
 

 

 .گویند.......  الکترونیکی مدارهای و فیزیکی و لمس قابل عناصر از مجموعه به-1

افرار نرم -د افرار سخت -ج  ترانسیتور -ب IC تراشه -الف

2-IT ؟ چیست معنای به 

 ارتباطات و اطلاعات فناوري- الف

 اطلاعات فناوري- ب 

 کامپیوتر فناوري -ج

مخابراتی ارتباطات -د

3-CPU شود می قاطلا.........  واحد به. 

 مرکزي پردازشگر -الف 

 کنترل -ب

 ومنطق محاسبه -ج

 حافظه -د

 شود؟ می نامیده منطقی و ریاضی عملیات مناسب واحد cpu های بخش از یک کدام-4

 Cu -الف

 ب- Alu 

 Register -ج

 Cache -د

 رود؟ می بین از برق جریان قطع با زیر های حافظه از یک کدام محتوای-5

PROM -د EPROM -ج RAM -ب ROM  -الف

 .شود می بایت........  شامل بایت کیلو هر-6

 بایت 2048 -الف

 بایت 1000 -ب

 بایت 1024*  1024 -ج

 بایت 1024 -د 

 کند؟ می عمل خروجی عنوان به زیر های دستگاه سری از یک کدام-7

 کلید صفحه-نمایش صفحه - چاپگر -الف

  ترپال - نمایش صفحه - چاپــگر -ب 

 پالتر-کلید صفحه-نمایش صفحه -ج

 اسکنر-پالتر-کلید صفحه -د

 ؟ کنند می کار صفحه به اشعه پرتاب با مانیتور مدل کدام-8

پالسما -د LED -ج CRT -ب LCD -الف

 ؟ است بهتر زیر چاپگرهای از یک کدام چاپ کیفیت-9

 سوزنی گرهاي چاپ -الف

 .افشان جوهر گرهاي چاپ -ب

 لیرزي گرهاي چاپ -ج 

 حرارتی چاپگرهاي -د

 رود؟ می کار به کامپیوتر به تصاویر انتقال جهت زیر های دستگاه از یک کدام-10

 اسکنر -الف 

 پالتر -ب

 کلید صفحه -ج

 ماوس -د

 باشد؟ می زیر گزینه کدام افزار نرم تعریف-11

 لمس قابل اجزاي -الف

 فلزي غیر قطعات -ب

 ها دستورالعمل و ها داده -ج 

 ها حافظه -د



 

 

 کلار ایلن وظیفله برنامله کلدام کلامپیوتر درک قابلل زبلان بله فهل  قابلل غیر دستورات تبدیل برای-12

 دارد؟ برعهده

 عامل سیستم -الف

 مترجم -ب 

 کاربردي افزارهاي نرم -ج

 کمکی افزارهاي نرم -د

 شود؟ می تدریس گسترده صفحه عنوان به افزار نرم کدام ICDL هفتگانه های مهارت در-13

 MS_WORD -الف

 MS-Access -ب

  ج- MS_EXCEL 

 Outlook express -د

 دارد؟ نام چه کامپیوتر سیستمی افزار نرم ترین مه -14

 Presentation -الف

 Utility -ب

 ج- Operating system 

Compiler -د

 باشد؟ می کاربره تک زیر های عامل سیست  از کدامیک-15

 الف- Dos ب- Windows ج- Linux د- Unix 

 شود؟ می محسوب شبکه کدام جز اینترنت-16

 خانگی -د شهري -ج گسترده -ب  محلی -الف

 کند؟ می تبدیل برعکس و آنالوگ به را دیجیتال سیگنالهای که دستگاهی-17

 اینترنت- د عامل سیستم- ج مودم- ب  تلفن- الف

 گویند؟ می چه اینترنتی خدمات دهنده ارائه های شرکت به-18

ADSL -د ISP -ج PSTN  -ب ISDN-الف

 نامند؟ می چه اصطالحا را شبکه در استفاده مورد عددی های آدرس-19

 الف- IP 

 TCP -ب

 DNS -ج

 PASSWORD -د

 )چپ به راست.(گویند می.......  را اینترنت به فایل ارسال و.....  اینترنت از فایل دریافت به-20

 Receiving , Sending -الف

 Download , Upload -ب

  ج- Upload, Download 

Sending , Receiving -د

 ؟ چیست توپولوژی-21

 شبکه در اطلاعات تبادالت قانون -الف

 شبکه در ها رایانه فیزیکی آرایش -ب 

 شبکه در رایانه هر آدرس -ج

 شبکه اجزاي -د

 ؟ است مفهومی چه به الکترونیک تجارت-22

 جهانی شبکه و اینترنت توصیف -الف

 اینترنت طریق از تجاري کارهاي انجام -ب 

 سیستم کارگیري به و اندازي راه -ج

 اینترنت طریق از بانکی کارهاي انجام -د

 رود؟ می بکار آرگونومی مورد در گزینه کدام-23

 کار محیط روشنایی -الف

 وسایل از استفاده روش -ب

 مناسب ازصندلی استفاده -ج

 کار محیط در انسان سالمت حفظ -د



 

 

  چیست؟ E-Mail مفهوم -24

 الکترونیکی پست -الف 

 الکترونیکی تجارت -ب

 الکترونیکی کتابخانه -ج

الکترونیکی بانک -د

 رود؟ می بکار الکترونیکی دولت مورد در گزینه کدام-25

 E-Learning -الف

 ب- E-Government 

 E-commerce -ج

E-Mail -د

 گویند؟ می چه دهد سرویس دیگر کامپیوترهای به شبکه یک در که کامپیوتری به-26

 Node -الف

 Client -ب

 ج- Sever 

 Work station -د

 شود؟ می نامیده چه اینترنت در منبع هر بفرد منحصر آدرس-27

 الف- URL ب- https ج- ETP د- Telnet 

 ؟ چیست کامپیوتری سیست  به ویروس سرایت از جلوگیری برای راه بهترین-28

 یالصاق فایل داراي الکترونیکی هاي نامه بررسی -الف

 شـدن روز بـه توانـایی کـه یـاب ویروس یک داشتن -ب 

 .باشد داشته را

 اینترنت به اتصال -ج

 جانبی هاي حافظه از استفاده -د

 ند؟ شو می تقسی  دسته چند به جغرافیایی توزیع نظر از ها شبکه-29

 الف- Man و Lan و Wan 

 LAN و Wan و Star -ب

 Bus و Star و Ring -ج

 Ring و LAN و Star -د

 است؟ مناسب متن ویرایش برای افزار نرم انواع از یک کدام-30

 سیستمی -الف

 یاطلاعات بانک -ب

 داده پایگاه -ج

 پردازها واژه -د 

 اسلتفاده ازآن رایگلان و آزمایشلی طلور بله مشخصلی ملدت بلرای کننلده مصلر  که افزاری نرم به-31

 بعد ولی کند می

 شود؟ می استفاده غیرقابل مدتی از

 Free Ware -الف

 Demo -ب

 ج- Share ware 

Open Source -د

 نیست؟ رایگان افزارهای نرم از گروه کدام-32

 کپی حق داراي افـزارهاي نـرم -الف 

 نمایشی افزارهاي نرم -ب

 باز متن افزارهاي نرم -ج

 Demo افزارهاي نرم -د

 ؟ دارد نام چه ، شود می نمایان تاپ دسک صفحه پائین در که باریکی نوار-33

 عنوان نوار -د آدرس نوار -ج ابزار نوار -ب وظیفه نوار -الف 

 دارد؟ نام چه یابد، می نمایش آیکن روی راست کلیک با که منویی-34

 فایل منوي -د فعال منوي -ج منو نوار -ب میانبر منوي -الف 



 

 

 کرد؟ استفاده روشی چه از باید ها پوشه مشخصات مشاهده برای-35

 Open گزینه انتخاب و پوشه آیکن روي راست کلیک -الف

 گزینه انتخاب و پوشه آیکن روي راست کلیک -ب Properties 

 نظر مورد پوشه آیکن روي کلیک دابل -ج

 نظر مورد پوشه آیکن کردن درگ -د

 چیست؟ نشانه آیکن یک کنار در فلش عالمت شدن ظاهر-36

 آن بودن میانبر -الف 

 آن انتخاب -ب

 آن بودن پنجره -ج

 آن پنجره شدن کوچک -د

 ؟ چیست نشانه یابد، نمایش(+)  عالمت درختی ساختار در پوشه آیکن نام کنار در اگر-37

 فایل داشتن -الف

 پوشه زیر داشتن -ب 

 پوشه بودن خالی -ج

 پوشه بودن میانبر -د

 دارد؟ وجود پنجره رساندن اکثر حد به امکان زیر موارد از یک کدام در-38

 معمولی پنجره -د  محاوره کادر -ج هشدار کادر -ب پیغام کادر -الف

 کرد؟ استفاده فرمان کدام از باید شده حذ  فایل یا و پوشه بازیابی برای-39

 Select All -الف

 Copy و Paste -ب

 Refresh -ج

 د- Restore 

 استفاده کردن کلیک همراه به زیر های کلید از یک کدام از باید پراکنده های آیکن گروهی انتخاب برای-40

 کرد؟

 Shift -الف

 Alt -ب

 ج- Ctrl 

 Alt + Shift -د

 .باید از چه معیاری استفاده کرد؟ gifبرای جستجو فایل های -41

 *.*gif -د *.* -ج *.gif -بgif  *. -الف

 با انتخاب کدام یک از گزینه های زیر امکان جا به جا کردن نوار وظیفه وجود ندارد ؟-42

 الف- Lock the taskbar 

 Keep the taskbar on top of the other windows -ب

 Auto-hide the taskbar -ج

 Show Quick Launch -د

 نوار وظیفه چه می گویند ؟به ناحیه سمت راست -43

 Toolbar -الف

 Quick Launch bar -ب

 ج- Notification area 

 Control box -د

 پسوند فایل های پشتیبان چیست؟-44

 الف- bkf ب- bak ج- zip د- rar 

 برای نمایش محتوای پنجره ها به صورت پشت سره  کدام گزینه صحیح است؟-45



 

 

 Tiles -د Content -ج List -بDetails   -الف

 هت نمایش محتوای فایل های شناسایی نشده توسط ویندوز کدام گزینه صحیح است؟ج-46

 نمایید کلیک بلدا آنها روي بر- الف

 نمایید انتخاب را openگزینه و کرده کلیک راست فایل روي بر- ب

 نمایید انتخاب را open گزینه و کرده کلیک فایل برروي -ج

 گزینه و کرده کلیک راست فایل روي بر -د With open نمایید انتخاب را 

 وجود دارد؟درکدام حالت از نحوه نمایش پنجره، امکان فیلتر کردن محتوا -47

 Details -دList   -ج Content -ب Tiles -الف

 برای مرتب کردن آیکن های میز کار بر اساس نوع، از کدام گزینه زیر استفاده می شود؟-48

 Size -الف

 Name -ب

 Date Modified -ج

 د- Item Type

  یک فایل به طوری کله در سلطل بازیافلت قلرار نگیلرد از کلدام کلیلد هملراه دکمله برای حذ  دائ-49

Delete 
 استفاده می شود؟

 الف- Shift ب- Alt ج- Ctrl د- Tab 

 رای مشاهده خصوصیات فایل ها و پوشه ها پس از کلیک راست روی آن ها چه گزینه ای را اتنخاب میب-50

 کنی ؟

 -Shortcutالف

 ب- Properties 

 Refresh -ج

 Attributes -د

 کدام یک از اسامی زیر برای نام پوشه غیر مجاز است؟-51

 الف- Con ب- Directory ج- Listname د- Asp

 است؟.......  فایل شناسایی روش-52

 ذخیره نوع و آیکن شکل -الف

 آیکن شکل و فایل پسوند -ب 

 آیکن شکل و فایل نام -ج

فایل نام و فایل ذخیره محل -د

 میکنی ؟ مراجعه گزینه کدام به پوشهها فایلو انتقال برای-53

 Burn -د Print -ج Organize -بOpen  -الف

 تلوان یمل....  بادسلتور و ذخیلره قبللی نلام هملان بلا را فایلل یلک تغییلرات توان می.....  بادستور-54

 فعلی فایل اطلاعات

 )چپ به راست از( کرد؟ ذخیره دیگری نام با را

 الف- Save as-Save 

 Save-Save as -ب

 Save-Save -ج

Save as- Save as -د



 

 

 کنی ؟ می استفاده زیر گزینه کدام از txt پسوند با ها فایل کلیه جستجوی برای-55

 *txt -دtxt  *. -ج ?txt.? -ب .? -txtالف

 است؟ صحیح گزینه کدام فشرده فایل بازکردن برای-56

 .ندارد وجود فشرده فایل کردن باز امکان -الف

 .نمایید انتخاب راto Sendگزینه و نموده راست کلیک آن برروي -ب

 گزینه و نموده راست کلیک آن برروي -جAll Extract نمایید انتخاب را. 

 .نمایید انتخاب را Propertiesگزینه و نموده راست کلیک آن روي بر -د

 .داد کاهش......  تا را فایل حج  توان می سازی، فشرده افزار نرم توسط-57

 %60 -د %10 -ج %50 -ب  %40 -الف

 چیست؟ نشانه شود نمایان قرمز رنگ با ویروس ضد آیکن چنانچه-58

 ضدویروس شدن خراب -الف

 سیستم شدن ویروسی -ب

 ویروس ضد نبودن روز به -ج 

سیستم در ویروس وجود عدم -د

 شود؟ می استفاده گزینه کدام از کاغذ تنظیمات برایNotepad افزار نرم در-59

 Page setup -دPrint   -ج Send -ب Print preview -الف

 کند؟ می فراه  را سند جاری صفحه چاپ امکانPrint ای محاوره کادر های گزینه از یک کدام-60

 All -د Current page -جSelection   -ب Collate -الف

 .کنی  می انتخاب را......  گزینه فرض پیش چاپگر عنوان به چاپگر تعیین برای-61

 Add Prnter -الف

 Set as Local Printer -ب

 ج-Set as default printer 

 Set as device -د

 کنی ؟ می عمل چگونه سند یک چاپ عمل مجدد گیری سر از برای و توقف برای-62

 .کنیم می انتخاب راPrinting Preference گزینه Properties ازمنوي -الف

 .کنیم می انتخاب را Pause گزینه Document ازمنوي -ب

 .میگیریم نظر در چاپ ادامه براي را Pause وگزینه توقف براي را Resume گزینه Document منوي از -ج

 ازمنوي -د Document گزینه Pause گزینه و توقف براي را Resume گیریم می نظر در چاپ ادامه براي را. 

 شود؟ می نامیده چه وب صفحه هر در فرد منحصربه آدرس-63

 الف- URL ب- Https ج- Etp د- Telent 

 کلیدهای سایت نام تایپ از بعد کافیست( WWW.سایت نام. )COMقالب با های سایت به دسترسی برای-64

 .بزنی  را..... 

 Ctrl+Enter -دCtrl+Esc   -ج Ctrl+Shift -ب +Ctrl -الف

 است؟ ایران کشور مختص زیر های دامنه از یک کدام-65

 TR -الف

 ب- IR 

 UK -ج

 US -د

 



 

 

66- ISP چیست؟  

اینترنت خدمات ارائه هاي شرکت -الف 

 .گویند را وب مرورگر -ب

 .گویندISP را اینترنت در اشتراک هاي فرم -ج

 .گویند تلفن خط ازطریق اینترنت اتصال به -د

 گویند......  را سایت وب یک خانگی صفحه-67

-Current page د -Web page ج -Home page بFirste pag-   الف

 کاراکتر ازکدام)عبارت همان دقیقا(شود جستجو اینترنت در شکل همان به جستجو مورد عبارت اینکه برای-68

 شود؟ می استفاده

" " -د  ( ) -ج [ ] -ب { } -الف

 می انتقال......  به شده انتخاب متن c+ctrl کلید فشردن و وب ی صفحه یک ازمتن قسمتی انتخاب از پس-69

 .یابد

 word پرداز واژه -الف

 دیگر وب صفحه -ب

 ویندوز موقت ي حافظه -جclipboard() 

 RAM حافظه -د

 .گویند می......  را اینترنت از اطلاعات دریافت-70

 Download -دMove   -ج Upload -ب Load -الف

 باشد؟ می صحیح پستی صندوق آدرس یک های گزینه از یک کدام-71

 

 -bayat@irantvto.ir لفا

 Yahoo.com@info -ب

 www.yahoo.com -ج

 yahoo@com.alireza -د

 است؟ درست جمله کدام-72

 باشد می فرد به منحصر ایمیل آدرس براي پسورد -الف

 ایمیل آدرس یک -ب mail-E است فرد به منحصر. 

 باشد می کاره نیمه هاي نامه نگهداري محل Inbox پوشه -ج

 باشد می ورودي هاي نامه نگهداري محل Spamپوشه- د

 مشهورند؟ نامی چه به پستی صندوق در ناخواسته های پیغام-73

 ایمیل -د Virus -ج Spam -بNoise  -الف

 .است....شامل sent پوشه-74

 است شده دریافت هاي نامه لیست- الف

 .است نشده تکمیل آنها ارسال فرایند هنوز که است هایی نامه لیست- ب

 است شده حذف هاي نامه لیست -ج

 است شده ارسال هاي نامه لیست -د 

 باشد؟ می شده دریافت های پیام برگیرنده در پوشه کدام-75

 الف- Inbox ب- Draft ج- Outbox د Sent item-  



 

 

 گیرند؟ قرارمی پوشه درکدام نویس پیش های نامه-76

 Draft -دSent Item   -ج Outbox -ب Inbox -الف

 ....بماند پوشیده گیرندگان سایر از نامه یک رونوشت آنکه برای-77

 .کنیم می وارد cc قسمت در را آن آدرس -الف

 قسمت در را آن آدرس -ب Bcc کنیم می وارد. 

 .کنیم می وارد To قسمت در را آن آدرس -ج

 .کنیم می وارد From قسمت در را آن آدرس -د

 نویسی ؟ می را چیز چه نامه Subject قسمت در-78

 نامه متن -د نامه موضوع -ج  مخفی گیرنده آدرس -ب گیرنده آدرس -الف

 شود؟ می استفاده دکمه کدام از شده نوشته نامه ارسال برای-79

 الف- Send ب- Draft ج- Mail د- Reply

 شود؟ می استفاده گزینه کدام از الکترونیکی نامه به فایل یک کردن) پیوست( ضمیمه برای-80

Priority -د Forward -ج Attach File -بReply   -الف

 شود؟ می استفاده زیر گزینه کدام از نامه یک فرستندگان تمام به پاسخ ارسال برای-81

Creat mail -د Reply all -جForward   -ب Reply -الف

 کرد؟ انتخاب را گزینه کدام باید نامه حذ  برای-82

Clear Letter -د Delete Letter -ج Delete -بClear   -الف

 دارند؟ قرار پوشه کدام در شده حذ  های نامه-83

 Inbox -د Deleted Items -جSent Items   -ب Drafts -الف

 است؟ آدرس کتابچه به مربوط گزینه کدام-84

 الف- Address book ب- Address ج- Find د- Book 

 ؟ شود می استفاده گزینه کدام از دیگر اشخاص به شده دریافت نامه یک ارسال برای-85

 reply -د Reply all -ج forward -بsend   -الف

86-Favorites دارد؟ کاربردی چه 

 عالقه مورد هاي سایت لیست سازي فعال -الف 

 سایت در جلو به حرکت -ب

 ها نامه پاسخ -ج

سایت مشاهده -د

 است؟ کدام متن نمودن چین وسط بر میان کلید-87

 Ctrl +J -د Ctrl +L -ج Ctrl +E -بCtrl +R   -الف

 ؟ کنی  می استفاده گزینه چه از افقی صورت به کاغذ جهت تغییر برای-88



 

 

 Portrait گزینه Orientation گروه layout Page برگ سر -الف

 Landscape گزینه Orientation گروه Insert برگ سر -ب

 Portrait گزینه Margins گروه Insert برگ سر -ج

 برگ سر -د layout Page گروه Orientation گزینه Landscape 

 شود؟ می استفاده ای گزینه چه از کاغذ ی اندازه تغیر برای-89

 Size گزینه Insert سربرگ -الف

 سربرگ Page layout گروه Page Scape -ب

 Size گزینه View سربرگ -ج

 د- Size گزینه Page Setup گروه Page Layout سربرگ 

 شود؟ می استفاده فرمان کدام از دیگر نامی تحت سند یک ذخیره برای-90

look in -د save -ج save as -بsave in   -الف

 .کرد استفاده----- ترکیبی کلید از باید جمله یک انتخاب برای-91

 الف-ctrl +click ب- ctrl +Alt ج- ctrl +home د- view 

 کنید؟ می استفاده گزینه کدام از سند، محیط در تصویری فایل یک کردن وارد برای-92

 لفا- insert \ picture 

 home \ picture -ب

 view \ picture -ج

 insert \ chart -د

 کنی ؟ می استفاده گزینه کدام از خانه چند به جدول خانه یک تقسی  برای-93

Align top left -د Split Cells -ج Split Table   -ب Merge Cells -الف

 کنی ؟ می استفاده گزینه کدام از فرد و زوج صفحات پاصفحهی و سرصفحه در تفاوت ایجاد برای-94

 Different First Page -الف

  ب- Different Odd & Even Pages 

 Even page -ج

 Insert header and footer -د

 نمود؟ عمل باید صورت چه به صفحه شماره درج برای-95

 الف- Insert>Header & Footer >Page Number 

 Home>Page Number -ب

 View>Page Number -ج

 Page Layout>Macros>Page Number -د

 شود؟ می استفاده گزینه کدام از فرورفتگی میزان تنظی  برای-96

  الف- Indent ب- spacing ج- alignment د- hyphenate

 شود؟ می استفاده..........  از اسناد در عبارتی جایگرینی برای-97

  الف- Replace ب- Find ج- select د- search 



 

 

 رود؟ می بکار شده انجام عمل آخرین لغو برای مورد کدام-98

ctrl + v -د ctrl + z -ج  ctrl + x  -ب ctrl + y -الف

 گذارد؟ می سند بر تاثیری چه نمایی بزرگ حالت-99

 .کند می ذخیره نمایی بزرگ با را سند -الف

 .کند می چاپ نمایی بزرگ با را سند -ب

 ندارد چاپ چگونگی بر تاثیري گونه هیچ -ج 

 کند می کاري دست را متن قلم سایز -د

 کنید؟ می استفاده ها گزینه کدام از سند، محیط در تصویری فایل یک کردن وارد برای-100

 Insert \ chart -الف

 View \ picture -ب

 Picture \ home -ج

د- Insert \ picture

 ؟ دارند قرار زبانه کدام در صفحه بندی حاشیه به مربوط های گزینه-101

 Insert -الف

 ب- page layout 

 View -ج

 home -د

 است؟ خاصی عدد از صفحات شماره شروع تنظی  برای گزینه کدام-102

 Alignment -الف

 Position -ب

ج- Start at 

 Continue -د

 شود؟ می استفاده استاندارد کلید صفحه در ترکیبی کلید کدام از فاصله نی  تایپ برای-103

 الف- spacebar + shift 

 enter + ctrl -ب

 spacebar + alt -ج

 shift + enter -د

 شود؟ می استفاده ازکدام Word در متن به جدول یک تبدیل برای-104

 Table to Text←Table -الف

 ب- Convert to Text ←Table 

 Text to Table←Table -ج

 Table to Text←Convert -د

 دارند؟ قرار insert زبانه از گروه کدام در تصاویر-105

 pages -الف

 text -ب

 header & footer -ج

د- illustrations 

 گردد؟ می انتخاب فایل پیشفرض پسوند عنوان به فرمت کدام سند ذخیره هنگام در-106

 txt -د docx -جhtml  -ب dot-الف

 یا ددع یک ها سربرگ کنار در و فعال سربرگها و خارج متن حالت از نما مکان تابعی کلید کدام فشردن با-107

 گیرد؟ می قرار حر  یک

 الف- F2 ب- F4 ج- F6 د- F8 

 شود؟ می استفاده کلیدهایی چه ترکیب از برعکس و فارسی به انگلیسی زبان تغییر برای-108



 

 

 Home -د Ctrl+Enter -ج Alt+Shift -ب Ctrl+ALt  -الف

 شود؟ نمی دیده گرافیکی اشکال و حاشیه سند نمای کدام در-109

 الف- Draft 

 Web layout -ب

 Print layout -ج

Full Screen -د

 گزینه کدام از کنی  ایجاد میانبر کلید یک Symbol پنجره در شده انتخاب کاراکتر برای بخواهی  اگر-110

 کنی ؟ می استفاده

 لفا- Shortcut key 

 Autocorrect -ب

 Inser -ج

Symbol -د

 است؟ بزرگ التین به شده نوشته حرو  تغییر برای گزینه کدام-111

 Lowercase -الف

 Toggle Case -ب

 ج- Uppercase 

 Sentence Case -د

 است؟ مناسب ابزار کدام گذاری عالمت لیست ایجاد جهت-112

 الف- Bullets 

 Nambering -ب

 Table -ج

 Symbol -د

 کلیلد کلدام از ملتن خلوردگی بهل  علدم و تلراز حفل  بلا پلارگرا  یلک خطلوط شکسلتن برای-113

 شود؟ می استفاده

 Enter -الف

 ب- SHift+Enter 

 Ctrl+Enter -ج

 ask Space -د

 شود می استفاده........  از شده نوشته متن قل  رنگ تغییر برای-114

 الف- Font Color 

 Fill Color -ب

 Font -ج

 Highlight -د

 ؟ شود می استفاده ای گزینه چه از سلول یک محتویات حذ  برای-115

 Delete گزینهHome سربرگ -الف

 برگ سر -ب Home گزینه Contents Clear 

 Clear گزینه Data برگ سر -ج

 Format Clear گزینه Clear گروه Home برگ سر -د

 ؟ کنی  می استفاده ای گزینه چه از سلول یک به توضیحات کردن اضافه برای-116

 Home برگ سر از Edit گزینه -الف

گزینه -ب Comment new برگ سر از Reviwe 

 View برگ سر Comment Insert گزینه -ج

 Insert برگ سر از Comment گزینه -د

 ؟ شود می استفاده ای گزینه چه از ویژه کاراکتر یک درج برای-117



 

 

 Style گزینه View برگ سر -الف

 Chart گزینه Insert برگ سر -ب

برگ سر -ج Insert گزینه Symbol 

 Object گزینه Insert برگ سر -د

 ؟ کنی  می استفاده ای گزینه چه از ماکرو یک ضبط برای-118

 macro گزینه Insert برگ سر -الف

 Macro View گزینه View برگ سر -ب

برگ سر -ج View گروه Macro گزینه Macro R 

 Macro Record گزینه Macro گروه Insert برگ سر -د

 .گیرند می قرار استفاده مورد.........  کلیدهای redo فرمان سریع اجرای برای-119

ctrl +x -د ctrl +v -ج ctrl +y -بctrl +z  -الف

 را template excelگزینه.......  لیست در است کافی template یک عنوان به الگو یک کردن ذخیره برای-120

 .کنید انتخاب

 save in -الف

ب- save as type 

 save as name -ج

 file name -د

 ) ...... الفبا حرو  اساس بر( لیست در موجود اطلاعات کردن مرتب برای-121

الف- data \ sort 

 data \ filter -ب

 insert \ sort -ج

 home \ find -د

 چیست؟ نشانه خانه یک شروع در مساوی عالمت-122

فرمول یک شروع -الف 

 جستجو یک شروع -ب

 filtering عملیات شروع -ج

 فایل یک سازي ذخیره شروع -د

 ؟ کند محاسبه سلول چند در را 3 بزرگتراز اعداد تعداد تواند می زیر توابع از کدامیک-123

 sum if -د count if -جcount  -ب if -الف

 است؟ صحیح فرمول کدام اکسل دوسلول محتویات جمع آوردن بدست برای-124

 الف- =A1+B5 

 A1+b5 = X -ب

 A1+5= -ج

A1+b5=x -د

 دارد؟ نام چه کاری صفحه در ها خانه از هریک-125

 sheet -الف

 ب- cell 

 Work book -ج

 file -د

 است؟ کدام ها فرمول خواندن در الویت ترینبالا-126

تقسیم -د ضرب -ج پرانتز -ب  توان -الف

 ؟ شود می استفاده ای گزینه چه از اکسل در سطر یک حذ  برای-127



 

 

 الف- Delete sheet Rows گزینهHome سربرگ 

 Rows Clear گزینه Home برگ سر -ب

 columns Delete گزینه Data برگ سر -ج

 Format Clear گزینه Clear گروه Home برگ سر -د

 گیرند می قرار استفاده مورد......  کلیدهای undo فرمان سریع اجرای برای-128

ctrl +x -د ctrl +v -ج ctrl +z -ب ctrl +y  -الف

 .کنید انتخاب را... گزینه type as save لیست در است کافی اکسل در الگو یک کردن ذخیره برای-129

 save in -الف

 ب- excel template 

 xml data -ج

 file name -د

 شود؟ می استفاده گزینه کدام از لیست در موجود اطلاعات کردن فیلتر برای-130

 data \ sort -الف

 ب- data \ filter 

 insert \ sort -ج

 home \ find -د

 .است فرمول نشانه خانه یک ابتدای در عالمت کدام-131

 د ؟ -ج $ -ب = -الف- : 

 باشد؟ نمی گسترده صفحه های برنامه های توانایی از زیر موارد از کدامیک-132

 کامپیوتري مستقل اجرایی برنامه یک تولید -الف 

 بازرگانی شرکت یک حسابداري -ب

 تجاري هاي داده و اطلاعات مدیریت -ج

 شرکت یک فروش میزان بررسی -د

 .گویند می.......  اکسل کاربرگ داخل جدول از سطر هر به-133

 Column -د row -ج table  -ب Cell -الف

 نوشت؟ باید فرمولی چه اکسل دوسلول محتویات ضرب آوردن بدست برای-134

 5b*A 1=-الف

 A1*b5 = X -ب

 ج- =A1*B5 

 A1*b5=x -د

 .فشاری  می را Delete کلید کرده، کلیک...... روی نمودار حذ  برای-135

 نمودار عنوان -الف

 نمودار محور -ب

 نمودار کل -ج 

نمودار راهنماي -د

 دارد؟ وجود کاربرگ چند جدید کارپوشه یک 2013 اکسل در فرض پیش طور به-136

 1 -د  4 -ج 2 -ب 3-الف

 کند؟ می حذ  را فعال کاربرگ......  فرمان-137

 Insert -د Tabcolor -ج Delete -ب Rename  -الف



 

 

 چیست؟ اکسل های فایل فرض پیش نام-138

 Document -الف

 ب- Book 

 Workbook -ج

 Database -د

 دارد؟ کاربردی چه Number ای محاوره کادر در places Decimal گزینه-139

 منفی اعداد نمایش -الف

 تایی سه صورت به اعداد ارقام کردن جدا -ب

 اعشار ارقام تعداد -ج 

 عدد نوع تعیین -د

140-type Chart دارد؟ کاربردی چه نمودارها در 

 نمودار عنوان تعیین -الف

 نمودار راهنماي تعیین -ب

 راهنما خطوط نمایش -ج

 نمودار نوع تغییر -د

 شوند؟ می ذخیره قالبی چه با Access های فایل-141

 PPTX -د accdb -ج BMP  -ب DOCX -الف

 شود؟ می استفاده افزار نرم کدام از موضوع یک مورد در اطلاعات سازماندهی و آوری جمع جهت-142

 یاطلاعات بانک-الف 

 پرداز واژه -ب

 نمایشی برنامه -ج

جدول -د

 .گویند می.............رکورد چند یا یک از ای مجموعه به-143

 فیلد -الف

 جدول -ب 

 فایل -ج

یاطلاعات بانک -د

 شود؟ می گفته چه داده پایگاه در یاطلاعات جزء کوچکترین-144

 جدول -الف

 رکورد -ب

 یاطلاعات بانک -ج

 فیلد -د

 شود؟ می استفاده طوالنی های متن برای زیر داده نوع کدام-145

Currency -د long text -ج Number  -ب Text -الف

 گویند؟ می چه داداه پایگاه در جداول بین ارتباطات به-146

 الف- Relationship 

 Entity -ب

 Integrity Rules -ج

Database -د

 است؟ مناسب اعشاری عددهای جهت نوع کدام عددی های داده تعریف هنگام به-147

 -Byteالف

 Integer -ب

 Long integer -ج

 د- decimal 

 است؟ اشتباه جداول بین در رابطه نوع کدام-148

 یک به یک رابطه -الف

 چند به یک رابطه -ب

 یک به چند رابطه -ج 

چند به چند رابطه -د



 

 

 گیرد؟ می قرار Byte نوع از عددی فیلد در عددی چه حداکثر-149

نامحدود -د 255 -ج  1024 -ب 65000 -الف

 باشد؟ نمی access یاطلاعات بانک اجزای از گزینه کدام-150

 database -د report  -ج table -ب form -الف

 باشد؟ می فرض پیش مقدار کننده تعیین فیلدها درمورد زیر خصوصیات از یک کدام-151

 الف- default value 

 caption -ب

 new value -ج

 input mask -د

 شود؟ می استفاده.......  گزینه......  سربرگ از جدول دو بین ارتباط ایجاد برای-152

 الف- relation shipsگزینه data base tools سربرگ 

 form گزینه create سربرگ -ب

 ships relation گزینه homeسربرگ- ج

 create گزینه table سربرگ -د

 نکند؟ دریافت کاراکتر 20 از بیشتر کردکه تنظی  طوری را نام فیلد توان مشخصه،می کدام تنظی  با-153

 Required -الف

 Validation Text -ب

 ج- Filed Size 

 Format -د

 ظاهر اخطار پیغام سیست  طر  از فیلد یک کردن رها خالی با که کنی  تنظی  طوری را جدول بخواهی  اگر-154

 ؟ کنی  می استفاده مشخصه کدام از شود

 name -د caption -ج required -ب format  -الف

 کند؟ می مشخص را اطلاعات ورود صحت قانون زیر خاصیت کدام-155

 Field Size -الف

 Caption -ب

 ج- Validation Rule 

 Required -د

 کنی ؟ می انتخاب را مسیری چه کلیدی فیلد ایجاد برای-156

 الف- Design → tools → primary key 

 Design→builder -ب

 Design→show/hide→index -ج

 Design→ key -د

 ؟ شود می استفاده سربرگ کدام از یاطلاعات بانک در گزارش و فرم یا و جدول ایجاد برای-157

 Home -الف

 ب- Create 

 External Data -ج

Data base Tools -د

 ؟ کرد تهیه جو و پرس یک توان می گزینه کدام از استفاده با-158

query -د macro  -ج report -ب Table -فال

 نتیجه لیست در رود کار به=<and 1360=> 1367 عبارت تولد تاریخ فیلد برای query یک در اگر-159

 شود؟ می ظاهر زیر مورد کدام



 

 

 است کمتر 1367 از آنها تولد تاریخ که افرادي اطلاعات فقط -الف

 است 1367 تا 1360 از انها تولد که افرادي اطلاعات -ب 

 است بیشتر 1360 ار انها تولد تاریخ که افرادي اطلاعات فقط -ج

 (1367 تا 1360 بین(است بیشتر 1360 از و کمتر 1367 از انها تولد تاریخ که افرادي اطلاعات -د

 شود؟ می استفاده جو و پرس یک در قسمت کدام از معیار یک درج برای-160

 -Showالف

 field -ب

 Or -ج

 د- Criteria & Or

 شود؟ می استفاده فرمان کدام از جدول یک در خاص مشخصات با رکوردی جستجوی برای-161

 Search -د Find -ج Filter -ب form  -الف

 شود؟ می استفاده گزینه کدام از فیلتر اعمال جهت-162

 Delete Filter-الف

 ب- Apply Filter 

 Auto Filter -ج

Toggle Filter -د

 کنید می استفاده عالمت کدام از کند، درخواست اجرا موقع را ورودی شرط جو، و پرس در اینکه برای-163

 الف- [ ] 

 ( ) -ب

 ” ” -ج

نیست نیاز عالمتی به -د

 نمود؟ رها خالی را فیلد توان می باشد.........مقدار دارای فیلد........ مشخصه صورتیکه در-164

 Yes-Required -الف

 ب- No-Required 

 Yes-Default Value -ج

No-Default Value -د

 شود؟ انجام جدول فیلدهای کل روی بر جستجو که کرد تعیین توان می جستجو پنجره قسمت کدام در-165

 Match -الف

 find What -ب

 Look in -ج

 د- Search

 باشد؟ می Descending Sort معنای به گزینه کدام-166

 صعودي سازي مرتب -الف

 نزولی روش به سازي مرتب -ب 

 کردن باانتخاب سازي مرتب -ج

سازي مرتب بدون -د

 از صفحه اولین ابتدای در فقط را ثابت عبارت یک بخواهی  و بوده صفحه یک از بیش ما گزارش چنانچه-167

 داد؟ قرار بخش کدام در بایستی می را عبارت آن ببینی ، گزارش

 Page Header/Footer -لف

 Detail -ب

 Group Header/Footer -ج

 د- Report Header / footer

 می نامیده چه دهد می نشان را یاطلاعات بانک از شده استخراج اطلاعات یافته ساخت صورت به که سندی-168

 شود؟

 الف- Query ب- Table ج- Report د- Form 

 یبند قالب را گزارش توانی  می شوند می داده نمایش گزارش در ها داده اینکه با همزمان ، نما کدام در-169

 کنی ؟



 

 

 Print Preview -الف

 Design View -ب

 ج- Layout View 

 Report View -د

 شود؟ می استفاده گزینه کدام گزارش بندی گروه برای-170

 Add -الف

 Field ّ-ب

 Sort -ج

 د- Group & Sort

 کنی ؟ استفاده printکادر بخش ازکدام فرم یک 5 تا 2 صفحه چاپ برای-171

 All -الف

 ب- Pages 

 Selection Record -ج

Number of Copies -د

 کرد؟ انتخاب باید را گزینه کدام باشد داشته ادامه هااسلاید پایان تا صوت اجرای اینکه برای-172

 Automatically -الف

 clicked -ب

 ج- play Across slides 

 play sound -د

 شود؟ می انجام اسلاید کدام از نمایشی برنامه اجرای slide current From گزینه از استفاده با-173

جاري اسلاید -د  آخر اسلاید -ج میانی اسلاید -ب اول اسلاید -الف

 شود؟ می ذخیره............ پسوند با گویندکه........... یک Powerpointدر تولیدی فایل هر به-174

 Doc-document -الف

 ب- Pptx-presentation 

 pxt-slide-ج

 xls-spreadsheet -د

 شود؟ می ایجاد جدید یاسلاید ، اسلاید عناوین روی بر کلید کدام فشردن باOutline نمای در-175

 Space Bar -الف

 Ctrl+Enter -ب

 ج- Enter 

F5 -د

 دارد؟ کاربرد ایجادانیمیشن برای Powerpointافزار درنرم منو کدام-176

 الف- Animations 

 Slide Show -ب

 Design -ج

 Review -د

 شود؟ می استفاده روشی چه از متن درج برای-177

 Format -الف

 ب- Text Box 

 اسلاید ي بدنه -ج

خارجی شی یک -د

 .گویند می.......  هااسلاید محتوای گرفتن قرار نحوه به-178

 Slide Design -الف

 ب- Slide Layout 

 Slide Sorter -ج

Color Schemes -د

 ؟ شود می استفاده_گزینه ازکداماسلاید تعویض کردن زمانبندی جهت-179

 الف- Advanced Slide 

 Preview -ب

 Transition to this Slide -ج

 Animation -د

 دارد؟ کاربرد گزینه کدام نمودار روی بر ها داده مقادیر افزودن برای-180

 الف- Data Label ب- ChartTitle 



 

 

ChartLayout -د ChartType -ج

 است؟ اسلاید در شده رس  نمودار نوع تغییر برای گزینه کدام-181

 Chart Layout -الف

 Data Label -ب

 ChartTitle -ج

 د- Chart Type 

 است؟ کدام نمایشی فایل ایجاد برای روش راحتترین و سریعترین-182

 Office منوي از New گزینه انتخاب -الف

 کلیدهاي فشردن -ب N+Ctrl 

 M+Ctrl کلیدهاي فشردن -ج

 Office منوي ازDocument Recent گزینه انتخاب -د

 .گویند می.......  را یکجا صورت به اطلاعات کل مشاهده برای نمایی کوچک قابلیت-183

 Fit -دFont Size   -ج Zoom out -ب Zoom in -الف

 گویند؟ می چه اسلاید در....  متن،تصویر،نمودارو گرفتن قرار نحوه به-184

 الف- Slide layout 

 Slide Design -ب

 Themes -ج

Templates -د

 شود؟ می استفاده گزینه کدام ازDesign سربرگ از هااسلاید برای دلخواه زمینه طرح و رنگ انتخاب برای-185

 Themes -الف

 ب- Background Style 

 Color -ج

 Effects -د

 کنی ؟ انتخاب را گزینه کدام Insert برگ سر از شده ذخیره های آرم درج برای-186

 الف- Picture ب- Clip Art ج- Shapes د- Table

 کند؟ می دار سایه را شده انتخاب متن گزینه کدام-187

 Outline -الف

 Underline -ب

 Engrave -ج

 د- Shadow 

 دهی ؟ می انجام بخش کدام از را آن ابتدای ،تورفتگی پارگرا  تنظیمات در-188

 Spacing -الف

 ب- Indentation 

 Direction -ج

 Alignment -د

 شود؟ می استفاده متن به فانتزی های جلوه اعمال برای گزینه کدام از-189

Word Art -د Font  -ج Text Box -ب Shape -الف

 داد؟ تغییر را خطوط مدل توان می ابزار کدام توسط جدول درج از پس-190

 Eraser -الف

 Pen Color -ب

 ج- Pen Style 

Table Style -د

 است؟ کدام "اطلاعات درصد" دادن نشان جهت نمودار ترین مناسب-191

Pie -دBar   -ج Column -ب Line -الف

 شود؟ می استفاده گزینه کدام از نمودار به عنوان افزودن برای-192



 

 

 Chart Layout -الف

 Data Label -ب

 ج- Chart Title 

Chart Type -د

 کنی ؟ انتخاب را گزینه کدامInsert سربرگ از اسلاید در سازمانی نمودار یک ایجاد برای-193

 Chart -الف

 Organization Chart -ب

 ج- Smart Art 

Shapes -د

 کرد؟ ایجاد آلبوم صورت به را تصاویر از ای مجموعه توان می Insert سربرگ در ابزار کدام توسط-194

 Picture -الف

 Clip Art -ب

 ج- Photo Album 

Shapes -د

 است؟ سازی متحرک آماده های جلوه از استفاده برای گزینه کدام-195

 Animate -الف

 Advanced Slide -ب

 Slide Show -ج

 د- Slide Transition

 می انتخاب را گزینه کدام شود، اجرا قبلی سازی متحرک با همراه شی یک سازی متحرک بخواهی  اگر-196

 کنی ؟

 On click -الف

 ب- With Previous 

 After Previous -ج

Direction -د

 کنی ؟ می اضافه بخش کدام به را ها آن اشتباه کلمات خودکار برایتصحیح-197

 لفا- Auto Correct 

 Spelling -ب

 Dictionary -ج

Language -د

 باشد؟ می کامپیوتر تعریف زیر موارد از یک کدام-198

 دهد نجاما بالینی سرعت با را محاسباتی عملیات تواند می که است ریزي برنامه قابل حساب ماشین یک کامپیوتر -الف

 خروجی و ادهد انجام آن روي خاصی عملیات و کرده دریافت وروردي عنوان به را هایی داده تواند می که است اي وسیـله -ب 

 .کند تولید را نیاز مورد هاي

 کند اريی را انسان کارها از بسیاري در تواند می که است اطمینان قابل و هوشمند،خالق است اي وسیله کامپیوتر -ج

 .هدد انجام بالا دقت و سرعت با را انسان کارهاي همه است قادر که الکترونیکی است دستگاهی -د

 شوند؟ می محسوب عامل سیست  یک زیر موارد از کدامیک-199

 Netscape -الف

 ب- windows10 

 PowerPoint -ج

Photoshop -د

 شود؟ می استفاده اینترنت به اتصال برای مورد کدام از-200

گرافیک کارت -د مودم -ج  صدا کارت -ب LAN شکبه -الف

 نیست؟ ضروری زیر های گزینه از یک کدام کامپیوتر در موزیک و صوت از استفاده برای-201

 صدا کارت -الف

 مودم -ب 

 ویدئویی یا صوتی فایل -ج

بلندگو -د

 گویند؟ می چه سیست  خام ورودیهای به-202



 

 

داده- د  پردازش- ج اطلاعات- ب سیستم- الف

 چه؟ یعنی copyrightقانون-203

 کپی ار افزار نرم این او اجازه بدون ندارد حق کسی و شود می محسوب آن مالک افزار نرم هر کننده تولید یعنی -الف 

 .کند

 شود استفاده دیگر شرکتهاي توسط نباید است شده ثبت آنها نام به که شرکتها بعضی اسامی یعنی -ب

 شوند فروش و خرید کنندگان تولید اجازه بدون نباید افزاري سخت قطعات یعنی -ج

 .کند برداري کپی یا استفاده دیگران شخصی اطلاعات از ندارد حق کسی یعنی -د

 است؟ بیشتر زیر کامپیوترهای از نوع کدام در اطلاعات سازی ذخیره ظرفیت و پردازش سرعت-204

 الف- super Computer 

 Micro Computers -ب

 Mini Computer -ج

Main Frame -د

 ؟ هستند خروجی دستگاههای جزء زیر ابزار از یک کدام-205

 الف- Speaker ب- Mouse ج- Keyboard د- Scanner

 است؟ ورودی ، دستگاه چند زیر موارد در-206

 نوري قلم اسکنر، چاپگر، پالتر، ماوس، کلید، صفحه نمایش، صفحه

 1 -د 5 -ج 4 -ب  9 -الف

 شوند؟ نمی محسوب گر اشاره کننده کنترل وسایل جزو زیر های گزینه از کدامیک-207

 اسکنر -د  بازي دسته -ج لمسی صفحه -ب ماوس -الف

 هستند؟ خواندنی فقط زیر های حافظه از کدامیک-208

 RAM -د ROM -ج Hard Disk  -ب Diskette -الف

 است؟ نوعی چه از اداره یک داخلی شبکه-209

 الف- LAN ب- MAN ج- Internet د- wan 

 ؟ گیرند می قرار واحد کدام در اجرا جهت ها برنامه-210

 اصلی حافظه -الف 

 تغذیه منبع -ب

 ثانویه کمکی حافظه -ج

خروجی واحد -د

 ؟ است غلط زیر موارد از کدامیک ثانویه حافظه مورد در-211

 رود نمی بین از آن اطلاعات برق جریان قطع با که است دائمی حافظه -الف

 است نامحدود تقریبا اصلی حافظه با مقایسه در فرعی یا ثانویه حافظه حجم -ب

 کرد ذخیره کمکی یا ثانویه حافظه در را آنها باید اطلاعات دائمی ذخیره براي -ج

 کرد ذخیره کمکی یا ثانویه حافظه در را آنها باید اطلاعات موقت ذخیره براي -د 

 گویند؟ می چه افزار نرم و افزار سخت ترکیب به-212

افزار نرم -د افزار میان -ج  ترانزیستور -ب (IC( تراشه -الف

 ؟ چیست عامل سیست -213



 

 

 دیگر افزارهاي نرم ایجاد براي است افزاري نرم -الف

 اداري امور انجام براي است افزاري نرم -ب

 اینترنت از استفاده براي است افزاري نرم -ج

 ددار عهده بر را سیستم افزاري نرم و افزاري سخت منابع تمام مدیریت که است افزاري نرم -د. 

 ؟ باشد نمی cpu واحدهای جزء زیر بخشهای از کدامیک-214

 ALU -الف

 CU -ب

 (REGISTER( ثبات -ج

 د- MEMORY SECONDRY

 ؟ شود می نامیده کنترل واحد CPU بخشهای از کدامیک-215

 CACHE -د REGISTER -ج cu -ب Alu  -الف

216 -Learning-E باشد؟ می زیر موارد از یک کدام 

 الکترونیکی پست- الف

 الکترونیکی تجارت- ب

 الکترونیکی آموزش- ج 

الکترونیکی داري بانک -د

 باشد؟ می الکترونیکی تجارت معنای به گزینه کدام-217

 الف- E - commerce 

 E-Learning -ب

 E-Government -ج

 E-Library -د

 ؟ نیست مربوط کامپیوتر با کار هنگام سالمتی امور به زیر های عبارت از یک کدام-218

 صندلی ارتفاع بودن تنظیم از اطمینان -الف

 اتاق نور بودن مناسب از اطمینان -ب

 کار مرتب کردن ذخیره -ج 

 دور ۀ نقط یک به کردن نگاه گاهی -د

 چیست؟ حافظه واحد کوچکترین-219

byte -د Bit -ج kb  -ب -wordالف

 شود؟ می محیطی زیست های آلودگی کاهش باعث زیر ازموارد کدامیک-220

 الکترونیکی اسناد جاي به کاغذي ازاسناد استفاده -الف

 شده مصرف هاي تونر و ها کاغذ بازیافت و کاغذي جاي به الکترونیکی اسناد از استفاده -ب 

 حضوري جلسات و مالقات -ج

 پریز یک از زیاد برق گرفتن عدم -د

 چیست؟ کامپیوتر به نسبت انسان مزیت-221

 بالا دقت با محاسبات انجام -الف

 بالا سرعت با محاسبات انجام -ب

 ابتکار و خالقیت -ج 

اطمینان قابلیت -د

 شود؟ می استفاده کاغذ روی بر گزارشات و عملیات نتایج چاپ جهت زیر دستگاه کدام از-222

 نوري قلم -د مانیتور -ج اسکنر -ب پرینتر -الف

 چیست؟ paste فرمان میانبر کلید-223



 

 

Ctrl+X-د Ctrl+V -ج Ctrl+P -ب ctrl+c -الف

 کرد؟ انتخاب را پوشه یک پراکنده فایل چند میتوان چگونه-224

 نظر مورد فایلهاي روي کلیک با -الف

 فایل نام حرف اولین کلید دادن فشار با -ب

 کلید نظر مورد فایلهاي روي کردن کلیک هنگام -ج CTRL داشت نگه پایین را 

 داشت نگه پایین را SHIFT کلید نظر مورد فایلهاي روي کردن کلیک هنگام -د

 شود؟ می استفاده گزینه کدام از فایلها نوع براساس پنجره آیکنهای نمودن مرتب برای-225

Size -د Date-ج Type -ب Name  -الف

 شود؟ می استفاده گزینه کدام از ها پوشه و فایلها نام تغییر برای-226

 Send To -الف

 Properties -ب

 ج- Rename 

Delete-د

 نمود؟ استفاده گزینه کدام از باید کامل خروج و کاربرجاری پنجرههای شدن بسته برای-227

 انتخاب -الف off logمنوي از start 

 Shutdownپنجره از Restartانتخاب- ب

 Shutdown پنجره از Sleep انتخاب -ج

 Shut down windows پنجره از Restart انتخاب و start منوي از off log انتخاب -د

 ؟ شوند می داده نشان قسمت کدام در ویندوز محیط در اجرا حال در های برنامه-228

 الف- task manager 

 System tray bar -ب

 toolbar -ج

 Star منوي -د

 شود؟ می استفاده گزینه کدام از پوشه یا فایل یک خصوصیات تغییر برای- 229

 الف- Properties 

 Back-ب

 View -ج

 Cut -د

 دهد؟ می نشان را سخت دیسک درایوهای گنجایش گزینه کدام-230

 type -الف

 free -ب

 backup now -ج

 د- capacity

 شود؟ می عمل چگونه Bin Recycleمحتوای کردن خالی برای-231

 میکنیم انتخاب را Restore گزینه file منوي از و آن پنجره از -الف

 میکنیم کلیک را Empty Bin Recycleگزینه باشد نشده انتخاب فایلی که صورتی در File منوي از و آن پنجره از -ب

 کنیم می کلیک را delete گزینه File منوي از و انتخاب را موارد کلیه آن پنجره در -ج

 منوي از و آن پنجره از -د File گزینه باشد نشده انتخاب فایلی که صورتی در Empty Bin Recycleممیکنی کلیک را 

 کنیم می کلیک را delete گزینه File منوي از و انتخاب را موارد کلیه پنجره آن در یا و

 کرد؟ تایپ باید چگونه جستجو کادر در شود می خت  T به و شود می شروع S با که فایلی جستجوی برای-232

T * S~ -د S * T ~ -ج T ? S ~ -ب S ? T~ -الف



 

 

 دهد؟ می نشان جزئیات با همراه را پوشه و ها فایل زیر های گزینه از کدامیک-233

 Large Icon -الف

 ب- Details 

 List-ج

 Small Icon -د

 گردد؟ می Desktop بروی آیکنها شدن مخفی یا نمایش باعث ها گزینه از انتخاب کدام-234

 Modified -الف

 ب- show desktop icons 

 Auto Arrange-ج

 Align to grid -د

 است؟ کدام باز های پنجره بستن برای میانبر کلیدهای-235

 Ctrl+Alt+F4 -لفا

 ب- Alt+F4 

 Ctrl+F4 -ج

 Shift+F4 -د

 :با است برابر پیشفرض نرمافزارهای تعداد display to programs recent of number کادر در-236

 6 -د 2 -ج 10 -ب  8 -الف

 کدام از باشد نداشته وجود آنها مجدد بازیابی امکان که طوری به ها فایل قطعی حذ  برای Windows در-237

 کنی ؟ می استفاده کلیدها

 Alt + Delete -الف

 Ctrl+Shift+Delete -ب

 Ctrl+ Delete -ج

 د- Shift + Delete

 ؟ کند می مرتب آنها تغییر یا ایجاد زمان و تاریخ اساس بر را آنها ها آیکن سازی مرتب روش کدام انتخاب-238

 show desktop icons -الف

 ب- Date modified 

 Size-ج

 Type -د

 ؟ نمود انتخاب را پوشه یک محتوای کل توان می کلیدها کدام ترکیب با-239

 Alt + a -د Ctrl + A -ج Shift + A  -ب Alt + C -الف

 Taskbar and Start محاورهای کادر از را گزینه کدام باید داد تغییر را وظیفه نوار محل نتوان اینکه برای-240

 Properties Menuنمود؟ انتخاب 

 لفا- Lock the taskbar 

 Auto_ hide the taskbar -ب

 show Quick launch -ج

 Keep the taskbar on top of other windows -د

 شود؟ می استفاده گزینه کدام از صعودی سازی مرتب برای-241

 الف- Ascending 

 -Descendingب

 Type -ج

 Date Modified -د

 است؟ کدام چاپ پنجره کردن باز جهت میانبر کلیدهای-242

 Ctrl+Z -د Ctrl+C -ج Ctrl+P -ب Ctrl+A  -الف

 ؟ است ویروس ضد افزار نرم ها گزینه از یک کدام-243

 Calculator -د Wordpad-ج Nod32 -ب Paint  -الف

 است؟ صحیح سازی فشرده مورد در گزینه کدام-244

 رساند می آسیب فایل به -ب فایل حجم کاهش براي روشی -الف 



 

 

نیست انتقال قابل فشرده فایل -د ندارد وجود پوشه براي سازي فشرده امکان -ج

 است؟ نادرست جمله کدام-245

 گیرد می قرار Bin Recycle در شده حذف فایل -الف

 کرد بازیابی توان نمی هیچگاه را شده حذف هاي فایل -ب 

 کرد وخالی پر را بازیافت صندوق توان می -ج

 کرد پاک را فایل توان می delete گزینه وانتخاب فایل نام روي راست کلیک با -د

 .شود می استفاده................ کلید از نام تغییر برای و....................7 ویندوز در آیکن چند نام تغییر امکان-246

 F1-دارد وجود -الف

 F5 -ندارد وجود -ب

 دارد وجود -ج- F2 

F3-ندارد وجود -د

 است؟ معرو  گزینه کدام به الکترونیک پست-247

 E-Mail -الف

 ب- Chat 

 E-Banking -ج

E-Commerce -د

 زنی ؟ می را دکمه کدام دهی  پاسخ ای رسیده نامه به بخواهی  اگر-248

Send -د Answer -ج Reply -ب Create  -الف

 کنی ؟ رامشاهده قبلی شده مشاهده سایتهای وب صفحات توانی  می گزینه کدام توسط-249

Back -د History -ج Favorites  -ب Forward -الف

 است؟ گزینه کدام شخصی سیست  روی بر اینترنت از فایل ذخیره-250

 الف- Download 

 Forward -ب

 Upload -ج

Explode -د

 نویسی ؟ می چه نامه Subject قسمت در-251

 گیرنده آدرس -الف

 مخفی گیرنده آدرس -ب

 نامه موضوع -ج 

نامه متن -د

 باشد؟ می وب مرورگر یک زیر های عبارت از کدامیک-252

 Word Wide Web -الف

 Network -ب

 Uniform Resource Locator -ج

 د- Internet Explorer

 کرد؟ ارسال و کرده ضمیمه فایل یک الکترونیکی نامه همراه به میتوان طریقی چه از-253

Attach File -د Body  -ج Signature -ب Subject -الف

 نیست؟ وب مرورگر یک زیر های گزینه از کدامیک-254

 fire fox -د mamma -ج IE  -ب Opera -الف

 کنی ؟ می استفاده گزینه کدام از اکسپلورر اینترنت مرورگر در خانگی صفحه تنظی  برای-255

 -Securityالف

 ب- Home Page 

 Compose -ج

 Send -د

 مشهورند؟ نامی چه به پستی صندوق در ناخواسته های پیغام-256



 

 

ایمیل -د Virus -ج Spam -ب Noise  -الف

 شود؟ می استفاده زیر گزینه کدام از اینترنت با ارتباط قطع جهت-257

 الف- Disconnect 

 Disable -ب

 Enable -ج

Stop -د

 ISP چیست؟-258

 ارتباطات و اطلاعات فناوري -الف

 اینترنت دهنده سرویس شرکت -ب 

 فایل دهنده انتقال پروتکل -ج

مخابرات -د

 شود؟ می استفاده زیر گزینه کدام از خود عالقه مورد های سایت آدرس ثبت برای-259

 الف- Favorites 

 Media -ب

 History -ج

Home Page -د

 شود؟ می استفاده ای گزینه چه از کلیک راست از پس وب در تصاویر نمودن ذخیره برای-260

 Go to my picture الف

 Show picture -ب

 Load as picture -ج

 د- Save picture as

 شود؟ می استفاده گزینه کدام از Yahoo سایت در شخصی ایمیل محل به ورود منظور به-261

 Receive -الف

 ب- Sign in 

 Check mail -ج

Sign out -د

 access exercise نباشدعبارت جستجو درعبارت exercise کلمه که شود جستجو صفحاتی بخواهی  اگر-262

 نمود؟ search توان می چگونه را

 exercise and access -الف

 access + exercise -ب

 ج- access not exercise 

exercise or access -د

 ؟ شود می نامیده چه شود می داده نمایش اتوماتیک بطور IE اجرای هنگام در که ای صفحه-263

 home page -الف

 ب- last page 

 startup page -ج

 final page -د

 باشد؟ زیرمی ی گزینه کدام غیرانتفاعی های سازمان های پسوندسایت-264

 Net -د GOV -ج Org -ب com -الف

 نمود؟ کلیک باید IE در دکمه کدام روی شده مالحظه قبلی ی صفحه به برگشتن برای-265

Refresh -د Forward -ج Back -ب Home  -الف

 است؟ کدام اینترنتی های درسایت آموزشی مراکز ی دامنه-266

 الف- Edu ب- Com ج- Gov د- Org 

 ؟.باشد می........ ویندوز، عامل سیست  در مرورگروب، ی برنامه فرض پیش-267

 Mozilla Fire Fox -الف

 Opera -ب

 Netscape -ج

 د- Internet explorer

 باشد؟ می پروتکل یک گزینه کدام-268



 

 

 Connect -د Security -ج Https -ب url- الف

 .کند می اجرا زیرا فرمان کدام ستاره، دکمه IE نوارابزار در-269

History -د Favorites -ج Refresh  -ب Stop -الف

 کادر امکد در را آن باشد باخبر آن از اصلی گیرنده فرد که صورتی به دیگر فرد به نامه رونوشت ارسال برای-270

 مینویسی ؟

Subject -د Bcc -ج CC -ب to  -الف

 ؟ کنی  می استفاده ای گزینه چه از جدول درج برای-271

 Table گروه View سربرگ -الف

 سربرگ -ب Insert گروه Table 

 Table گروه layout Page سربرگ -ج

 Table گروه File سربرگ -د

 ؟ کنی  می استفاده ای گزینه چه از پاورقی درج برای-272

 Header گزینه Reviwe برگ سر -الف

 Footnotes گزینه References برگ سر -ب

 Endnote Insert گزینه References برگ سر -ج

 برگ سر -د References گزینه Footnotes برگ سر و References گزینه Endnote Insert 

 ؟ کنی  می استفاده ای گزینه چه از صفحه به کشی خط کردن اضافه برای-273

 Ruler گزینه Insert سربرگ -الف

 سربرگ -ب View گزینه Ruler 

 Ruler گزینه Review سربرگ -ج

 Ruler گزینه Review سربرگ و Ruler گزینه View سربرگ و Ruler گزینه Insert سربرگ -د

 .کنی  انتخاب......... سربرگ از را......  گزینه باید سربرگها، طریق از مناسب قل  انتخاب برای-274

 insert \ font -الف

 ب- home \ font 

 page layout \ font -ج

page layout \ paragraph -د

 رود؟ می کار به قل  سایز کاهش برای میانبر ترکیبی کلید کدام-275

 الف- ctrl+ [ ب- ctrl>+ ج- ctrl+( د- ctrl+) 

 دهد؟ می نشان کاربر به را کاغذ صفحه طر  چهار word نماهای از یک کدام-276

 الف- print layout 

 web layout -ب

 outline -ج

 draft -د

 رود؟ می کار به موجود سند یک کردن باز برای فرمان کدام-277

 save as -د save -ج open -ب new  -الف

 .کرد استفاده........  ترکیبی کلید از باید فایل ابتدای به رفتن برای-278

 ctrl+click -الف

 ب- ctrl+home 

 ctrl+end -ج

ctrl+tab -د

 گیرد؟ قرار استفاده مورد کاربر توسط تواند می بار چند الگو هر-279



 

 

 یکبار -الف

 دوبار -ب

 بار سه -ج

 باشد مایل کاربر که تعداد هر به -د. 

 شود؟ می استفاده گزینه کدام از سند، محیط در تصویری فایل یک کردن وارد برای-280

 الف- insert \ picture 

 home \ picture -ب

 view \ picture -ج

 insert \ chart -د

 اینکه جای به شکل دارید،آن نگه پایین و داده فشار شکل یک کردن درگ حین در را ctrl دکمه چنانچه-281

 .گردد می....  شود.... 

 جا به جا- کپی -الف

 کپی - جا به جا -ب 

 قرینه- جا به جا -ج

 کپی - قرینه -د

 قلرار( ریبلون) زبانله کلدام در انتقلال و رونوشلت هلای گزینله و فونلت تغیلر خطلوط، ترازبندی- 282

 دارند؟

 view -د review -ج home -ب insert -الف

 میکنی ؟ مراجعه سربرگ کدام به بعدی تنظیمات انجام جهت جدول، رس  از پس-283

table -د view -ج design -ب home  -الف

 ؟ دارد قرار زبانه کدام در symbol گزینه-284

 الف- insert ب- home ج- review د- view 

 ؟ شوند می ذخیره پسوندی چه با word 2013 محیط فایلهای-285

dotx -د docx -ج dot  -ب doc -الف

 ؟ رسد می چاپ به سند از بخش کدام what print لیست از page odd گزینه انتخاب با-286

 زوج صفحات -الف

 فرد صفحات -ب 

 سند اول صفحه -ج

 سند آخر صفحه -د

 داد؟ قرار سند زمینه پس در رنگ ک  صورت به را متنی توان می گزینه کدام طریق از-287

 سربرگ -الف design گروه، background page گزینه، Watermark 

 سربرگ page Layout گروه،page set up ، گزینه Watermark -ب

 سربرگ page Layout گروه، background page گزینه، page border -ج

 Watermark ،گزینه link ،گروه insert سربرگ -د

 ؟ چیست شده ایجاد سندهای نمودن باز میانبر کلید-288

 الف- Ctrl + O  ب- Alt + O  ج- Ctrl + P  د- Shift +P

 ؟ کنی  می انتخاب را گزینه ،کدام Print ای محاوره کادر از جاری صفحه چاپ برای-289

 Collate -الف

 Print To File -ب

 All -ج

 د- Current Page

 نمود؟ انتخاب باید را گزینه کدام امالیی، غلط گرفتن نادیده جهت Grammar & Spelling پنجره در-290

 Ignore -ب Change  -الف



 

 

Autocorrect -د Change all -ج

 انتخاب باید Columnsای محاوره درکادر را گزینه شودکدام کشیده ستونهاخط بین در اینکه برای-291

 نمائی ؟

 الف- Line Between  

 Equal Column Width -ب

 Number Of columns -ج

 Right-to-left -د

 داری ؟ نگه پایین را کلید کدام آن رس  هنگام باید مربع یک رس  برای-292

 Alt -الف

 ب- Shift 

 Ctrl -ج

نیست کلید داشتن نگه پایین به نیاز -د

 است؟ گزینه کدام Replace فرمان میانبر کلید-293

Ctrl+A -د Ctrl+G -ج Ctrl+H -ب Ctrl+F  -الف

 است؟ صحیح گزینه کدام lock Numکلید شدن فعال هنگام-294

 .میکند فعال را تایپ قسمت اعداد -الف

 میکند فعال را حساب ماشین قسمت اعداد -ب. 

 .میکند فعال را تایپ قسمت جهتی هاي کلید -ج

 .میکند فعال را حساب ماشین جهتی هاي کلید -د

 چه؟ یعنی شیرازه-295

 صحافی براي کاغذ در متن شروع و حاشیه بین فاصله -الف 

 صحافی براي کاغذ وسط هاي حاشیه از متن اضافی فاصله -ب

 کاغذ راست و چپ از متن فاصله -ج

 متن دور کادر -د

 . کنی  می استفاده...... از جدول سطر یک حذ  برای-296

 Delete -الف

 گزینه -ب Rows Delete 

 Clean Rows -ج

گزینه Delete Rows و Clean Rows -د

 آید؟ می حساب به زیر های برنامه از یک کدام جزو اکسل برنامه-297

 گسترده صفحه -الف 

 یاطلاعات بانک -ب

 نویسی برنامه زبان -ج

 پرداز واژه -د

 دارد؟ کاربرد مورد کدام در اکسل افزار نرم-298

 پزشکی امور در -الف

 یاطلاعات هاي بانک امور به مربوط کارهاي -ب

 ویراستارها به مربوط کارهاي -ج

 مالی امور به مربوط کارهاي و مهندسی امور در -د 

 است؟ رویت قابل کجا در فعال خانه آدرس-299

 ریبون داخل در -ب فرمول نوار در -الف



 

 

 کادر در -جbox name وضیعت سطر در -د

 ؟ کنی  می استفاده گزینه چه از ستون یک محتوای کردن مرتب برای-300

 برگ سر -الف Home گروه Editing گزینه Sort & Filter 

 Fill گزینه Editing گروه Home برگ سر -ب

 Sort گزینه Editing گروه Insert برگ سر -ج

 Editing گروه layout Page برگ سر -د

 نمود؟ وارد توان نمی یاطلاعات نوع چه خانه یک در-301

تصویر -د  عددي -ج زمان و تاریخ -ب متنی -الف

 است؟ اولویت ترین پایین دارای عملگر کدام-302

 بزرگتري- د توان- ج ضرب- ب جمع -الف

 است؟ کدام 2013 اکسل های فایل پسوند-303

xlsx -د xldx  -ج xplx -ب xelx-الف

 شود؟ می استفاده دستوری چه شده انجام عمل آخرین از انصرا  برای-304

 لفا- undo 

 redo -ب

 repeat -ج

repeat و redo -د

 شود؟ می استفاده گزینه کدام از ها سلول ادغام جهت-305

 الف- home- alignment- merge cells  

 home- alignment-unmerge cells -ب

 home-alignment-split table -ج

 home - alignment-split cells -د

 شود؟ می استفاده زیر میانبر کلیدهای کدام از paste و cut فرمان اجرای برای-306

 ctrl+y - ctrl+z -الف

 ctrl+z - ctrl+y -ب

 ج- ctrl+v - ctrl+x 

ctrl+c - ctrl+v -د

 % کردن اضافه امکان format cells محاوره کادر از number درزبانه موجود های گزینه از یک کدام-307

 دهد؟ می اعداد به را) درصد(

 currency -الف

 ب- percentage 

 special -ج

number -د

 ؟ رود می بکار میانگین محاسبه برای زیر تابع کدام-308

IF -د AVERAGE -ج MAX  -ب SUM -الف

 ؟ شود می ظاهر خطا پیغام کدام ، شود انجام صفر بر تقسی  چنانچه-309

!NAME# -د DIV/0#! -ج REF! # -ب !VALUE# -الف

 ؟کنی  می استفاده دستوری چه از دهی  تغییر را کارپوشه در موجود کاربرگهای از یکی نام بخواهی  چنانچه-310

Delete -د Rename -ج Copy  -ب Insert -الف



 

 

 ؟ است تر مناسب کدام کنی  کپی را خانه درون متن قالب بخواهی  نچه چنا-311

 الف- Format Painter 

 Cut -ب

 Copy -ج

 Copy و Cut -د

 شود؟ می استفاده کلید کدام از excel در همجوار غیر سطر چند انتخاب برای-312

space -د ctrl -ج alt  -ب shift -الف

 شود؟ می استفاده دستور کدام از جداول تیتر داشتن نگه ثابت برای-313 

unfreeze -د freeze -ج split  -ب arrange -الف

 شود؟ می استفاده شرطی بندی قالب برای گزینه کدام-314

 الف- Conditional Formatting 

 Format Cells -ب

 Format -ج

Format as table -د

 ؟ شود می استفاده گزینه کدام از ها داده سری خودکار درج برای-315

 Auto Complete -الف

 Pick From Drop Down List -ب

 ج- Auto Fill 

Auto List -د

 تعریلف نلوعی چله از را آن ، شلود داده نملایش درصلد صلورت بله اعلداد A5 خانله در اینکه برای-316

 ؟ کنی  می

 الف- Percentage 

 Fraction -ب

 Currency -ج

Scientific -د

 شود؟ می استفاده کلید کدام از excel در همجوار سطر چند انتخاب برای-317

 الف- shift ب- alt ج- ctrl د- space

 ؟ رود می بکار فیلد در ها داده ورود جهت خاصی الگوی تعیین برای زیر گزینه کدام فیلد، خواص قسمت در-318

 Field Size -الف

 Default Value -ب

 ج- Input Mask 

Caption -د

319-Place Decimal ؟ است بوده دسترسی قابل داده نوع کدام برای 

 یادداشت -د تاریخ -ج متنی -ب عددي- الف 

 رود؟ می کار به جدول ساختار تغییر برای زیر های گزینه از یک کدام-320

 New دکمه -الف

 Open دکمه -ب

 دکمه -ج Design 

 داد تغییر توان نمی Access در را جدول ساختار -د

 باشد؟ باید نوعی چه از تولد سال فیلد-321

 Text -الف

 Memo -ب

 Date/Time -ج

 د- Number

 گیرند؟ می قرار گزارش بخش کدام در شوند تکرار گزارش صفحه هر یبالا در خواهی  می که متنی-322



 

 

 Detail -الف

 ب- Page Header 

 Report footer -ج

Group footer -د

 ؟ کنی  می انتخاب را................  گزینه گیرد قرار افقی بصورت جدول خروجی اینکه برای-323

 الف- LandScape 

 Portrait -ب

 Vertically -ج

 Horizontally -د

 ؟ کند می ایجاد جدولی صورت به گزارش یک زیر گزینه کدام-324

 Auto Report : Columnar -الف

 ب- Auto Report : Tabular 

 Auto Report : Data Base -ج

 Auto Report : Wizard -د

 باشد؟ می فیلد مشخصات جزء زیر های گزینه از کدامیک-325

 فیلد نام -الف

 فیلد نوع -ب

 توصیف -ج

 توصیف و فیلد نوع و فیلد نام -د 

 کرد؟ وارد مربوط ستون در نظر مورد شرط توان می زیر های گزینه از کدامیک کمک به Query یک در-326

 Show -د Table -ج Criteria -ب Sort  -الف

 تشکیل را فرم اصلی بدنه زیر های گزینه از کدامیک View Designدستی صورت به فرم طراحی روش در-327

 دهد؟ می

 الف- Details 

 Form header -ب

 Page footer -ج

 Form footer -د

 شود؟ می استفاده میانبری کلید چه از فیلد در جدید مقدار کردن جایگزین و کردن جستجو برای-328

Ctrl+H -دCtrl+Z   -ج Ctrl+D -ب Ctrl+A -الف

 رود؟ می کار به ارزی یا پولی واحد ذخیره برای زیر های داده انواع از کدامیک-329

 الف-Currency 

 Memo -ب

 Text -ج

Ole Object -د

 شود؟ می استفاده نزولی سازی مرتب برای زیر های گزینه از کدامیک از-330

 Filter by Form -الف

 ب- Sort Descending 

 Filter By Selection -ج

Sort Ascending -د

 کرد؟ استفاده باید دادهایی نوع چه از فیلد در تصویر درج برای-331

 Currency -الف

 Memo -ب

 Text -ج

 د- Ole object

 شود؟ می استفاده مشخصه کدام از فیلدها برای توصیفی نام گرفتن نظر در برای-332

 default value -الف

 ب- caption 

 new value -ج

input mask -د

 یلدف از خاصیت کدام برای را شرط شوند گرفته نظر در فیلد یک برای< 50 اعداد که کنی  اعال  اینکه برای-333

 ؟ نمود اعال  باید



 

 

 Default Value -الف

 Required -ب

 ج- Validation Rule 

Validaton Text -د

 ؟ نمود تعریف باید فیلد برای را داده نوع کدام اتوماتیک متوالی اعداد تولید برای-334

 Number -الف

 Memo -ب

 ج- Autonumber 

Hyperlink -د

 رود؟ می کار به رکورد سازی فرد به منحصر برای زیر موارد از یک کدام-335

 )rule validation(  اعتبار قانون یک -الف

 (Form)فرم -ب

 اولیه کلید -ج)key primary) 

 ()Filterفیلتر- د

 ؟ کرد چاپ و انجام جمع مانند محاسباتی ها داده روی بر توان می..........  از استفاده با-336

 گزارش- الف 

 فرم -ب

 Query -ج

Data sheet -د

 کنید؟ می انتخاب باشد می False/True محتوایش که فیلدی برای را داده نوع کدام-337

Yes/no -د Number  -ج Text -ب Date -الف

 شود؟ می استفاده اسلاید به جدول افزودن برای گزینه کدام از-338

 گزینه Insert / New Slide -الف

 گزینه -ب Table / Insert  

 Diagram /Insert گزینه -ج

 کرد اضافه اسلاید به توان نمی را جدول -د

 داد؟ مسیر روی بر موضوعات به حرکت جلوه توان می Animationسربرگ از قسمت کدام در-339

 Entrance -الف

 Emphasis -ب

 Exit -ج

 د- Motion Path

 نمود؟ اضافه اسلاید به تصویر یا متن توان نمی نما کدام در-340

 Note Page -لفا

 ب- Slide Sorter 

 Normal -ج

Outline -د

 ؟ کرد ایجاد اسلاید همان از بعد را اسلاید از کپی یک توان می کلیدها کدام فشار با-341

 Ctrl + D -دCtrl + V   -ج Ctrl + X -ب Ctrl + C -الف

 می را موضوع حرکت برای تاخیر زمان زیر گزینه کدام ، Timing قسمت در و Animationسربرگ در-342

 کرد؟ وارد توان

Repeat -د Speed -ج Delay -ب Start  -الف

 چیست؟ Point Power در نمایش فایل نام فرض پیش بطور-343

 Presentation1 -ب Book1  -الف



 

 

 Ppt -د Slide1 -ج

 کرد؟ اضافه اسلاید به یادداشت و تصویر ، متن توان می زیر نماهای از یک کدام در-344

 Slide Sorter -الف

 Draft -ب

 ج- Normal 

 Slide Show -د

 فشرد؟ باید را کلید کدام ها اسلاید نمایش به دادن خاتمه برای-345

 End -د Home -ج Ecs -ب E  -الف

 اسلاید آخرین روی و فشارداده کلید صفحه از همزمان را........کلید جوار ه  هایاسلاید انتخاب جهت-346

 .کنید می کلیک

 الف- Shift ب- Ctrl ج- Alt د- Tab

 فشاری ؟ می را ترکیبی کلیدهای کدام پاورپوینت در فایل ایجاد برای-347

ctrl+O -د Ctrl+N -جCtrl+F   -ب trl+S -الف

 کنی ؟ می انتخاب را گزینه کدام گرافیکی اشکال و اشیاء کردن بعدی سه منظور به-348

 Shadow slide -الف

 ب- D style- 3 

 Arrow style -ج

 Insert clip art -د

 کرد؟ طی باید را مراحلی چه هااسلاید گذاری شماره جهت-349

 الف- Insert/Header and footer/Slide number 

 View/Zoom -ب

 View/Slide show -ج

 /Header and footer/Slide number -د

 است؟ صحیح پاورپوینت در اسلاید ایجاد برای گزینه کدام-350

 Blank presentation -الف

 Form design tamplate -ب

 Bullet -ج

 د- New Slide 

 .باشد می..........درج برای اسلاید چیدمان درtable Insert دکمه از استفاده-351

 نمودار -د رکورد -ج فیلد -ب جدول -الف 

 هااسلاید همه چاپ برای بازشده پنجره در و کرده انتخاب را.......گزینه فایل منوی از اسلاید چاپ برای-352

 )راست به چپ از(کنی ؟ می انتخاب را........گزینه

 Print/Selection -الف

 ب- Print / All 

 Print/Current slide -ج

 Print/Custom show -د

 است؟ پذیر امکان گزینه کدام با اسلاید انتقال عمل-353

Delet -د Print -ج Cut -ب Copy  -الف

 ؟ چیست Slide Hide گزینه کار-354

 اسلاید حذف -الف

 اسلاید کردن مخفی -ب 

 اسلاید انتقال -ج

اسلاید درج -د



 

 

 ؟ شود می استفاده گزینه کدام از هااسلاید گذاری شماره برای-355

 الف- Slide Number 

 Numbering -ب

 Number Slide -ج

 Page Slide -د

 ؟ داد تغییر را ها اسلاید ترتیب توان می نما کدام در-356

 notes page -الف

 normal -ب

 ج- slide sorter 

slide show -د

 شود؟ می انجام اسلاید کدام از نمایشی برنامه اجرای slide current from گزینه از استفاده با-357

میانی اسلاید -د آخر اسلاید -ج جاري اسلاید -ب  اول اسلاید -الف

 شود؟ می مشخص صوت تکرار تعداد دستور کدام طریق از-358

 repeat -د speed  -ج delay -ب start -الف

 ؟ کند ایجادمی فرض پیش ازتنظیمات استفاده با خالی نمایشی برنامه یک مواردزیر، از یک کدام-359

 Autocontent Wizard -الف

 ب- Template 

 Open An Existing Presentation -ج

 Blank Presentatrion -د

 نامند؟ می چه را point power محیط در شده ایجاد فایلهای-360

 الف- presentation 

 book -ب

 document -ج

 chart -د

 ؟ شود انتخاب باید نمودار به مربوط منوی از گزینه کدام اسلاید یک در نمودار نوع تغییر با-361

 Chart area -لفا

 Lines -ب

 ج- Chart Type 

Chart data -د

 ؟ کرد ایجاد چهارضلعی یک اسلاید درون در توان می دستوری چه با-362

 Arrow -د Rectangle -جOval   -ب Line -الف

 .شود می..........  به تبدیل موس گر اشاره متن تایپ هنگام-363

 Curser -الف

 پنهان- ب 

 دلخواه شکل- ج

کند نمی تغییري- د

 چیست؟( ) scrollپیمایش عمل-364

 شود می گفته متن جابجایی عمل به -الف

 شود می گفته متن کپی عمل به -ب

 است کردن رها و کشیدن همان -ج

 شود می گفته پنجره محتویات مشاهده براي موس وسط کلید چرخاندن عمل به -د 

 نیست؟ تابعی کلید گزینه کدام-365

F12-د Alt -ج F3  -ب F1 -الف



 

 

 شود؟ می کنترلی کلیدهای شامل گزینه کدام-366

 الف- Ctrl-Shift-Alt -Esc 

 f12 تا F1 -ب

 Numlock-caps lock-scroll lock -ج

 arrow key -د

 ؟ کنی  می استفاده زیر افزار نرم کدام از صدا ضبط برای ویندوز در-367

 Cd Player -الف

 ب- Sound Recorder 

 Enterainment -ج

Media Player -د

 است؟ صحیح گزینه کدام-368

 دارد حساسیت وبزرگ کوچک حروف به نسبت ویندوز به ورود صفحه در عبور کلمه -الف. 

 .پذیرد می نیز را تابعی کلیدهاي ویندوز به ورود صفحه در عبور کلمه -ب

 .میپذیرد را حروف فقط ویندوز به ورود صفحه در عبور کلمه -ج

 .ندارد حساسیت وبزرگ کوچک حروف به نسبت ویندوز به ورود صفحه در عبور کلمه -د

 کنی ؟ می استفاده گزینه کدام از ها آیکن همیشگی بودن مرتب برای-369

 Sort By Name -الف

 ب- Auto Arrange icons 

 Align To Grid -ج

Show desktop icons -د

 کرد؟ استفاده ویندوز زمینه تصویر عنوان به توان نمی را زیر های پرونده از کدامیک-370

 *.jpg -د *.dat -ج bmp.*  -ب *. -gifالف

 است؟ نادرستSleep زیردرباره های گزینه از کدامیک-371

 .گیرد می قرار باش آماده حالت در کامپیوتر گزینه این روي بر باکلیک -الف

 .یابد می کاهش برق انرژي مصرف حالت دراین -ب

 .گردد برمی عادي حالت به کامپیوتر ماوس یاحرکت کلید بازدن حالت دراین -ج

 گردد می مصرف زیادي زمان و هستیم ویندوز سیستم اندازي راه به مجبور ما حالت دراین -د. 

 ؟ کنی  می استفاده روش کدام از Option Folder نمودن فعال جهت-372

 مسیر از -الف Option Folder | Panel Control | Start نمائیم می اقدام . 

 اي پنجره هر در Tools منوي از استفاده -ب

 Desktop روي بر ماوس راست کلیک از استفاده با -ج

 File Option -د

 قابل آنها عنوان نوار تنها و قرارگرفته ه  روی ها پنجره تمامی که شود می باعث سازی مرتب روش کدام-373

 باشد؟ مشاهده

 STACKED WINDOWS SHOW)اي پشته صورت به( -الف

 SIDE BY SIDE WINDOWS SHOW) هم مجاور صورت به( -ب

 آبشاري صورت به( -ج(WINDOWS CASCADE 



 

 

 Task Manager -د

 تلا شلود ملی باعلث گزینله کلدام انتخلاب General تلب و Option Folder ای محلاوره کادر در-374

 یک در پوشهها

 شوند؟ باز پنجره

 Use Windows Classic Desktop -الف

 ب- Open Each Folder In The Same Window 

 Open Each Folder In Its Own Window -ج

 My Desktop Enable All Web - Relate Content On -د

 است؟ معنا چه به( folder( پوشه-375

 .است فایل همان- الف

 ها برنامه و ها فایل سازماندهی و نگهداري براي محلی- ب 

 ها برنامه به راحتتر و سریعتر دسترسی براي آیکنی- ج

 سخت دیسک نمایش براي آیکنی- د

 است؟ معنا چه به) file)فایل-376

 گویند می رایانه در موجود اطلاعات همه به -الف. 

 ها برنامه و ها فایل وسازماندهی نگهداري براي محلی -ب

 ها برنامه به راحتتر و سریعتر دسترسی براي آیکنی -ج

 سخت دیسک نمایش براي آیکنی -د

 شود؟ می استفاده همجوار آیتمهای انتخاب برای گزینه کدام-377

Shift -د Home  -ج Ctrl -ب Alt -الف

 بینی پیش درمیزکار مختلف اطلاعات آسان و سریع ارائه برای که کوچکی های برنامه 7 ویندوز در-378

 .شوند می نامیده......  شدهاند،

Gadgets -دDesktop   -ج Menu -ب Taskbar-الف

 .گویند..................... کار نوار روی در غیره و بلندگو وضعیت ساعت، نمایش ناحیه به-379

 الف-Notification 

 Start button -ب

 Gadgets -ج

 Tasks -د

 دارند؟ قرار ناحیهای چه روی بر اجرا حال در برنامههای-380

 الف- Taskbar ب-Menu ج- Start د- Gadgets 

 است؟ ضروری پشتیبان نسخه تهیه زیر دالیل از یک کدام برای-381

 افزاري سخت مشکالت بروز -الف

 اطلاعات رفتن دست از -ب 

 ها برنامه کند اجراي -ج

یاب ویروس نصب -د

 .شود می استفاده.................  برنامه از پشتیبان نسخه تهیه برای-382

 Scan Disk -ب Disk Cleanup -الف



 

 

 ج- Backup د- Copy Disk

 شود؟ استفاده سازی فشرده برای تواند می زیر افزارهای نرم از کدامیک-383

 Wordpad -الف

 Notpad -ب

 Acd See -ج

 د- Win Zip و Win Rar

 .نمایی  استفاده....................  های کلید ترکیب از کافیست پاسخ بدون های برنامه بستن برای-384

 Ctrl+alt -الف

 Ctrl+alt+shift -ب

 ج- Ctrl+alt+delete 

Ctrl+shift -د

385- Hibernate.......یعنی  

 شود می فراهم دیگر کاربري نام با ویندوز به ورود امکان فعلی، کاربر محیط بستن بدون -الف

 .کند می قفل را رایانه -ب

 .کند می خاموش را رایانه و داده خاتمه ویندوز کار به و میبندد را باز هاي برنامه کلیه -ج

 کردن شنرو صورت در. کند می خاموش را رایانه و کند می ذخیره سخت دیسک روي بر را اجرا حال در هاي برنامه کلیه -د 

 .دهد می نمایش قبل حالت همان به را قبلی باز هاي برنامه مجدد،

 دهد؟ می انجام کاری چه Sleep گزینه-386

 کند می نگهداري حافظه در را فعلی وضعیت ها پنجره و ها برنامه بستن بدون -الف. 

 شود می فراهم دیگر کاربري نام با ویندوز به ورود امکان فعلی، کاربر محیط بستن ضمن -ب

 کند می قفل را رایانه -ج

 .کند می دازيان راه مجددا و کند می خاموش را رایانه و داده خاتمه ویندوز کار به و میبندد را باز هاي برنامه کلیه -د

387- Shut down چیست؟  

 .کند می نگهداري حافظه در را فعلی وضعیت ها پنجره و ها برنامه بستن بدون -الف

 شود می فراهم دیگر کاربري نام با ویندوز به ورود امکان فعلی، کاربر محیط بستن بدون -ب

 کند می قفل را رایانه -ج

 کند می خاموش را رایانه و داده خاتمه ویندوز کار به و میبندد را باز هاي برنامه کلیه -د. 

 .کنی  می استفاده...... کلیدهای از باز های پنجره بین جابهجایی برای-388

 Ctrl+Tab -د Alt+Tab -ج Ctrl+Esc -    ب Alt+f4 -الف

 است؟ استفاده قابل ویندوز زمینه تصویر برای زیر فایل فرمتهای از کدامیک-389

 الف- JPG ب- Docx ج- Pdf د- Dat 

 است؟ کدام ویندوز فرض پیش ت -390

 Classic Start Menu -الف 

 Start menu -ب

 ج- Windows Style 

 Defaulte Style -د

 امکد بپوشاند را صفحه کل زمینه، برای شده انتخاب تصویر اینکه برای personalize ای محاوره کادر در-391

 نمود؟ انتخاب باید Position شوی باز فهرست از را مورد

 الف- Stretch ب- Tile ج- Center د- Fill 



 

 

 مخفی فایلهای تا شود می باعث Option Folder ای محاوره کادر از View تب در گزینه کدام انتخاب-392

 گردند؟ مشاهده

 Do Not Show Hidden Or System Files -الف

 Show All Files -ب

 ج- Show Hidden Files And Folder 

 Hide File Extetion For Know File Types -د

 داد؟ تغییر را( Attributes( پوشه یک صفت توان می Properties پنجره در برگه کدام از-393

Hidden -د Customize -ج General -ب Sharring  -الف

 . شود می................  باعث برنامه آیکن روی بر کلیک دوبار-394

 برنامه اجراي -الف 

 برنامه انتخاب -ب

 میانبر منوي شدن باز -ج

 افتد نمی اتفاقی هیچ -د

 .گویند می...........  است فشرده آن چپ سمت دکمه که حالی در موس دادن حرکت عمل به-395

 (Click(  کلیک -الف

 کلیک راست -ب

 کشیدن -ج  (Drag( 

 (Double(  دوبارکلیک -د

 سخت دیسک و مانیتور و میگیرد قرار مصر  ک  حالت در کامپیوتر زیر حاالت از یک کدام انتخاب با-396

 شوند؟ می خاموش

 Shut Down -لفا

 ب- Sleep 

 Restarting MS-Dos Mode -ج

 Restart -د

 باشد؟ فایلها خصوصیت جزء تواند می زیر موارد از یک کدام-397

 Archive -الف

 ب- Read Only 

 System -ج

 Properties -د

 نیست؟ صحیح میانبرها مورد در زیر موارد از یک کدام-398

 .شوند می استفاده ها برنامه سریع اجراي جهت- الف

 .باشند می فلش عالمت یک داراي میانبرها- ب

 .نمایند می ایجاد Desktopدر میانبر یک نصب از پس بردي کار هاي برنامه از بعضی- ج

 شود می پاک نیز اصلی برنامه آن شدن پاک با -د. 

 است؟ File-View-Favorites-Help مانند مواردی شامل زیر موارد از یک کدام- 399

 (Bar Title( عنوان نوار -الف

 منو نوار -ب )Menu ) 

 (Bar Address( آدرس نوار -ج

 (Standard( ابزار نوار -د

 شود؟ می استفاده............... های کلید کیب تر از فعال پنجره بستن برای-400

Alt+Esc -د Ctrl+C -ج Alt+F4 -ب Alt+C  -الف

 شود؟ می استفاده Personalize پنجره در لینک ازکدام زمینه، طرح تغییر برای-401



 

 

 Screen Saver -لفا

 Apperance -ب

 Setting -ج

  د- Desktop background

 کرد؟ انتخاب را پوشه یک محتوای کل توان می کلید ترکیب کدام با-402

Shift+A -د Ctrl+A -ج  Alt+A  -ب Alt+C -الف

 .نمایی  انتخاب.............  باید باشد را مانیتور صفحه مرکز در شده انتخاب زمینه طرح اینکه برای-403

Modify -د  -Stretchج Center -ب Tile  -الف

 باید را سازی مرتب روش کدام) عمودی بصورت( راست به چپ از ه  کنار در ها پنجره تمام نمایش برای-404

 نمود؟ انتخاب

 الف- Show Windows side by side 

 Cascade Windows -ب

 Show Windows stacked -ج

 Minimal Windows -د

 دهد؟ می قرار باش آماده حالت در را کامپیوتر گزینه کدام انتخاب-405

 Shut down -الف

 Restart -ب

 Switch User -ج

 د- Sleep 

 را...............گزینه شده باز منوی واز نموده راست کلیک درایو آیکن روی ها درایو خواص مشاهده برای-406

 .کنی  می انتخاب

 Label -الف

 ب- Properties 

 View-ج

 Details -د

 دارد؟ نام چه گیرد می قرار آن داخل کردن Cut یا کپی از پس اطلاعات که مجازی موقت حافظه-407

 Clipboard -د Rom  -ج Paste -ب Copy-الف

 کنید؟ می انتخاب را مسیر کدام سیست  تاریخ و زمان تنظی  برای-408

 Time & Dateانتخاب و کار نوار روي بر راست کلیک- الف

 Time & Date انتخاب و Desktop صفحه روي بر راست کلیک -ب

 Start/setting/Date&Time -ج

 د- Control Panel /Date &Time 

 .کنی  می استفاده................. گزینه از نمایش صفحه از محافظت برای-409

  Desktop Background-الف

 Window color -ب

 ج- Screen Saver 

Sound-د

 

 .کنی  می استفاده.............. از فایلها چاپ برای-410

 الف- File/Print 

 Edit/Print -ب

 Insert/Print -ج

 View/ Print -د



 

 

 گیرد؟ می قرار استفاده مورد ویندوز های پنجره محتویات مرور جهت زیر های گزینه از یک کدام-411

 الف- Scroll Bar 

 Menu Bar -ب

 Tool Bar -ج

 Status Bar -د

 کنید؟ می عمل چگونه Desktop روی میانبر یک فرستادن جهت-412

 گزینه انتخاب و آیکن روي کلیک راست -الف To Send گزینه انتخاب سپس و (Shortcut Create(Desktop 

 Floppy گزینه انتخاب سپس و To Sendگزینه انتخاب و آیکن روي کلیک راست- ب

 Mail Recipient گزینه انتخاب سپس و To Send گزینه انتخاب و آیکن روي کلیک راست -ج

 Recipient Mail گزینه انتخاب سپس و To Send گزینه انتخاب و آیکن روي کلیک راست -د

 ؟ کنی  می انتخاب را گزینه کدام Computer آیکن شکل تغییر جهت-413

 Display -الف

 Screen Saver -ب

 ج- Change Desktop Icon 

Desktop background -د

 .باشد می........... کپی فرمان معادل کلید-414

 الف- Ctrl+C ب- Ctrl+V ج- Ctrl+X د- Ctrl+A 

415-Bar Taskگردد؟ می اطلاق ویندوز قسمت کدام به 

 پنجره اصلی هاي منو -الف

 پایین کار نوار -ب Desktop 

 وضعیت نوار -ج

مرورگر نوار -د

 شوند؟ می داری نگه کجا در شده حذ  اطلاعات-416

 Document -الف

 Microsoft Outlook -ب

 ج- Recycle Bin 

 Cotrol Panel -د

 ) راست به ازچپ: ( از است عبارت عکس و صوتی فایلهای) فرمت( پسوند-417

 Wav-Mpb -الف

 Doc-Bmp -ب

 ج- Wav-Bmp 

Bmp-Doc -د

 کند؟ می کمک ما به پراکنده آیتمهای انتخاب در زیر های دکمه از کدامیک-418

 Tab -د Inc -ج Ctrl -ب Alt  -الف

419"-Reset "است......... همان کردن. 

 است کردن Off Turn -الف

 کامپیوتر مجدد اندازي راه -ب 

 نیمهخاموش حالت به رایانه بردن -ج

 است انتظار حالت -د

 ؟ چیست( Saver Sceen( از منظور-420

 دیواري کاغذ -الف 

 ویندوز نمایش صفحه -ب

 متحرک نمایش -ج

 نمایش صفحه محافظ -د . 

 کنی ؟ مدیریت و مشاهده را ها درایو کلیه توانی  می پنجرهای چه به ورود با-421

 الف- Computer 

 Document -ب

 Network -ج

 Desktop -د



 

 

 چیست؟ متنی فایلهای) فرمت( پسوند-422

 Txt & Docx -د Docx  -ج Wav -ب Txt -الف

 ............ توان می فایل یک حذ  جهت-423

 نمود اجرا را Delete/View فرمان و کلیک آن روي بر -الف

 نمود انتخاب را Cut گزینه و کلید صفحه از و مربوطه فایل روي بر راست کلیک -ب

 کرد رها آنجا در و نموده درگ نمایش صفحه از اي گوشه را آن -ج

 گزینه کلید صفحه از و مربوطه فایل روي بر کلیک -د Delete نمود انتخاب را 

 دهد؟ می انجام را عملی چه Rename فرمان-424

 کردن کپی -الف

 فایل مسیر تعیین -ب

 بازیابی -ج

 ها پوشه و فایل مجدد نامگذاري -د 

 سازی ؟ ذخیره فایل یک درون را مطالب توانی  می چگونه ویندوز کاربردی های برنامه محیط در-425

 File/Copy -الف

 Edit/Save -ب

 ج- File/Save 

 Edit/Exit -د

 چیست؟ بورد کلیپ-426

 کامپیوتر جانبی حافظه -الف

 گیرد می قرار آن درون کردن کپی از بعد ها داده کامپیوترکه موقت حافظه از بخشی -ب 

 کامپیوتر دائمی حافظه -ج

 باشد تواند می ها گزینه از کدام هر مورد به بسته -د

 .میکنی  انتخاب را................  گزینه و کرده کلیک راست آن روی فایل یک ظرفیت مشاهده برای-427

 Size -الف

 ب- Properties 

 Capacity -ج

Details -د

 کرد؟ باید چه شده نوشته سطر دو بین خالی سطر ایجاد برای متن ویرایشگر های برنامه در-428

 بزنیم اول سطر انتهاي در را Shift کلید -الف

 بزنیم را Enter و کرده بلوک را اول خط ماوس با -ب

 بزنیم را Delete کلید اول خط انتهاي در -ج

 کلید دوم سطر ابتداي یا اول سطر انتهاي در -د Enter بزنیم را 

 کند؟ می مرتب اصالح آخرین تاریخ اساس بر را پنجره درون های آیکن گزینه کدام-429

 Auto Arrange -الف

 Name -ب

 Type -ج

 د- Date Modified

 چه گردد، خاموش موقت صورت به سیست  ولی بوده باز ها برنامه که حالتی در سیست  قراردادن جهت-430

 کنید؟ می انتخاب را ای گزینه

Hibernate -د Sleep -ج Standby  -ب Turn Off -الف

 .است.............. انتقال فرمان معادل کلید-431



 

 

 الف- Ctrl+X ب- Ctrl+V ج- Ctrl+C د- Ctrl+A 

 .گردد می......... شدن ظاهر باعث نگیرد، جای پنجره فضای در پنجره محتویات اگر-432

 Status Bar -الف

 Address Bar -ب

 Toolbar -ج

 د- Scrollbars

 کرد؟ اجرا را آن روشی چه به میتوان فایل، مکان از اطالع عدم صورت در-433

 Run پنجره در Browse دکمه از استفاده -الف

 از استفاده -ب Search 

 My Computer -ج

 نیست عملی کار این -د

 کنی ؟ می استفاده مسیر ازکدام Wordpad محیط در دیگر های افزار نرم از تصویر دادن قرار برای-434

 View/Object -لفا

 Edit/Object -ب

 ج- Insert/Object 

File/Object -د

 امکد از است بهتر شود سیست  وارد دیگری کاربر و شود قطع کامپیوتر با فعلی کاربر ارتباط اینکه برای-435

 کنی ؟ استفاده گزینه

 انتخاب -الف Off Log 

 sleep انتخاب -ب

 Off Turn پنجره از down shutانتخاب -ج

 Hibernate -د

 ؟ کنی  می استفاده مسیری چه از Explorer Windows اجرای برای-436

 Computer پنجره فقط -الف

 است دسترسی قابل ویندوز هاي پنجره همه در -ب 

 Explorer Windows آیکن -ج

 C درایو طریق از فقط -د

 به مربوط Propertiesای محاوره کادر در درایو کل گنجایش دهنده نشان زیر های گزینه از یک کدام-437

 است؟ دیسک

 الف- Capacity 

 Type -ب

 Free Space -ج

 Used Space -د

 بزرگ حرو  بین جستجو هنگام در میتوانPad Word نرمافزار در Find پنجره از گزینه کدام انتخاب با-438

 شد؟ قائل تفاوت کوچک و

 Between -الف

 Advanced -ب

 ج- Case Sensitive 

 During The Previous Day -د



 

 

 تایپ باید چگونه جستجو کادر در شود، می خت  S به و شده شروع Mبا که سهحرفی فایل جستجوی برای-439

 کرد؟

M*S~ -د S?M~ -ج M?S~ -ب S*M ~ -الف

 گردد؟ می وظیفه نوار شدن قفل باعث گزینه کدام انتخاب وظیفه نوار تنظیمات ای محاوره کادر از-440

 Show Quick Launch -الف

 ب- Lock the taskbar 

 Auto Hide The Task Bar -ج

 Hide Inactive icon -د

 گیرد؟ می قرار منو کدام در معموال آنها میانبر آیکن ها، برنامه نصب هنگام-441

 Accessories منوي -الف

 ب- All Program 

 Accessories منوي از System منوي -ج

 File -د

 کاغذ نوع و کاغذ اندازه تعیین و کاغذ نوع ها، حاشیه تغییر جهت Paint افزار نرم در ها گزینه از کدامیک-442

 رود؟ می بکار

 الف- Page Setup 

 Save As -ب

 Print Preview -ج

 Open -د

 کنی ؟ می انتخاب Sort منوی زیر از را مورد کدام شوند، مرتب آنها نوع اساس بر ها آیکن اینکه برای-443

 By Name -الف

 By Data -ب

 ج- By Item Type 

Auto Arrange -د

 است؟ صحیح گزینه کدام صدا تنظی  منظور به-444

 کار نوار روي بر صدا آیکن روي بر کلیک-الف 

 All Program/Accessories/sound recorder -ب

 Computer -ج

 Setting -د

 شود؟ می کار میز در آیکنها نمایش عدم یا نمایش باعث گزینه کدام-445

 Auto Arrange -لفا

 Align To Grid -ب

 Date Modified -ج

 د- Show Desktop Icon

 .شود می استفاده.......... گزینه Start منوی کردن سفارشی منظور به-446

 Properties menu start &Taskbar/ میزکار روي کلیک راست- الف

 ب- Start/Properties 

 Computer -ج

 Properties انتخاب و Desktop روي راست کلیک -د



 

 

 باید را گزینه کدام شوی  منتقل دیگری User به بخواهی  و نشوند بسته فعال های پنجره اینکه برای-447

 کنی ؟ انتخاب

 Standby -الف

 Log Off -ب

 ج- Switch User 

 Restart -د

 .کنی  می انتخاب را......... گزینه گیرد قرار Desktop در کاری کاشی صورت به زمینه تصویر اینکه برای-448

 الف- Tile ب- Stretch ج- Center د- Position 

 کنی ؟ می استفاده گزینه کدام از سیست  به دیگر زبان یک کردن اضافه برای-449

 الف- Language\ Add Language Control Panel \ Region And 

 Setting\Control Panel \mouse -ب

 Control Panel \power option -ج

 Setting\Keyboard \ Language -د

 کنی ؟ می استفاده ابزار نوار گزینه کدام از فایلها نمایش نحوه تعیین برای-450

Address -د View -ج Back  -ب Forward -الف

 .دهد می انجام را................  عمل cut فرمان-451

 کردن کپی -الف

 دادن انتقال -ب 

 حافظه از فراخوانی -ج

کردن پاک -د

 ندارد؟ را فایل ایجاد قابلیت افزار نرم کدام Windows در-452

Calculator -د Paint  -ج Word Pad -ب notepad -الف

 شود؟ می باز طریق کدام از Printer نصب مخصوص پنجره-453

 Computer\ Faxes -الف

 Computer \Printer -ب

 Document \Printers -ج

 د- Control Panel \Devices And Printers 

 چیست؟ در Apply و OK های دکمه تفاوت- 454

 .شود می تغییرات آن لغو باعث Apply ولی کند می ثبت را شده انجام تغییرات Ok -الف

 ب- Ok ولی شود می بسته پنجره بالفاصله و کرده ثبت را تغییرات Apply نددب نمی را پنجره ولی ثبت را تغییرات. 

 .بندد می را پنجره و ثبت را تغییرات Apply ولی دارد می نگه باز را پنجره و کرده ثبت را تغییراتOk -ج

 .دهند می انجام را عمل یک دو هر -د

 .شود می استفاده..........گزینه از جدید افزار سخت نمودن اضافه برای-455

 الف- Control Panel \Devices And Printers 

 Add\Remove Program -ب

 Folder Option -ج

 Hardware Addگزینه و Panel Control پنجره -د



 

 

 معناست؟ چه به دارد ای وظیفه چند ماهیت ویندوز-456

 کند اجرا را برنامه زیادي تعداد تواند نمی- الف

 کند اجرا همزمان را برنامه زیادي تعداد تواند می- ب. 

 کند ذخیره طوالنی زمان مدت براي حافظه در را متعدد وظایف تواند می- ج

 کند اجرا هم با متنی برنامه چند تواند می فقط- د

 .شود می استفاده..........................  کلیدهای ترکیب از باز های پنجره بین جابهجایی جهت-457

Ctrl + V -د Alt + Tab -ج Ctrl + Z  -ب Alt + Esc -الف

 جستجو کادر در شود می خت  S به و شود می شروع M با و بوده حرفی پنج که فایلی جستجوی برای-458

 نمود؟ تایپ باید چگونه

M???S~ -د m?s  -ج M(S( -ب S*M -الف

 است؟ کدامPaste و Copy فرمان میانبر های کلید-459

Ctrl + Y ،Ctrl + A الف   

Ctrl + E ،Ctrl + Y ب-   

ج- Ctrl C, Ctrl +V  

 Ctrl + V ،Ctrl + A -د

 چه کنی  رها سپس و بکشی  خود دلخواه سمت به را آن و داشته نگه را کلیک چپ آیکن یک روی بر اگر-460

 ای ؟ داده انجام عملی

 لفا- Drag and Drop 

 Double click -ب

 Right click -ج

 Click -د

 .نمایی  می استفاده پنجره کنترل منوی از......  گزینه از میزکار در پنجره جابجایی برای-461

Restore -د Close -ج Move -ب Size -الف

 نمود؟ تایپ باید Search برنامه در را مورد کدام صوتی فایلی جستجوی برای-462

 *.jpg -د *.mp3 -ج txt.*  -ب *.music -الف

 گزینه از اند بوده دسترسی قابل یا و شده ایجاد یافته، تغییر گذشته ماه در که فایلهایی جستجوی جهت-463

 نمایی ؟ می استفاده....... 

 Yesterday-الف

 ب- Last Month 

 This Month -ج

Last Week -د

 .................... نگیرد قرار Bin Recycle در شده حذ  اطلاعات اینکه برای-464

 داریم می نگه پایین را Ctrl کلید حذف موقع در -الف

 داریم می نگه پایین را Alt کلید حذف موقع در -ب

 کلید حذف موقع در -ج Shift داریم می نگه پایین را . 

 نیست پذیر امکان -د

 دبای را گزینه کدام گردد آشکارومخفی اتوماتیک وظیفه نوار اینکه برای Properties Taskbar پنجره در-465



 

 

 نمود؟ انتخاب

 Keep the taskbar on top of other windows -لفا

 ب- Auto hide the taskbar 

 Show Quick launch -ج

 Show the clock -د

 است؟ نادرست زیر های گزینه از کدامیک-466

 کند می قفل را ویندوز کار نوار taskbar the Lock -الف

 است سیستم اصلی هاي پوشه از Windows پوشه -ب

 باشد می ویندوز جانبی یا فرعی هاي برنامه جزو Paintنقاشی ي برنامه- ج

 د- taskbar the Lock کند می مخفی را ویندوز کار نوار 

 و شده متصل دیسک یستمیس نواحی یا و اجرایی برنامه به عمال که هستند کوچکی های برنامه-............... 467

 .گذارند می نامطلوب اثرات آنها روی بر

 اجرایی هاي برنامه -الف

 ها ویروس -ب 

 Bin پسوند با فایلهایی -ج

 Com پسوند با فایلهایی -د

 است؟ کدام سیست  به ویروس ورود از جلوگیری موثر راههای از یکی-468

 روز به یاب ویروس از استفاده -الف 

 مشکوک فایلهاي حذف- ب

 یکبار ساعت هر ویروس ضد هاي برنامه اجراي- ج

 مشکوک درایو کردن فرمت- د

 کرد؟ پیدا دسترسی Panel Controlپنجره به توان می زیر روشهای از کدامیک توسط-469

 الف- Start Menu 

 Task Bar -ب

 Always On Top -ج

 Auto Hide -د

 جابجا را ابزار نوار گزینه کدام طریق از Properties Menu Star and Bar Task ای محاوره کادر در-470

 کنی ؟ می

 Toolbars -الف

 Taskbar Location on Screen -ب

 ج- Auto Hide The Task Bar 

Unlock the Taskbar -د

 گیرد؟ می قرار منو کدام در معموال آنها میانبر آیکن ها، برنامه نصب هنگام-471

 Document پنجره از File منوي -الف

 منوي -ب Program All 

 Computer پنجره از Tools System منوي -ج

 Computer پنجره -د

 شود؟ می دار خط زیر صورت به متنی شدن نوشته باعث زیر های گزینه از یک کدام انتخاب-472

 Underline -ب Italic  -الف



 

 

Super Scribe -د Bold -ج

 میکنی ؟ اقدام مسیری چه از کلید صفحه تنظیمات اعمال برای- 473

 پنجره از -الف Panel Control انتخاب Keyboard 

 Keyboard انتخاب Computer پنجره از -ب

 از پنجره Control Panel انتخاب Keyboard And Mouse -ج

 Mouse And Keyboard انتخاب Computer پنجره از -د

 چیست؟( Resolution Screen( نمایش صفحه وضوح- 474

 گرافیک کارت حافظه میزان -الف

 نمایش صفحه هاي پیکسل تراکم میزان -ب 

 مانیتور اندازه -ج

 نمایش صفحه شفافیت -د

 نمایی ؟ می عمل چگونه جدید نام با متن یک کردن ذخیره جهت-475

 فرمان از -الف as save منوي در File 

 File ازمنوي save فرمان از -ب

 Format منوي در Font فرمان از -ج

 Edit منوي در save فرمان از -د

 .است انجام قابل..........  پنجره طریق از سیست  تنظیمات اکثر-476

 Computer -الف

 ب- Control Panel 

 Document -ج

 Start -د

 رود؟ می بکار جزئیات با ها آیکن نمایش جهت گزینه کدام-477

 الف- Details ب- Small ج- Tile د- Large 

 نیست؟ صحیح زیر جمالت از یک کدام-478

 باشند داشته پسوند توانند نمی ها پوشه -الف

 هستند پسوند بدون ها فایل -ب 

 گویند می هم Document فایل به گاهی -ج

 است فولدر همان پوشه -د

 کنی ؟ می استفاده گزینه کدام از کنی  ارسال دیگران برای را رسیده نامه بخواهی  اگر-479

 Reply -الف

 Reply To All -ب

 فرمان -ج Forward 

فرمان Forward To All -د

 : Add To Favorites هد -480

 یاطلاعات فایلهاي کپی جهت -الف

 Web صفحات)ذخیره( نگهداري جهت -ب

 یاطلاعات فهرستهاي کپی جهت -ج



 

 

 عالقه مورد هاي سایت لیست به کردن اضافه -د 

 ؟ کنی  می استفاده گزینه کدام از وب صفحه یک کردن ذخیره برای-481

 الف- File/Save As 

 Edit/Save Picture As -ب

 File/Save -ج

 File/Save As Picture -د

 دارند؟ قرار پوشه کدام در Express Outlook در شده دریافت پیغامهای-482

Draft -د Sent -ج INBOX -ب Outbox  -الف

 ؟ نیست الزم تجهیزات کدام اینترنت برقراری برای-483

 مودم -الف

 تلفن خط -ب

 اینترنت از استفاده اشتراک کد -ج

 صدا کارت -د 

 ؟ است کدام آموزشی سایت یک پسوند-484

 الف- Edu ب- Net ج- Mit د- Com 

 شود؟ می استفاده گزینه کدام از وب صفحه رسانی بروز برای-485

 Home -د Refresh -ج Forward  -ب Back -الف

 ؟ چیست معر  Http عبارت ، Com.Yahoo.Www://Http آدرس در-486

 Second Level Damain -الف

 Top Level Domaim -ب

 پروتکل -ج 

 شود داده نشان مرورگر توسط باید که وب صفحه نام -د

 ؟ است دولتی سازمان معر  زیر های دامنه از یک کدام-487

 Org -د Gov -ج Edu  -ب Com -الف

 می نشان اید کرده اخیرمشاهده روزهای در راکه سایتهایی ازتمام فهرستی IE دکمه کدام روی بر کلیک-488

 دهد؟

History -د Mail  -ج Favorites -ب Search -الف

 ؟ کرد انتخاب باید را سازی ذخیره نوع کدام وب های متن تنها ذخیره برای-489

 web Page , Complete -الف

 Web Art -ب

 Web Page , Html only -ج

 د- Txt File

 چه General بخش در Current Use دکمه روی بر کلیک Option Internet ای محاوره کادر در-490

 شود؟ می انجام عملی

 صفحه عنوان به را جاري صفحه آدرس -الف Page Home گیرد می درنظر . 

 . دهد می قرار Page Homeعنوان به را است شده داده قرار Page Home بعنوان Ie نصب هنگام در که وبی صفحه -ب

 . دهد می قرار خانگی وب صفحه را Blank -ج

 . گیرد می درنظر Page Home صفحه عنوان به را فرض پیش صفحه آدرس -د

 ؟ کرد کلیک باید دکمه کدام روی بر شده مالحظه قبلی صفحه به برگشتن برای-491



 

 

Home -د Back -ج Forward  -ب Refresh -الف

 ؟ کنی  می کلیک ابزار نوار از را ای دکمه چه کنی  متوقف IE در را ای صفحه شدن باز بخواهی  اگر-492

 الف- Stop ب- Refresh ج- End د- Back 

  جستجوی نتایج و دهد می قرار جستجو موتور چند در را شما جستجوی مورد واژه که جستجویی موتور-493

 ؟ شوند می نامیده چه کنند می لیست شما برای را آنها

 Directionary Sites -الف

 Search Engines -ب

 ج- Meta Search Engines 

Search Dictionary -د

 ؟ است وب صفحات مرورگر زیر افزارهای نرم از یک کدام-494

 الف- Internet Explorer 

 Add To Favorites -ب

 Creat In -ج

 Put In -د

 ؟ شود می گفته چه کند می میسر را نامه دریافت و ارسال امکان که شبکه سرویس به-495

 E-Marketing -الف

 E-Commerece -ب

 ج- E-Mail 

 E-Banking -د

 ؟ گویند می چه دهی  می قرار کامپیوترخود روی بر اینترنت از را فایلی که فرآیندی به-496

 الف- Download 

 Upload -ب

 Upgrade -ج

 Turboload -د

 ؟ کنی  می استفاده کلید کدام از شده خواست در وبسایت یک بازدید از انصرا  جهت-497

Home -د Stop -ج Back  -ب History -الف

 ؟ کنی  می استفاده دکمه کدام از شده ویزیت صفحات سوابق حذ  برای-498

 Clear Address -الف

 ب- Clear History 

 Clear Favorites -ج

Clear Cookie -د

 ؟ کنی  می استفاده دکمه کدام از کنونی وب صفحه مجدد فراخوانی برای-499

Search -د Favorites -ج Refresh -ب History  -الف

 ؟ باشد می شما کامپیوتر به وب صفحه کامل انتقال از نمودن نظر صر  منظور به............  دکمه-500

 الف- Stop ب- Back ج- Forward د- Home

 ؟ باشد خالی صفحه یک خانگی صفحه شود می موجب ها گزینه کدام انتخاب Internet درپنجره-501

 Clear History -الف

 ب- Use Blank 

 Use Default -ج

Use Current -د

 ؟ نمایی  مشاهده را قبلی شده مشاهده های سایت وب صفحات کلیه توانی  می گزینه کدام توسط-502

History -د Forward  -ج Back -ب Home -الف

 ؟ است الزم اینترنت با کار برای زیر افزارهای نرم از یک کدام-503

 الف- Internet Explorer 

 Windows Explorer -ب

 Documents -ج

 Control Panel -د



 

 

 ؟ باشد می اینترنت با ارتباط قطع معنی به زیر های گزینه از یک کدام-504

 الف- Disconnect 

 Connect -ب

 Stop -ج

Shut Down -د

 ................ کند می فراه  مشترکانش برای را اینترنت به یابی دست امکان وجه دریافت مقابل در که شرکتی-505

 دارد؟ نام

 ISP -د FIP  -ج Server -ب URL -الف

 ؟ دهد می نشان را چیزی چهHistory نوار-506

 (Media( رسانه هاي گزینه -الف

 شده ذخیره وب آدرس -ب

 (Search( جستجو آیتمهاي -ج

 اند شده بازدید قبال که سایتهایی وب -د 

 شود؟ می مشاهده کجا در ای  شده آن وارد که سایتی نام-507

 شود می مشاهده Downloads در -الف

 شود می مشاهده page Home در -ب

 شود می مشاهده Bookmarks در -ج

 شود می مشاهده مرورگر آدرس نوار در -د 

 ؟ دهد می نشان را سایت بودن آموزشی زیر های دامنه از یک کدام-508

 Edu -د Mil  -ج Org -ب Net -الف

 استفاده.......  نام با ازدامنه تجاری وسازمانهای موسسات ،کمپانی، تجاری های سایت نمودن مشخص جهت-509

 میکنی ؟

End -د Net -ج Com -ب Gov  -الف

 ؟ باشد نمی الکترونیکی پست مزایای از کدامیک-510

 باشد داشته حضور مقصد در باید نامه ارسال حال در حتما پیغام گیرنده -الف . 

 . است پذیر امکان الکترونیکی هاي نامه همراه به ،تصویري صوتی فایلهاي ارسال -ب

 . باشد می ارزانتر دیگر هاي دهنده سرویس به نسبت اقتصادي نظر از -ج

 .مقابل طرف پستی صندوق به پیام انتقال از اطمینان ضریب و بالا سرعت -د

 بجز را COMپسوند با اینترنتی آدرس یک نیاز مورد زیرقسمتهای ترکیبی ازکلیدهای یک کدام فشردن-511

 نماید؟ می اضافه آدرس نام

 Alt + Home -الف

 Alt + Eter -ب

 ج- Ctrl + Enter 

 Home -د

 است شده جدا ه  از......  عالمت توسط دهنده سرویس نام و کاربری نام الکترونیکی پست آدرس در-512

 @ -د  اسلش -ج () -ب ! -الف

 ؟ نیست سایت وب یک به دسترسی عدم احتماالت جزء زیر موارد از کدامیک-513



 

 

 . باشد افتاده کار از ISP اینترنت -الف

 . باشد شده مشکل دچار سایت وب -ب

 . باشد رسیده پایان به اینترنت اشتراک -ج

 سایت وب در حد از بیش تصاویر داشتن -د 

 ؟ است پذیر امکان ابزاری چه توسط شده مشاهده وب صفحه یک رسانی بروز عملیات-514

 ابزار نوار در Back دکمه -الف

 ابزار نوار در History دکمه -ب

 F9 کلید -ج

 د- F5 

 ؟ است زیر موارد از یک کدام صفحات طراحی استاندارد زبان-515

 Hyper Language -الف

 ب- Html 

 Http -ج

word -د

 ؟ کرد استفاده توان نمی سایتها کدام از IE توسط اینترنت در جستجو عمل انجام برای-516

Blogfa -د Msn  -ج Googel -ب Yahoo -الف

 ؟ شود می متصل کامپیوتر قسمت کدام به تلفن خط اینترنت با ارتباط برقراری برای-517

 صدا کارت -د گرافیک کارت -ج شبکه کارت -ب مودم -الف 

 :است صورت این به دستگاه کدام کار-518

 شود می ارسال تلفن خط طریق از بعد و شده اسکن ابتدا شود می دستگاه وارد که کاغذي

 تلکس -الف

 ISDN -ب

 مودم -ج

 فاکس -د 

 باشد؟ می نادرست زیر های گزینه از یک کدام-519

 .کند می تبدیل بالعکس یا آنالوگ سیگنالهاي به را کامپیوتر یک دیجیتال سیگنالهاي مودم -الف

 باشد می جهانی شبکه یک ، اینترانت -ب. 

 پیوسته هم به که باشد می مختلف افزارهاي نرم و افزار سخت ، مسیریاب ، کابل ، کامپیوتر میلیونها از متشکل ، اینترنت -ج

 .است

 .ستنی متصل اینترنت به ولی شود می ایجاد اینترنت هاي وپروتکل قوانین اساس بر که است خصوصی شبکه اینترانت -د

 گویند؟ می..........  پیوند این به باشد صدا یک یا تصویر طریق از وب صفحه دو پیوند اگر-520

 Hyper Text -الف

 ب- Hyper Media 

 Hyper Link -ج

Hyper Sound & Image -د

 نمایید؟ می ابزارکلیک نوار از دکمه کدام روی بر اصلی نامه گیرندگان همه به نامه پاسخ ارسال برای-521

 Forward -د Reply All -ج Reply -ب send  -الف

 شود؟ می مشخص قسمت درکدام) کپی( اضافی های گیرنده آدرس نامه ارسال برای-522

BCC -د CC -ج From  -ب - Toالف



 

 

 در را آن آدرس شود، مطلع نامه موضوع از اصلی گیرنده طوریکه به دیگر فرستنده به نامه یک رونوشت ارسال برای

 کنید؟ می وارد قسمت کدام

BCC -د From -ج CC -ب To  -الف

 گردد؟ ظاهرمی بشه ارسال بالا اولویت با که هایی نامه کنار در عالمت کدام-523

 * -د ! -ج  () -ب ؟ -الف

 شود؟ می ذخیره پوشه کدام در گردد می ارسال شما آدرس به که هایی نامه کلیه-524

Drafts -د sent Items -ج Inbox -ب Outbox  -الف

 شود؟ می استفاده...... از افراد مشخصات و آدرس ذخیره برای-525

 الف- Address Book 

 Mail Box -ب

 Sent Items -ج

 Inbox -د

 .است اینترنت و رایانه ازطریق....  تبادل نوعی الکترونیک پست اصل در-526

فرستنده- د نامه- ج  ماشین- ب انسان- الف

 افتد؟ می اتفاقی چه بنویسی  رااشتباه الکترونیک پست یک اگرادرس-527

 شود می داده برگشت مناسب باپیام نامه- الف 

 رود می ازبین نامه خاصی اتفاق هیچ بدون -ب

 پیام بدون شودولی می داده یکباربرگشت معمولی هاي نامه مانند -ج

 گیرد قرارمی item out درپوشه -د

 شود؟ می استفاده گزینه ازکدام یاهو درسایت الکترونیک پست منظورساخت به-528

 Sign out -الف

 Check mail -ب

 ج- Create new account 

 Receive -د

 است؟ درست جمله کدام-529

 باشد فرد منحصربه ایمیل آدرس براي پسورد -الف

 فرداست منحصربه الکترونیک پست آدرس یک -ب 

 کند ایجاد ایمیل آدرس کارخود براي تواند نمی سایتی هیچ -ج

 دهد رانمی رایگان ایمیل ایجاد امکان سایتی هیچ -د

 هستند؟ عنوانی چه دارای اند نشده مقصدارسال به هردلیلی به که هایی نامه-530

 Re notice -الف

 Return to back -ب    

 ج- Failure notice 

Failure back -د

 مشهورند؟ نامی چه به پستی درصندوق ناخواسته های پیغام-531

 e-mail -د virus -ج Spam -ب Noise  -الف

 .است...........شاملoutboxپوشه-532

 است شده دریافت هاي نامه لیست -الف

 است نشده تکمیل انها ارسال فرایند هنوز که است هاي نامه لیست -ب 



 

 

 است شده حذف هاي نامه لیست -ج

 است شده ارسال هاي نامه لیست -د

 شود؟ می زیرذخیره های ازپوشه درکدامیک بایگانی عنوان به ارسالی های ازنامه نسخه یک-533

 الف- Sent item 

 Out box -ب

 inbox -ج

 draft -د

 د؟کنی می انتخاب را گزینه بماندکدام پوشیده گیرندگان ازسایر نامه یک رونوشت آنکه برای-534

 کنیم واردمیccرادرقسمت ان آدرس -الف

 رادرقسمت آن آدرس -بbccکنیم واردمی 

 واردمیکنیمtoرادرقسمت ان ادرس -ج

 کنیم می واردfromرادرقسمت ان ادرس -د

 ؟ نوشت آن در را خود های نامه اینترنت به اتصال بدون توان می زیر برنامه کدام-535

 yahoo -الف

 Google -ب

 ج- Outlook Express 

msn -د

536-Reدرsubjectدارد؟ معنایی چه 

 شوند می مشخص عالمت بااین مشکوک هاي نامه -الف

 اید می نیستند ادرس دردفترچه که هایی ادرس براي عالمت این -ب

 بدهیم را اي نامه پاسخ بخواهیم که شود می ظاهر زمانی عالمت این -ج 

 اید می هستند ادرس دردفترچه که هایی ادرس براي عالمت این -د

 ؟ کنی  می استفاده دکمه کدام از بفرستی  دیگری افراد برای را شده دریافت نامه بخواهی  اگر-537

 الف- Forward 

 Work offline -ب

 Reply -ج

 Send -د

 رابزنید؟......... گزینه باید حتما پستی صندوق بستن برای ایمیل با کار بعدازاتمام-538

 Log out -د sign up -ج sign out -ب sign in  -الف

 شود؟ می داری نگه فولدر کدام در ناقص یا تمام نیمه های نامه-539

 الف- draft ب- trash ج- inbox د- Send 

 رود؟ می کار به منظوری چه به) نامه رایا)mail create پنجره در bcc کادر-540

 نامه اصلی گیرنده الکترونیکی پست آدرس- الف

 محرمانه صورت به نامه رونوشت فرستادن براي- ب 

 نامه رونوشت ارسال براي -ج

 اولویت در نامه ارسال براي -د

 ها نامه لیست درپنجره که) یادآوری برای( شود گذاری نشانه شما توسط تواند می نامه هر-541

 شود می مشخص.....باعالمت

 گیره -د سوال -ج تعجب -ب پرچم -الف 



 

 

 .................................نامه آن کنی  حذ  item delete ی ازپوشه ای نامه اگر-542

 نیست بازیابی قابل- الف 

 است بازیابی قابل -ب

 است خواندن قابل -ج

 نیست حذف قابل -د

 ؟ است استفاده قابل ثالث شخص به توضیحات برخی همراه به شده دریافت پیام ارجاع برای فرمان کدام-543

 Reply -الف

 Reply To All -ب

 فرمان -ج Forward 

فرمان Forward To All -د

 دارد نام....... شود می داده نمایش اتوماتیک طور به IE اجرای هنگام در که ای صفحه-544

 الف- Home Page 

 Start Up Page -ب

 Last Page -ج

 Final Page -د

 ؟ است الزم اینترنت با کار برای زیر افزارهای نرم از یک کدام-545

 الف- Internet Explorer 

 Windows Explorer -ب

 Documents -ج

 Control Panel -د

 ؟ دهد می نشان را چیزی چهHistory نوار-546

 (Media( رسانه هاي گزینه -الف

 شده ذخیره وب آدرس -ب

 (Search( جستجو آیتمهاي -ج

 اند شده بازدید قبال که سایتهایی وب -د 

 ؟ کنی  می استفاده ای دکمه چه از پیش هفته در شده ویزیت وب صفحات مجدد مشاهده جهت-547

 الف- History ب- Back ج- Favorites د- Home 

 جدا ازدیگری......  عالمت توسط بخش هر و است شده تشکیل مجزا بخش چندین از سایت یک آدرس-548

 است؟ شده

 . -د اسلش -ج () -ب  ! -الف

 ؟ باشد می اسکنر دستگاه و مودم از ترکیبی زیر دستگاه از یک کدام-549

فاکس -د  مودم -ج ISDN -ب تلکس -الف

 شود؟ می مشخص قسمت رادرکدام گیرنده آدرس نامه، ارسال هنگام در-550

 الف- To ب- From ج- C د- Bcc 

 شود؟ می مشخص قسمت درکدام اضافی های گیرنده آدرس نامه ارسال برای-551

BCC -د CC -ج From  -ب To -الف

 گیرد؟ می قرار پوشه درکدام نویس پیش های نامه-552

 Inbox -الف

 Out box -ب

 Sent items -ج

 د- Draft 

 .است...........................محدودیت دارای ضمیمه فایل ارسال-553

 زمانی -ب ارسالی فایل حجم -الف 



 

 

 ارسال سرعت -د مکانی -ج

 باشد؟ نمی الکترونیک پست ازویژگیهای زیر های گزینه از یک کدام-554

 .باشد...... و صوتی فایل و تصویر تا متن یک شامل توان می الکترونیکی نامه یک -الف

 باشند اشته حضورد اي گیرنده شخص الکترونیکی پست ارسال هنگام -ب. 

 .کنیم استفاه الکترونیکی پست افزار نرم یک از نامه دریافت و ارسال -ج

 .است صرفه به و ارزان الکترونیکی صورت به نامه ارسال -د

 رابزنید؟......... گزینه باید حتما پستی صندوق بستن برای ایمیل با کار بعدازاتمام-555

 sign in -الف

 ب- sign out 

 sign up -ج

Log out -د

 شود؟ می داری نگه فولدر کدام در ناقص یا تمام نیمه های نامه-556

 الف- draft ب- trash ج- inbox د- Send 

  ؟کنی طی باید را زیر مسیرهای از کدامیک Express Outlook برنامه در نامه یک ایجاد برای-557

 ابزار نوار روي بر کلیک -الف mail create 

 edit/new/mail message -ب

 file/message/new message -ج

 Edit -د

 رود؟ می کار به منظوری چه به) نامه یا)mail create پنجره در bcc کادر-558

 نامه اصلی گیرنده الکترونیکی پست آدرس -الف

 محرمانه صورت به نامه رونوشت فرستادن براي -ب 

 نامه رونوشت ارسال براي -ج

 اولویت در نامه ارسال براي -د

 توان می امهن پنجره استاندارد ابزار نوار در...........ی دکمه از نامه همراه به پیوست یا ضمیمه فرستان برای-559

 .کرد استفاده

 الف- Attach ب- check ج- spelling د- Priority 

 کنی ؟ می انتخاب را گزینه کدام آدرس کتابچه بازکردن برای-560

 View/Address -الف

 ب- Tools/Address book 

 Edit/Message -ج

Tools/Replay -د

 شود؟ می استفاده منظوری چه برایImapپرتکل-561

 ایمیل ارسال -الف

 ایمیل دریافت -ب

 ایمیل ودریافت ارسال -ج 

فایل دریافت -د

 .................................نامه ان کنی  حذ  item deleteی ازپوشه ای اگرنامه-562

 نیست بازیابی قابل -الف 

 است بازیابی قابل -ب

 است خواندن قابل -ج

نیست حذف قابل -د



 

 

 کنید؟ استفاده کلید درصفحه کلیدی توانیدازچه می ها نامه حذ  برای-563

Ctrl+shift -د Space -ج Delete -ب Cntrl+f1  -الف

 .گویند می....... صفحات این از یک هر به که است شده تشکیل صفحه چندین از مطلب ارائه هرفایل-564

کاربرگ -د سند -ج اسلاید -ب  الیه -الف

 .دارد اسلاید.......حداقل مطلب ارائه هرفایل-565

 4 -د 1 -ج  3 -ب 2 -الف

 .دهد می نشان را فایل نوع و مشخصات که است..........نوار افزار نرم در نوار ترینبالا-566

 آدرس نوار -الف

 عنوان نوار -ب 

 ریبون -ج

 سریع دسترسی ابزار نوار -د

 برای الزم امکانات به توان می آن وسیله به که شود می باز افزار نرم منوی دکمه این روی بر کلیک با-567

 .کرد پیدا دسترسی ها فایل مدیریت

 Options -د Home -ج File -ب Office  -الف

 .استPoint Powerافزار نرم پرکاربرد دستورات شامل ابزار نوار این-568

 عنوان نوار -الف

 سریع دسترسی ابزار نوار -ب 

 ریبون -ج

 کنترلی هاي دکمه -د

 .اند شده بندی دسته ه  به مرتبط ابزار تعدادی آنها از یک هر در که است...........تعدادی شامل ریبون-569

 الف- Tab ب- Group ج- Tools د- Slide 

 .شود می استفاده افزار نرم کردن وکوچک بستن برای نوار این از-570

 پیمایش نوار -الف

 سریع دسترسی ابزار نوار -ب

 کنترلی هاي دکمه -ج 

اسلاید ویرایش ناحیه -د

 راستای در است پنجره ی اندازه از بزرگتر آن محتوای که زمانی در ها اسلاید توانی  می..........از استفاده با-571

 .کنی  پیمایش افقی و عمودی

 پیمایش نوارهاي -الف 

 عنوان نوار -ب

 اسلاید ویرایش ناحیه -ج

وضعیت نوار -د

 کنی ؟ اصالح را آن توانی  می فعال اسلاید از ناحیه کدام در-572

 گوینده نکات کردن اضافه ناحیه -الف

 اسلاید ویرایش ناحیه -ب 

 افزار نرم کاري فضاي -ج

 ها اسلاید لیست -د

 از یستیل و. دارد قرار point power افزار نرم ی پنجره راست یا چپ سمت در عمودی صورت به-..........573

 .دهد می نشان را مطلب ارائه فایل در موجود ی ها اسلاید

 اسلایدنوار -الف 

 پیمایش نوار -ب

 اسلاید ویرایش ناحیه -ج

وضعیت نوار -د

 .شود می استفاده اسلاید نمائی کوچک یا بزرگنمایی برای..........ابزار از-574

 الف- Zoom ب- Undo ج- Redo د- Save 



 

 

 .شود می استفاده بعدی اسلاید به ورفتن قبل اسلاید به بازگشت برای..........و..........ابزارهای-575

 Next Slide -لفا

 Previous slide -ب

 Comments -ج

 د- previous slide و Next slide

 شود؟ می استفاده slide مختلف های قسمت در..........ایجاد برای comments ابزار از-576

 یاداشت -الف 

 نویسی فرمول -ب

 پاورقی -ج

 اسلاید ویرایش -د

 .شود می استفاده point power در ها اسلاید کردن مدیریت و جابجایی برای.......... نمای از-577

 الف- Slide Sorter 

 Normal -ب

 Reading view -ج

 Slide show -د

 جلسه در نکنندگا شرکت به شده طراحی های اسلاید نمایش برای توان می افزار نرم در.................  نمای از-578

 .کرد استفاده

 Slide Sorter -الف

 Normal -ب

 Reading view -ج

 د- Slide show

 .کرد استفاده توان می شده طراحی های slide خواندن برای........نمای از-579

 Normal -الف

 Slide show -ب

 ج- Reading view 

Slide sorter -د

 شود؟ می استفاده ترکیبی های کلید چه از file منوی کردن باز برای-580

 الف- Alt +f ب- Alt +f1 ج- Ctrl +f د- Shift +f  

 شود؟ نمی استفاده مطلب ارائه فایل کردن ذخیره برای زیر های گزینه از یک کدام از-581

 Save گزینه انتخاب و File ي دکمه از -الف

 سریع دسترسی نوار از Saveگزینه از استفاده -ب

 S+ Ctrl ترکیبی هاي کلید از استفاده -ج

 ریبون از -دHome گزینه Save 

 ؟دهی  می انجام را.......  عملیات افزار، نرم از کننده استفاده کاربر نام تغییر برای-582

 دکمه منو از -الف file گزینه options قسمت و General گزینه name User 

 name User گزینه proofing قسمت و options گزینه file دکمه منو از -ب

 name User گزینه Advanced قسمت و options گزینه file دکمه منو از -ج

 name User گزینه language قسمت و options گزینه file دکمه منو از -د

 است؟ مناسب مطلب ارائه فایل یک کردن باز برای راه کدام-583

 دکمه منو از -الف file گزینه open 

 save گزینه file دکمه منو از -ب

 New گزینه file دکمه منو از -ج

 shere گزینه file دکمه منو از -د

 چیست؟ point Power افزار نرم در مطلب ارائه فایل یک کردن باز برای راه ترین سریع-584

Ctrl+c -د Ctrl+o -ج Ctrl+m  -ب Ctrl+s -الف



 

 

 است؟ مناسب گزینه کدام point Power 2013 افزار نرم از خروج جهت-585

 F3+Alt ترکیبی هاي کلید -الف

 Exit گزینه File دکمه -ب

 W + Ctrl ترکیبی کلیدهاي -ج

 ترکیبی کلیدهاي -د F4 + ALT

 کنی ؟ می انتخاب را......... گزینه........ وگروه........ سربرگ به جدید Slide یک ایجاد برای-586

 الف- HOME > SLIDE > NEW SLIDE 

 HOME > NEW > SLIDE -ب

 View > SLIDE > NEW SLIDE -ج

 DESIGN > NEW > NEW SLIDE -د

 است؟ کلیدهایی چه فشردن slide یک ایجاد برای راه ترین سریع-587

 SHIFT +M -د CTRL +M -ج ALT +M  -ب CTRL +N -الف

 .شود می استفاده است عنوان زیر و عنوان قالب با اسلاید ایجاد منظور به....... از slide چیدمان در-588

 الف- TITLE SLIDE 

 TITLE AND CONTENT -ب

 SELECTION HEADER -ج

 TITLE ONLY -د

 شود؟ می استفاده غیرمتنی محتوای نگهداری و عنوان نگهداری برای....... چیدمان از هاslide چیدمان در-589

 Title slide -الف

 ب- Title and content 

 Title only -ج

Section heather -د

 شود؟ می استفاده متن نگهداری و عنوان نگهداری برای.......  چیدمان از ها Slide چیدمان در-590

 Title slide -الف

 ب- Title and content 

 section header -ج

Two content -د

 .شود می استفاده ارائه شروع اسلاید برای معموال و است عنوان نگهدارنده یک شامل چیدمان این-591

 Tow content -الف

 Comparison -ب

 ج- Title only 

Title slide -د

 .است متنی غیر دارنده نگه ویک متن دارنده نگه ویک عنوان دارنده نگه یک شامل چیدمان این-592

 الف- Content with caption 

 Comparison -ب

 Title only -ج

 Two content -د

 .است متن دارنده نگه یک عنوان دارنده نگه یک تصویر دارنده نگه یک شامل چیدمان این-593

 Blank -الف

 Content and caption -ب

 Title only -ج

 د- Picture with caption

 .کنی  طراحی دلخواه صورت به توانی  می و نیست ی دارنده نگه هیچ شامل چیدمان این-594

 Title only -الف

 ب- Blank 

 Title slide -ج

Two content -د

 کرد؟ استفاده میتوان ای دکمه چه از اسلاید چند انتخاب برای-595

 .کنیم می کلیک اسلاید پنل در آن روي بر باید فقط اسلاید یک انتخاب براي -الف



 

 

ــراي -ب ــوالی اســلاید چنــد انتخــاب ب ــین روي و نگهداشــته را CRTL مت ــورد اســلاید آخــرین و اول  مــی لیــکک نظــر م

 .کنیم

ــراي -ج ــد انتخــاب ب ــر اســلاید چن ــوالی غی ــد مت ــورد هــاي اســلاید روي و نگهداشــته را Shift کلی ــی لیــکک نظــر م  م

 .کنیم

 ــراي -د ــاب ب ــد انتخ ــوالی اســلاید چن ــته را Shift مت ــین روي و نگهداش ــرین و اول ــورد اســلاید آخ ــ م ــک رنظ ــی کلی  م

 .کنیم

 است؟ مناسب اسلاید یک حذ  برای روش کدام-596

 .زنیم می را Erase گزینه و کنیم می کلیک راست نظر مورد اسلاید روي ها اسلاید پنل در -الف

 .فشاریم می را کیبورد End دکمه و کنیم می کلیک نظر مورد اسلاید روي ها اسلاید پنل در -ب

 .فشاریم می را Delete گزینه slide گروه و Home سربرگ در -ج

 دکمه و کنیم می کلیک نظر مورد اسلاید روي ها اسلاید پنل در -د Delete مفشاری می را کیبورد. 

 نیست؟ مناسب راه کدام شده بریده یا و کپی های اسلاید یا اسلاید چسباندن برای-597

 Paste گزینه زدن و sorter Slide یا Normal نماي در ها اسلاید خالی فضاي در کلیک راست -الف

 Paste گزینه انتخاب و clipboard گروه Home برگ سر به رفتن -ب

 v+ctrl ترکیبی هاي کلید از استفاده -ج

 برگ سر به رفتن -د Home گروه clipboard گزینه انتخاب و Replace 

 رنظ مورد ت  روی بر کلیک راست با کنی  اعمال ها اسلاید همه روی را انتخابی ت  بخواهی  که صورتی در-598

 است؟ مناسب گزینه کدام

 الف- Apply to all slides 

 Apply to selected -ب

 Set as default theme -ج

 Add gallery to quick access toolbar -د

 است؟ مناسب گزینه کنیمکدام تعیین فرض پیش ت  عنوان به را انتخابی های ت  بخواهی  که صورتی در-599

 Apply to all slide -الف

 Apply to selected slides -ب

 ج- Set as default theme 

Add gallery to quick access toolbar -د

 مناسب گزینه کدام شود اعمال انتخابی های Slide روی بر فقط شده انتخاب ت  بخواهی  که صورتی در-600

 است؟

 Apply to all slide -الف

 ب- Apply to selected slide 

 Set as default theme -ج

Add gallery to quick access toolbar -د



 

 

 می انتخاب را گزینه کدام شود اضافه سریع دسترسی ابزار نوار به ها ت  گالری بخواهی  که صورتی در-601

 کنی ؟

 Apply to all slide -الف

 Apply to selected slide -ب

 ج- Add gallery to quick access toolbar 

Set as default theme -د

 کنی ؟ یم انتخاب را.......  گروه زیر و.......  گروه.......  سربرگ از اسلاید زمینه پس رنگ تغییر برای-602

 Design > Variants > Colors -الف

 Design > Variants > background styles -ب

 ج- Design > Customize > format background 

 Design > Themes -د

 Format ی پنجره در را.......  گزینه باشد متفاوت رنگ دو ترکیب با زمینه پس رنگ بخواهی  که صورتی در-603

background کنی ؟ می فعال 

 Slide fill -الف

 ب- Gradient fill 

 Pattern fill -ج

 Picture and texture fill -د

 شود؟ می استفاده زمانی چه background Format ی پنجره در fill Pattern گزینه از-604

 زمینه پس رنگ براي رنگ تک از استفاده براي -الف

 زمینه پس رنگ در افزار نرم خاص الگوهاي از استفاده براي -ب 

 زمینه پس رنگ براي متفاوت رنگ دو ترکیب براي -ج

 زمینه پس عنوان به دلخواه فایل و تصویر از استفاده براي -د

 شود؟ می استفاده منظور چه به background Format ی پنجره در Transparency خاصیت-605

 زمینه پس مکان تغییر -الف

 زمینه پس شفافیت تغییر -ب 

 زمینه پس رنگ تغییر -ج

زمینه پس ابعاد تغییر -د

 .........توانی  می master Slide ابزار در اصلی اسلاید طراحی در-606

 کنیم مشخص را مطلب ارائه فایل ي ها اسلاید زمینه پس و عناصر موقعیت ظاهري، نماي -الف. 

 .رود می کار به جلسه در حاضرین براي مطلب ارائه فایل هاي اسلاید چاپی نسخه الگوي طراحی براي -ب

 .دهیم می قرار استفاده مورد مطلب ارائه فایل هاي اسلاید دهنده ارائه نکات ظاهري نماي تعیین براي -ج

 کرد ایجاد توان نمی تغییري هیچ اصلی اسلاید طراحی در -د

 برای مطلب ارائه فایل های اسلاید چاپی نسخه الگوی طراحی برای گزینه کدام ها اسلاید طراحی در-607

 رود؟ می کار به جلسه در حاضرین

 Slide master -لفا

 Master view -ب

 ج- Handout master 

Note master -د



 

 

 ی دهنلده ارائله نکلات ظلاهری نملای تعیلین بلرای view master گلروه در ابزارهلا از یلک کدام-608

 فایل های اسلاید

 گیرد؟ می قرار استفاده مورد مطلب ارائه

 Slide master -الف

 ب- Note master 

 Handout master -ج

Master view -د

 می استفاده اسلاید یک تنظیمات تمام بازنشانی منطور به Slides گروه Home سربرگ در ابزار این از-609

 شود؟

 الف- Reset 

 Layout -ب

 Selection -ج

 New slide -د

 شود؟ می استفاده ها اسلاید بندی بخش برای Slide گروه و Home سربرگ در ابزار این از-610

 Reset -الف

 Layout -ب

 ج- Section 

New slide -د

 .شود می استفاده متن رنگ و سایز و نوشتاری فونت نوع تنظیمات برای گروه این از Home سربرگ در-611

 الف- Font 

 Paragraph -ب

 Drawing -ج

 Editing -د

 شود؟ می استفاده منظور چه به Font گروه در shadow Text ابزار از-612

 دار سایه متن ایجاد -الف 

 دار خط زیر متن ایجاد -ب

 متنی کاراکترهاي بین فاصله -ج

 گرافیکی هاي متن ایجاد -د

 شپی حالت به را متن فونت و سایز و رنگ قبیل از متن به مربوط تنظیمات تمام Font گروه از ابزار این-613

 .گرداند برمی اولیه و فرض

 الف- Clear all formatting 

 Reset -ب

 Text shadow -ج

 Align text -د

 شود؟ می استفاده Paragraph گروه ابزار کدام از شده گذاری عالمت لیست یک ایجاد برای-614

 الف- Bullets 

 Numbering -ب

 Right to left text direction -ج

 Arrange -د

 شود؟ می استفاده منظور چه به case Change ازابزار-615

 کوچک یا بزرگ حروف با متن نوشتن تعیین براي -الف 

 h2o اندیس صورت به متن تعیین -ب

 (X2( توان صورت به متن تعیین -ج

 متن هاي کاراکتر بین فاصله تعیین -د

 .گیرد می قرار استفاده مورد گذاری شماره لیست ایجاد برای ابزار کدام-616

 Bullets -الف

 ب- Numbering 

 Right to left text direction -ج

Arrange -د



 

 

 شود؟ می استفاده منظور چه به spacing line ابزار از-617

 متنی هاي کاراکتر بین فاصله تعیین -الف

 متنی هاي ستون تعداد تعیین -ب

 خطوط بین فاصله تعیین -ج 

 متن هاي بندي تراز تعییین -د

 شود؟ می استفاده متنی کادر در متن جهت تعیین برای Paragraph گروه در ابزار این از-618

 الف- Text direction 

 Text align -ب

 Increase list level -ج

 Decrease list level -د

 .... توانی  می art smart to Convert ابزار از استفاده با-619

 کنیم تبدیل هندسی اشکال کادر به را متنی کادر -الف

 کنیم تبدیل هوشمند تصاویر کادر به را متنی کادر -ب 

 کنیم تبدیل جدول به را متنی کادر -ج

 کنیم تبدیل نمودار کادر به را متنی کادر -د

 .شود می اضافه افزار نرم دستورات سربرگ به نیز..........  و.............  وابسته سربرگ دو نمودار درج هنگام در-620

 Home - insert -الف

 Home - format -ب

 ج- Design - format 

Insert - home -د

 ؟ چیست Find پنجره کردن باز برای راه ترین سریع-621

 الف- Ctrl + F 

 Ctrl + v -ب

 Ctrl + e -ج

 Alt +ctrl +F -د

 ؟ کنی  می فعال را گزینه شوندکدام پیدا جستجو کادر در مستقل لغات قفط بخواهی  که صورتی در-622

 Match case -الف

 ب- Find whole words only 

 Use wildcards -ج

Match kashida -د

 یکسان جستجو مورد باعبارت حرو  کوچکی و بزرگی نظر از شده یافت های عبارت بخواهی  که صورتی در-623

 کنی ؟ می فعال را گزینه کدام باشد

 الف- Match case 

 Find whole words only -ب

 Use wildcards -ج

 Match kashida -د

 .کند می جستجو نیز را شده کشیده عبارتهای جستجو کادر در گزینه این-624

 Match case -الف

 Find whole words only -ب

 Use wildcards -ج

 د- Match kashida

 گیرد؟ می قرار استفاده مورد دیگر عبارت با عبارتی کردن جایگزین برای دستور کدام از-625

Undo -د Save -ج Replace -ب Find  -الف

 را ابزار و هکرد مراجعه............  گروه..............  سربرگ به Replace یا گرینی جای دستور از استفاده برای-626

 .کنی  می انتخاب

 الف- HOME ( EDITING ) REPLACE 

 INSERT ( EDITING ) REPLACE -ب

 DESIGN ( EDITING ) REPLACE -ج

EDITING ( HOME ) REPLACE -د



 

 

 . است..................  و................  ترکیبی های کلید Replace دستور فراخوانی برای راه ترین سریع-627

 Ctrl + r -د Ctrl +h -ج Ctrl + w  -ب Ctrl + F -الف

 ؟ است تر مناسب گزینه کدام شود انتخاب اسلاید یک در عنصری بخواهی  که صورتی در-628

 Select -الف

 Select all -ب

 ج- Select object 

Select pane -د

 شود؟ می استفاده منظور چه به pane Selection ابزار از-629

 آن کردن مخفی یا نگهدارنده یک انتخاب -الف

 ها اسلاید متن کل اتنخاب -ب

 اسلاید از عنصر یک انتخاب -ج 

تصاویر اتنخاب -د

 کنی ؟ می انتخاب را گزینه کدام دلخواه ستون و سطر تعداد با جدول یک ایجاد برای-630

 الف- Insert table 

 Draw table -ب

 Excel spread sheet -ج

 Table -د

 ؟ نمایی  می انتخاب را گزینه کدام کنی  طراحی دستی را جدولی بخواهی  که صورتی در-631

 Insert table -الف

 ب- Draw table 

 Excel spread sheet -ج

 Table -د

 نهگزی کدام کنی  point Power افزار نرم وارد Excel افزار نرم محیط از را جدولی بخواهی  که صورتی در-632

 کنی ؟ می انتخاب را

 Insert table -الف

 Draw table -ب

 ج- Excel spread sheet 

Table -د

 است؟ مناسب ابزار کدام کنی  اسلاید وارد اینترنت از تصویری یک بخواهی  که درصورتی-633

 Pictures -الف

 ب- Online pictures 

 Screen shot -ج

Photo album -د

 گیرد؟ می قرار استفاده مورد تصاویر آلبوم یک ایجاد برای ابزار کدام از-634

 Pictures -الف

 Online pictures -ب

 Screen shot -ج

 د- Photo album 

 است؟ مناسب هندسی اشکال کردن اضافه برای گزینه کدام-635

 الف- Shapes 

 Smart Art -ب

 Chart -ج

 Hyper link -د

 شود؟ می استفاده هوشمند گرافیکی تصاویر کردن اضافه جهت insert سربرگ در ابزار کدام-636

 Shapes -الف

 ب- Smart Art 

 Chart -ج

 Hyper link -د

 شود؟ می استفاده نمودار کردن اضافه جهت insert سربرگ در ابزار کدام-637

 Shapes -الف

 Smart Art -ب

 ج- Chart 

Hyper link -د



 

 

 ؟ است مناسب ها اسلاید روی بر یادداشت درج جهت insert سربرگ در ابزار کدام-638

 Word art -الف

 Header and footer -ب

 Text box -ج

 د- Comment

 ؟ است مناسب ها اسلاید روی بر متن تایپ محل یک درج جهت insert سربرگ در ابزار کدام-639

 Word art -الف

 Header and footer -ب

 ج- Text box 

Comment -د

 ؟ است مناسب ها اسلاید روی بر صفحه پا و صفحه سر درج جهت insert سربرگ در ابزار کدام-640

 Word art -الف

 ب- Header and footer 

 Text box -ج

Comment -د

 شود؟ می استفاده منظور چه به art Word ابزار از-641

 گرافیکی تصاویر ایجاد -الف

 گرافیکی متن ایجاد -ب 

 یادداشت ایجاد -ج

صفحه پا و صفحه سر ایجاد -د

 شود؟ می استفاده منظور چه به time and Date ابزار از-642

 زمان و تاریخ درج -الف 

 گرافیکی متن درج -ب

 یادداشت درج -ج

 صفحه پا و صفحه سر درج -د

 شود؟ می استفاده منظور چه به number slide ابزار از-643

 تصویر درج -الف

 هوشمند اشکال درج -ب

 اسلاید شماره درج -ج 

 زمان و تاریخ درج -د

 .......منظور به object ابزار از-644

 مرتبط غیر هاي افزار نرم هاي فایل قبیل از سخت دیسک حافظه داخل از هایی فایل درج -الف 

 رارق سخت دیسک روي بر فایل صورت به و اند شده ایجاد دیجیتال هاي دوربین و ها افزار نرم توسط که تصاویري درج -ب

 دارند

 بعدي سه و گرافیکی متن درج -ج

 نمودار درج -د

 .گیرد می قرار استفاده مورد..... درج برای افزار نرم در symbol ابزار از-645

 ویژه عالیم و ها کاراکتر درج -الف 

 ریاضی معادالت درج -ب

 تصاویر درج -ج

هندسی اشکال درج -د

 .گیرد می قرار استفاده مورد..... درج برای افزار نرم در equation ابزار از-646

 ویژه عالیم و ها کاراکتر درج -الف

 ریاضی معادالت درج -ب 

 تصاویر درج -ج

هندسی اشکال درج -د

 گیرد می قرار استفاده مورد اسلاید به اینترنت طریق از ویدیو درج برای ابزار این از-647



 

 

 Picture -الف

 ب- Online video 

 Text box -ج

 Audio -د

 .شود می استفاده وغیره اسلاید سایز ،و زمینه پس رنگ تنظی  ، اسلاید طراحی برای سربرگ این از-648

 Transition -الف

 Insert -ب

 ج- Design 

 Home -د

 شود می استفاده اسلاید عبور های حالت انتخاب جهت..... سربرگ از-649

 الف- Transition 

 Insert -ب

 Design -ج

 Home -د

 موردنظر اسلاید در شده انتخاب عبور های حالت از نمایشی پیش transition سربرگ در...... ابزار از-650

 شود؟ می مشاهده

 Timing -الف

 Effect option -ب

 Transition to this slide -ج

 د- Preview

 زینهگ........ ابزار از کنی  اضافه را خودمان نظر مورد صدای اسلاید Transition به بخواهی  که صورتی در-651

 کنی  می انتخاب را........ 

 الف- (Sound ( other sound  

 Audio ( other audio) -ب

 Sound ( loop unit next sound) -ج

 Audio ( loop unit next sound) -د

 زا پلس کله کنیلد تعریلف برنامه برای میتوانید timing گروه transition سربرگ در گزینه این انتخاب با-709

 شدن سپری

 .برود بعدی اسلاید به خودکار صورت به شده مشخص زمان مدت

 Apply to all -الف

 ب- After 

 Sound -ج

 Duration -د

 .شود می استفاده ها اسلاید دیگر عناصر روی بر Animation کردن کپی برای ابزار این از-652

 Trigger -الف

 Start -ب

 Animation pane -ج

 د- Animation painter

 چیست؟ Animation سربرگ در Start گزینه عملکرد-653

 کند می مشخص را انیمیشن شدن آغاز نحوه -الف 

 کند می مشخص را Animation پخش زمان کاهش یا افزایش -ب

 .انداخت تاخیر به را Animation پخش توان می نظر مورد زمان درج با -ج

 کند می پخش را انیمیشن -د

 دهد؟ می نشان را Animation نمایش زمان مدت طول زیر های ابزار از یک کدام-654

Delay -د Duration -ج Start  -ب Trigger -الف



 

 

 شود؟ می انیمیشن نمایش در تاخیر موجب آن عددی کادر در مقداردهی با زیر های ابزار از یک کدام-655

Delay -د Duration  -ج Start -ب Trigger -الف

 را Start از گزینه کدام اجراشود ماوس کلیک با عنصر روی بر شده ایجاد انیمیشن بخواهی  که درصورتی-656

 کنی ؟ می انتخاب

 Start -الف

 With previous -ب

 ج- On click 

After previous -د

 هگزین کدام اجراشود خود از قبل انیمیشن با عنصرهمراه روی بر شده ایجاد انیمیشن بخواهی  که درصورتی-657

 ؟ کنی  انتخاب را

 Start -الف

 ب- With previous 

 On click -ج

After previous -د

 نهگزی کدام اجراشود خود از قبل ازانیمیشن بعد عنصر روی بر شده ایجاد انیمیشن بخواهی  که درصورتی-658

 کنی ؟ می انتخاب

 Start -الف

 With previous -ب

 On click -ج

 د- After previous

 ؟ چیست نخست اسلاید از ها اسلاید نمایش برای روش ترین سریع-659

 الف- F5 

 Shift + F5 -ب

 Ctrl + F5 -ج

 Alt + F5 -د

 .شود می استفاده جاری اسلاید از ها اسلاید نمایش منظور به ابزار این از-660

 Present online -الف

 From beginning -ب

 ج- From current slide 

Custom slide show -د

 .بپردازی  سفارشی شو اسلاید یک ایجاد به توانی  می show slide سربرگ در ابزار این از استفاده با-661

 Present online -الف

 From beginning -ب

 From current slide -ج

 د- Custom slide show

 شود؟ می استفاده آنها نمایش و اسلاید تنظیمات به دسترسی منظور به زیر ابزارهای از یک کدام-662

 الف- Set up slide show 

 From beginning -ب

 From current slide -ج

 Custom slide show -د

 . شود می استفاده نمایش حالت در ها اسلاید کردن مخفی برای ابزار این از-663

 الف- Hide slide 

 Setup slide show -ب

 Record slide show -ج

 From current slide -د

 رود؟ می کار به اسلاید و انیمشین هر زمانبندی منظور به زیر های ابزار از یک کدام-664

 Hide slide -الف

 Setup slide show -ب

 Record slide show -ج

 د- Rehearse timing

 شود؟ می استفاده منظور چه به beginning from recording start ابزار از-665



 

 

 ها اسلاید روي بر صدا ضبط -الف

 اسلاید آخرین تا اولین روي بر صدا ضبط -ب 

 زمانبندي ایجاد -ج

 صدا کنترلی هاي دکمه نمایش -د

 های غلط کردن برطر  برای ها روش از یک کدام ها اسلاید متن در املایی های غلط وجود صورت در-666

 است؟ مناسب املایی

 اشتباه واژه روي بر Click Double -الف

 Grammer گزینه Review سربرگ -ب

 سربرگ -ج Review گزینه spelling 

translate گزینه Review سربرگ -د

 ؟ کنی  می رافعال ها گزینه کدام ای شبکه و راهنما خطوط نمایش برای-667

 Ruler - grid line -الف

 ب- Grid line- guides 

 Ruler- guides -ج

 Note- Ruler -د

 کند؟ می نمایش صفحه اندازه ه  را اسلاید ابعاد زیر های ابزار از یک کدام-668

 الف- Fit to window 

 Zoom -ب

 New window -ج

 Switch window -د

 کند؟ می کمک شده ترسی  هندسی شکل ترتیب کردن جا به جا برای یک کدام زیر های ابزار از-669

 الف- Arrange 

 Quick styles -ب

 Shape outline -ج

 Shape effect -د

 شود؟ می استفاده منظور چه به arrange گروه format سربرگ در Rotate ابزار-670

 عناصر چرخش -الف 

 عناصر بندي تراز -ب

 عناصر کردن گروه -ج

 عرض و طول ابعاد تغییر -د

 print پنجره در را گزینه کدام کنی  چاپ را مطلب ارائه فایل های اسلاید تمام بخواهی  که صورتی در-671

 ؟ کنی  می انتخاب

 الف- Print all slide 

 Print selection -ب

 Print current slide -ج

 Custom range -د

 زا گزینه کدام شوند چاپ صفحه تمام صورت به ها اسلاید ،اسلاید چاپ هنگام در بخواهی  که صورتی در-672

 گزینی ؟ برمی را layout print کادر

 Handouts -الف

 Outline -ب

 Note pages -ج

 د- Full page slides

 یم انتخاب را گرینه کدام شود چاپ آن بانکات همراه مطلب ارائه فایل های اسلاید بخواهی  که صورتی در-673

 ؟ کنی 

 Handouts -الف

 Outline -ب

 ج- Note pages 

Full page slides -د

 ؟ کنی  می انتخاب را گرینه کدام شود چاپ اسلاید هر های متن فقط بخواهی  که صورتی در-674

 Handouts -الف

 ب- Outline 

 Note pages -ج

 Full page slides -د



 

 

 باشد؟ نمی کامپیوتر مزایای از زیر های گزینه از یک کدام-675

 بالا سرعت -الف

 بالا اطمینان ضریب -ب

 گسترده هاي حجم در اطلاعات ثبت قدرت -ج

 بالا خطاي ضریب -د 

 شود؟ می محسوب شخصی کامپیوتر یک گزینه کدام-676

 الف- Desktop - Laptop 

 mainframe -ب

 mini computer -ج

 super computer -د

 ؟ ست ا درست شما نظر به زیر تعاریف از یک کدام-677

 هاي کــامپیوتر -الف Laptop هستند حمل قابل . 

 . ند ا شده تشکیل Laptop کامپیوترهاي به نسبت کوچکتري اجزاي از Desktop کامپیوترهاي -ب

 . نیستند حمل قابل Laptop هاي کامپیوتر -ج

 .است Minicomputer نوعی PC -د

 .شوند می اطلاق...............  ها داده پردازش نتیجه به-678

 الف- Information 

 Data -ب

 افزار نرم -ج

 عامل سیستمهاي -د

 است؟ کلماتی چه مخفف Pc واژه-679

 الف- Personal Computer 

 PresetComputer -ب

 Processing -ج

 PrimaryComputer -د

 است؟ Information کلمه مصداق زیر تعاریف از یک کدام-680

 شود می تولید ها داده پردازش از پس که هایی خروجی به -الف . 

 خام هاي داده -ب

 شوند می سیستم وارد کلید صفحه توسط که مطالبی -ج

 است فایل همان -د

681-Cpu ؟ است کلماتی چه مخفف 

 Unit Control Processing -الف

 Cd Processing Unit -ب

 ج- Central Processing Unit 

Cache Processing Unit -د

 است؟ چندبایت معادل مگابایت هر-682

 1024 -* 1024 - الف 

 1024*1024*1024 -ب

 1000 -ج

 1024*1024*1024*1024 -د

 باشد؟ می صحیح تعاریف از یک کدام-683



 

 

 . است کمتر جانبی حافظه از اصلی حافظه سرعت -الف

 . است یکسان اصلی و جانبی حافظه در ذخیره ظرفیت -ب

 است کمتر آن ظرفیت ولی بیشتر جانبی از اصلی حافظه سرعت -ج . 

 . است اصلی حافظه از کمتر جانبی هاي حافظه ظزفیت -د

 است؟ صحیح Rom حافظه مورد در گزینه کدام-684

 است پایدار و خواندنی فقط -الف . 

 . است ناپایدار و خواندنی فقط -ب

 . است وناپایدار نوشتنی فقط -ج

 . است وپایدار نوشتنی فقط -د

685-Cpu ؟ است شده تشکیل قسمتهایی چه از 

 کنترل واحد -منطق و محاسبه واحد -پنهان حافظه -اصلی حافظه -الف

 خروجی واحد - اصلی حافظه -پنهان حافظه - کنترل واحد -ب

 پنهان حافظه و ثباتها - کنترل واحد -منطق و محاسبه واحد -ج 

 اصلی حافظه -خروجی واحد -پنهان حافظه -ورودي واحد -د

 است؟ بایت چند معادل بایت کیلو هر-686

1024 -د  1000 -ج 512 -ب 128 -الف

 شود؟ می استفاده دستگاهی چه از کامپیوتر حافظه به تصاویر انتقال برای-687

 Mouse -الف

 ب- Scanner 

 joystick -ج

 keyboard -د

 هستند؟ کامپیوترها نوع کدام از شخصی های کامپیوتر-688

 Mini Computer -الف

 Supper Computer -ب

 Main Frame Computer -ج

 د- Micro Computer

 باشد؟ می صحیحDVD مورد در زیر های گزینه از یک کدام-689

 پشتیبان نوار- الف

 دیجیتال ویدیویی دیسک- ب 

 نرم دیسک- ج

سخت دیسک- د

 شود؟ می اطلاق چیزی چه به سیلندر یا استوانه دیسک، سطح بندی تقسی  در-690

 یکسان شعاع با ها شیار از اي مجموعه- الف 

 اي صفحه چند دیسک یک در شماره هم هاي ع قطا از اي مجموعه -ب

 نیستند شعاع یک داراي که سخت دیسک از شیارهایی مجموعه -ج

 هستند استوانه شکل به که گویند می سخت دیسکهاي به -د

 ؟ گیرد می شهرصورت یک در سازمان یک دفاتر اتصال برای معموالً زیر های ازشبکه یک کدام-691

 الف- man 

 Lan -ب

 wan -ج

 اینترنت شبکه -د

 ؟ شود می استفاده دائ  یا موقت صورت به اطلاعات نگهداری برای زیر موارد از کدامیک-692

 منطق و واحدمحاسبه- ب واحدکنترل- الف



 

 

 مرکزي واحدپردازش- د واحدحافظه- ج 

 ؟ است صورت چه به Ramحافظه در اطلاعات به دسترسی-693

 سري -د موازي -ج تصادفی -ب  ترتیبی -الف

 است؟................... دستگاه یک فلش حافظه-694

 ورودي -الف

 خروجی/ورودي -ب

 خروجی- ج

 حافظه- د 

 شود؟ می تقسی ................ نام به مساوی قسمتهای به شیار هر دیسک درسطح-695

 سیلندر- الف

 VGA-ب

 توسعه شکاف -ج

 قطاع -د 

 .باشند می....................  دستگاههای جز کدام هر بلندگو - کلید صفحه-696

 خروجی- ورودي-الف 

 ورودي-ورودي -ب

 خروجی-خروجی -ج

 ورودي -خروجی -د

 :دهند می رائه ا خدمات دیگر های کامپیوتر به شبکه محیط در که ای رایانه-697

 Node -د Client-ج ســرور -ب  ترمینال -الف

 .شود می گفته...... سی  بی های شبکه به-698

 SATELLITE -الف

 ب- WIRELESS 

 NETWORK -ج

 LNB -د

 باشد؟ می شبکه معنی به زیر های گزینه از کدامیک-699

 LNB-الف

 WIMAX -ب

 ج- Network 

WIRELESS -د

 رود؟ می کار به مهندسی فنی های نقشه چاپ جهت زیر دستگاههای از یک کدام-700

 چاپگر -د پرینتر -ج پالتر -ب  اسکنر -الف

 ؟ دارد نام چه نمایش صفحه عنصر کوچکترین-701

 الف- Pixel ب- Pin ج- Dots کاراکتر -د 

 نیست؟ کامپیوتر در ثانویه حافظه از استفاده دلیل یک کدام-702

 دیگر نقطه به نقطه یک از اطلاعات انتقال -الف

 ثانویه هاي حافظه در اطلاعات بودن فرار غیر -ب

 ثانویه حافظه يبالا ظرفیت -ج

 ثانویه هاي حافظه يبالا سرعت -د 

 است؟ بنفش ماوراء اشعه با شدن پاک وقابل ریزی برنامه قابل زیر های حافظه از یک کدام-703

Eeprom -د Eprom -ج Prom  -ب Rom -الف

 دارد؟ وجود خروجی دستگاه چند زیر دستگاههای در-704

 )بلندگو-نوري قلم - اسکنر - چاپگر -رسام -ماوس - کیبورد -نمایش صفحه(



 

 

 2 -د 5 -ج 4 -ب  3 -الف

 است؟ گروه کدام جزء اطلاعات به دستیابی روش نظر از دیسک هارد-705

 مستقیم دستیابی -الف 

 تصادفی دستیابی -ب

 ترتیبی دستیابی -ج

 انتخابی دستیابی -د

 است؟ اطلاعات موقت ذخیره محل زیر های حافظه از یک کدام-706

 Eprom -د Prom -ج Ram -ب Rom  -الف

 ؟ نیست جانبی های حافظه جزء زیر های گزینه از یک کدام-707

 مغناطیسی دیسک هارد -الف

 فالپی -ب

 ج- Rom 

 مغناطیسی نوار -د

 نیست؟ سیست  افزارهای نرم جزء یک کدام-708

 عامل سیستم -الف

 کاربردي هاي برنامه -ب 

 سودمند هاي برنامه -ج

 مترجمها -د

 .است.....................  کامپیوتر در افزار نرم ترین اصلی-709

 عامل سیستم -الف 

 کاربردي هاي برنامه -ب

 مترجمها -ج

 نویسی برنامه زبانهاي -د

 لود ار عامل سیست  و کند می استفاده ای حافظه چه از شده ذخیره اطلاعات از آمدن بالا هنگام کامپیوتر-710

 کند؟ می

 EPROM -د CMOS -ج Prom  -ب Ram -الف

 ؟ است تر سریع روش کدام طریق از اطلاعات به دسترسی-711

 ترتیبی -الف

 دارد حافظه نوع به بستگی -ب

 مستقیم -ج 

 کند نمی فرقی -د

 نیست؟ CPU داخلی اجزای جزء یک کدام-712

 ثبات -الف

 نهان حافظه -ب

 ج- Ram 

کنترل واحد -د

 ؟ است قسمت کدام عهده به CPU در ها داده کنترل-713

 ثبات -د Cache -ج Cu -ب Alu  -الف

 ؟ چیست اطلاعات-714

 . کنیم می کامپیوتر وارد پردازش براي که هایی فاکتور -الف

 . گیرد می انجام ها داده روي بر که عملیاتی -ب

 گیرد می انجام ها داده پردازش از که اي نتیجه -ج . 

 دهیم می کامپیوتر به ورودي دستگاه از که دادهایی -د

 ؟ کنند می استفاده ای شبکه چه از دفترکار یک های کامپیوتر-715

 Yahoo -د Man -ج Lan -ب Wan  -الف



 

 

 است؟ کاربره تک زیر عاملهای سیست  از یک کدام-716

 Singl User -الف

 ب- DOS 

 Windows Xp -ج

 Windows -د

 است؟ افزار سخت تعریف گزینه کدام-717

 کامپیوتر سیستم یک لمس وقابل فیزیکی اجزاي -الف 

 کامپیوتر سیستم یک یاطلاعات اجزاي -ب

 ها برنامه -ج

 دیسک هارد -د

 )چپ به راست از.(باشد می خواندنی فقط ای حافظه................ و تصادفی دسترسی با ای حافظه-........718

 الف-Ram و Rom 

 Cache و Rom -ب

 Ram و Rom -ج

 VCD و DVD -د

 است؟ تربالا بقیه از کیفیت نظر از زیر چاپگرهای از یک کدام-719

 افشان جوهر -د سوزنی -ج حروفی -ب لیزري -الف 

 ؟ است بیشتر حافظه کدام سرعت-720

 الف- Ram ب- Hard ج- Cd Rom د- DVD 

 رود؟ می بین از برق نبود در زیر های حافظه از یک کدام اطلاعات-721

 Rom -الف

 EEPROM -ب

 Cd -ج

 د- Ram 

 باشد؟ می ترتیبی اطلاعات به دسترسی روش موارد از یک کدام در-722

 دیسک هارد -الف

 دیسک فالپی -ب

 مغناطیسی نوار -ج 

 Ram -د

 .شود می گفته.................... آن خروجیهای به و....................  کامپیوتری سیست  یک های ورودی به-723

 software افزار نرم- Hardware افزار سخت -الف

 داده -ب Data - اطلاعات information 

 Data داده - Information اطلاعات -ج    

 افزار میان - Hardware افزار سخت -د

 باعث که هایی دستورالعمل و ها برنامه کلیه( باشد؟ می زیر گزینه کدام به مربوط تعریف این-724

 ) شود می عملکردسیست 

 Ware Hard افزار سخت -الف

 افزار نرم -ب Software 

 Process پردازش -ج

Input ورودي -د

 ؟ است نیاز Bit چند)حر (کارکتر یک سازی ذخیره برای-725

 16 -د 8 -ج  4 -ب 1 -الف

 است؟ انتخاب برای مالک بهترین زیر های گزینه از کدامیک چاپگر یک خرید برای-726



 

 

 چاپ کیفیت و سرعت -الف 

 چاپ کیفیت و دستگاه مارک -ب

 دستگاه مارک و وزن -ج

 دستگاه مارک -د

727- 1kb ؟ است بایت چند معادل 

 بایت 1000 -الف

 بایت 8 -ب 

 بایت 1024 -ج

بایت 256 -د

 است؟ خروجی زیر های دستگاه از کدامیک-728

 کلید صفحه -الف

 چاپگر -ب 

 اسکنر -ج

 ماوس -د

 ؟ است ناپایدار زیر های حافظه از یک کدام-729

 الف-Ram ب- Rom ج- Hard د- Cd - Rom

 ؟ است محلی شبکه زیر های گزینه از کدامیک-730

 Lan -دInternet   -ج Man -ب Wan -الف

731-CPU ؟ باشد نمی قسمتهایی چه شامل 

 کنترل واحد -الف

 ورودي واحد -ب 

 ثبات -ج

 ALU -د

 است؟ مناسب عاتاطلا دائ  سازی ذخیره برای زیر موارد از یک کدام-732

 ثانویه حافظه -الف 

 اصلی حافظه -ب

 ورودي واحد -ج

 خروجی واحد -د

 ؟ است تر ضعیف پردازش قدرت نظر از زیر های کامپیوتر یک کدام-733

 Main Frame computer -الف

 super computer -ب

 ج- micro computer 

 Mini computer -د

 ؟ معناست چه به رجیستر-734

 داخل در کوچک حافظه -الف CPU 

 گویند را جانبی حافظه -ب

 گویند را کامپیوتر اصلی حافظه -ج

گویند را بزرگ بسیار ظرفیت با حافظه -د

 .شوند می ذخیره..................... بصورت کامپیوتر حافظه در اتاطلاع-735

 دسیمال -الف

 دسیمال هگزا -ب

 اکتال -ج

 باینري -د 

 است؟ شده تشکیل بایت چند از Word یک-736

 بایت 2 -د  بایت 3 -ج بایت 4 -ب بایت یک -الف

 شود؟ می استفاده جانبی های حافظه از دلیل چه به-737

 برق قطع هنگام فرعی هاي حافظه محتواي شدن پاک- الف

 اصلی هاي حافظه بودن ارزان- ب

 حافظه محتواي شدن پاک- ج ram برق قطع هنگام 



 

 

 برق قطع هنگام romحافظه محتواي شدن پاک- د

 شود؟ می استفاده لیزر پرتو از عاتاطلا به دسترسی برای دیسکها از نوع کدام در-738

 دیسک فالپی -الف

 CD -ب

 DVD -ج

 د- DVDو CD 

 ؟ داشت نگه پایین باید را کلید ،کدام کلید یبالا ی علا تایپ برای کلید صفحه در-739

 Alt -الف

 ب- Shift 

 Ctrl -ج

Back Space -د

 نماید؟ می کامپیوتر وارد و کرده تبدیل یک و صفر به را تصاویر تواند می ورودی وسیله کدام-740

 ماوس -د پرینتر -ج اسکنر -ب  پالتر -الف

 باشد؟ می تصویر کیفیت به مربوط زیر ازکارتهای یک کدام-741

 VGA -دsound   -ج modem -ب ram-الف

 است؟ نویسی برنامه زبان یک کدام-742

پاورپوینت -د اکسل -ج C#-ب  فتوشاپ- الف

 دسته دامک جزء و دارد نام چه کند می فراه  را افزار سخت با کاربر ارتباط امکان که افزاری نرم مهمترین-743

 ؟ افزارهاست نرم از

 سیستمی افزار نرم - عامل سیستم- الف 

 تمیسیس افزار نرم - نویسی مه برنا زبان -ب

 بردي کار افزار نرم -کامپایلر -ج

سودمند افزار نرم -مفسر -د

 

744-Plotter (است.............. واحد اسکنر و........... دستگاههای جزء) رسام. 

 ورودي - ورودي- الف

 خروجی -ورودي- ب

 ورودي - خروجی- ج 

 خروجی - خروجی -د

 ؟ چیست شبکه توپولوژی از منظور-745

 است شبکه هاي گره اتصال فیزیکی آرایش در هري ظا شکل -الف . 

 . است شبکه در جانبی کامپیوترها تعداد -ب

 . است شبکه هاي گره بین ارتباطی کابلهاي -ج

 . است ها گره بین ارتباطی کابلهاي و ها گره نوع -د

 ؟ است صحیح عبارت کدام-746

 . شود می استفاده اطلاعات ونوشتن خواندن جهتRom حافظه -الف

 . ودش می داده قرارRam در سازنده خانه کار توسط افزار سخت به مربوط اساسی اطلاعات از بخشی -ب

 دارد را اطلاعات دائمی نگهداري قابلیت ثانویه حافظه -ج . 

 . است دائمی حافظه یکRam حافظه -د

747-ICT معناست؟ چه به 

 ارتباطات و اطلاعات آوري فن -ب اطلاعات آوري فن -الف



 

 

 الکترونیک آموزش -د الکترونیک تجارت -ج 

 باشد؟ می درست زیر موارد از یک کدام-748

 پردازش قدرت -الف Mini هاي کامپیوتر از کامپیوتر Pc است بیشتر . 

 . است بیشتر Miniهاي کامپیوتر ازPc هاي کامپیوتر پردازش قدرت -ب

 . هستند بره کار تک Pc هاي کامپیوتر همانند Mini هاي کامپیوتر -ج

 کوچکترMini کامپیوترهاي حجم لحاظ از اما هستند یکسان پردازش لحاظ از اما هستند یکسان پردازش قدرت لحاظ از -د

 . است

 ؟ باشند نمی پردازنده ریز های واحد از زیر موارد از کدامیک-749

 Alu -الف

 ثبات حافظه -ب

 اصلی حافظه -ج 

Cache -د

 باشد؟ نمی پردازنده ریز تعریف زیر موارد از کدامیک-750

 باشد نمی کامپیوتر یک جزء ترین اساسی -الف 

 . است شده تشکیل زیادي مجتمع مدارات از که است اي تراشه -ب

 . باشد می CPU آن دیگر نام -ج

 .شود می نصب سوکت بنام جداگانه مدار یک روي -د

 ؟ است درست گزینه کدام سرعت بیشترین داشتن لحاظ از-751

 الف- CPU > Ram>Hard> Floppy 

 CPU >Hard>Ram>Floppy -ب

 Ram> CPU >Hard>Floppy -ج

 Ram> CPU >Floppy>Hard -د

 باشد؟ می درست گزینه کدام-752

 1MB=1024GB -الف

 1Mb=1024 B -ب

 1 -جMB=1024KB 

1Gb=1024 Kb -د

 های حافظه از جهت همین به باشد می............ Ram اصلی حافظه از CPU در ها داده انتقال سرعت-753

 .کنند می استفاده.............. 

 ثبات - کمتر -الف

 ثبات - بیشتر -ب

 Cache -بیشتر -ج

 کمتر -د - Cache

 باشد؟ می درست بایت مورد در گزینه کدام-754

 دهی آدرس قابل غیره حافظه واحد کوچکترین -الف

 دهی آدرس قابل حافظه واحد کوچکترین -ب 

 کند ذخیره خود در را1 یا0 تواند می فقط -ج

 دهد می تشکیل را بیت یک بایت 8 هر -د

 می استفاده آن از ورایگان آزمایشی طور به مشخصی مدت یک برای کننده مصر  که افزارهایی نرم به-755

 شود؟ می گفته.................  کنند

 اشتراکی افزارهاي نرم -ب  رایگان افزارهاي نرم -الف



 

 

 نمایشی افزارهاي نرم -د باز متن افزارهاي نرم -ج

 باشد؟ می نادرست گزینه کدام-756

 دیسک روي دایره یک:  شیار -الف

 شود می تشکیل قطاع چند از دیسک روي دایره هر:  قطاع -ب

 برابر شعاع با مرکز هم هاي دایره:  سیلندر -ج

 برابر شعاع با مرکز هم هاي دایره:  قطاع -د 

 باشد؟ نمی درست گزینه کدام-757

 . است کمتر آن ظرفیت اما بیشتر جانبی هاي ازحافظه اصلی حافظه سرعت -الف

 است بیشتر مراتب به جانبی ازحافظه اصلی حافظه وسرعت ظرفیت -ب . 

 . است بیشتر مراتب به اصلی هاي حافظه از جانبی هاي حافظه ظرفیت -ج

 .است بیشتر جانبی هاي حافظه از اصلی هاي حافظه سرعت -د

 رود؟ می کار به صوت انتقال برای زیر موار از یک کدام-758

 RAM -الف

 صدا کارت -ب 

 گرافیکی کارت- ج

 مودم- د

759-ID USER و........  همان PASSWORD است...............  همان. 

 فامیل و نام -الف

 اطلاعات حفاظت و کاربري نام -ب

 عبور کلمه و کاربري نام -ج 

 عبور وکلمه رمز -د

 ؟ است 7 ویندوز های ویژگی از زیر های گزینه از کدامیک-760

AERO -د  وظیفه تک -ج متنی -ب کاربره تک -الف

 هستند؟ تابعی های کلید زیر های گزینه از کدامیک-761

 CTRL -الف

 ALT -ب

 ج- F 12 تا F1 

Num Lock -د

 ؟ کند نمی بیان را حافظه ظرفیت واحد کدام-762

 الف- Db ب- Kb ج- Gb د- Mb 

 .گویند.................  را کامیپوتر اصلی برد-763

 CPU -الف

 Ram -ب

 Hard -ج

 د- Mainboard

 ؟ است صورت کدام بهCD دیسکهای اطلاعات به دسترسی-764

 ترتیبی یا گام به گام -الف

 موازي -ب

 تصادفی یا مستقیم -ج 

 نوري -د

 ؟ است منظوری چه برای موس وسط غلطک-765

 است راست کلیک معادل -الف

 است چپ کلیک معادل -ب

 ندارد کاربردي -ج

 ها پنجره محتویات مرور -د 



 

 

766-Boot ؟ چه یعنی شدن 

 ماشین جانبی اجزاي از یکی خرابی بعلت سیستم عملیات شدن متوقف -الف

 دیسک روي Record Boot شدن خراب -ب

 ج- Load در موجود برنامه توسط سیستم فایلهاي اتوماتیک شدن Rom کامپیوتر 

 مختلف هاي برنامه شدن مقیم دلیل به حافظه شدن پر -د

 . گویند................ را تخت های مانیتور کامپیوتر، دراصطالح-767

 الف- LCD ب- CGS ج- CGA د- VGA

 ؟ است کدام عهده بر کامپیوتری سیست  یک درونی عملیات کلیه هماهنگی و کنترل وظیفه-768

 کاربردي هاي برنامه- الف

 سیستمی هاي برنامه- ب 

 عمومی هاي دهنده سرویس -ج

مترجم -د

 چیست؟ مخفف It اصطالح-769

 . است اینترنتی فناوري معناي وبه استTechnology Internet عبارت مخفف -الف

 . است اطلاعات فناوري معناي وبه است Technology Net Inter عبارت مخفف -ب

 . است ارتباطات فناوري معناي به و است Technology Information عبارت مخفف -ج

 عبارت مخفف -د Technology Informationاست اطلاعات فناوري معناي وبه است . 

 است؟ کامپیوتر تعریف زیر ازگزینه یک کدام-770

 دهد انجام را منطقی و ریاضی عملیات است قادر که ریزي برنامه قابل و حافظه داراي است دستگاهی -الف. 

 .دهد می انجام را منطقی و رایضی عملیات فقط که است دستگاهی -ب

 . دهد می انجام را حروفچینی و تایپ کارهاي فقط که است دستگاهی -ج

 مدیا هاي فایل پخش براي است دستگاهی -د

 رود؟ می شمار به افزار نرم خصوصیت زیر موارد از کدامیک-771

 لمس قابل و فیزیکی -الف

 است مکانیکی و الکترونیکی مدارات شامل -ب

 است کامپیوتر از استفاده جهت العملهایی دستور شامل -ج . 

 .دارد را اطلاعات پردازش وظیفه -د

 ؟ است کدام شخصی های کامپیوتر اصلی اجزای-772

 Cpu - Memory - Case - Monitor -الف

 Cpu - Ram - Hard - Case - Monitor- Keyboard -ب

 ج- Cpu - Memory - In Put Unit - Output Unit 

 Cpu - Memory - Keyboard - Case -د

 ؟ نیست صحیح زیر های گزینه از یک کدام-773

 است کاربر و افزار نرم و افزار سخت بین رابطه عامل سیستم -الف

 . باشد کاربره تک و کاربره چند است ممکن عامل سیستم -ب



 

 

 باشد داشته وظیفه یک یا وظیفه چند است ممکن عامل سیستم -ج

 هاست افزار سخت اندازي راه براي عامل سیستم -د. 

 ؟ دهد می انجام را کاری چه افزار نرم-774

 افزار سخت و کاربر بین رابط -الف

 رود می بکار کامپیوتر دستورات نوشتن براي- ب

 رود می کار به خاص کارهاي انجام براي- ج 

 سازد می ممکن را فایلها مدیریت -د

 ؟ کند می کامپیوتر وارد و کرده تبدیل دیجیتال سیگنالهای به را عکس زیر دستگاههای از کدامیک-775

 Touchpad -الف

 Trackball -ب

 ج- Scanner 

Light Pen -د

 ؟ است مناسب زیر های ازگزینه یک ام کد بایت مگا 500 حج  به فایل یک جابجایی برای-776

 Floppy -د Cd -جRom  -ب نوري قلم- الف

 است................ فایلهای به مربوط Wave پسوند و.................... فایلهای به مربوطTxt پسوند-777

 صوتی -اجرایی -الف

 تصویري - متنی -ب

 صوتی - متنی -ج 

تصویري - اجرایی -د

 .است........................... دستگاه یک نوری قل -778

 ورودي -الف 

 خروجی -ب

 خروجی - ورودي -ج

مغناطیسی دیسک -د

 باشد؟ می الکترونیک تجارت مزایای از گزینه کدام-779

 ساعته 24 خدمات -الف 

 سایت وب اعتمادبه عدم -ب

 کاال دقیق مشاهده عدم -ج

کارت از برداري کاله -د

 ؟ شود می نامیده چه Ram و Cpu بین اطلاعات عبور مسیر-780

Socket -د Bus -جSlot   -ب Port -الف

 . گویند می.................  است اطلاعات فرستنده که ای رایانه به و............  اطلاعات گیرنده رایانه به-781

 انتقال کانال Server -الف

 Server - انتقال کانال -ب

 ج- Server - Clients 

انتقال کانال- Client -د

 ؟ دارد بیشتری سرعت زیر چاپگرهای از کدامیک-782

 سوزنی چاپگرهاي -الف

 لیزري چاپگرهاي -ب 

 اي ضربه چاپگرهاي -ج

 افشان جوهر چاپگرهاي -د

 ؟ ندارد مضر تششعات نمایش صفحه کدام-783

 CRT -الف

 LCD . CRT -ب

 ج- Plasma . LCD 

CRT . Plasma -د

 ؟ نیست حالته دو زیر های کلید از یک کدام-784



 

 

 Caps Lock -الف

 Num Lock -ب

 Scroll Lock -ج

 د- Shift 

 .شود می استفاده................  از کلید صفحه راست سمت اعداد نمودن فعال منظور به-785

 Caps Lock -الف

 Scroll Lock -ب

 ج- Num Lock 

Shift -د

 .نمود فعال را...................... دکمه باید التین بزرگ حرو  تایپ برای-786

 الف- Caps Lock 

 Scroll Lock -ب

 Num Lock -ج

Ctrl -د

 .گرفت عکس نمایش صفحه از میتوان.............  دکمه از استفاده با-787

 Caps Lock -الف

 ب- Print Screen 

 Num Lock -ج

Scroll Lock -د

 .........توقف غیرقابل انرژی منبع به-788

 الف- USB ب- POWER ج- UPS د- FLASH

789-PDA ؟ چیست 

 . دارد ییبالا بسیار سرعت که است شخصی هاي کامپیوتر انواع از -الف

 . دارد بزرگی بسیار ابعاد که است شخصی کامپیوترهاي انواع از -ب

 . شود می دهاستفا زیاد حجم با کارهاي براي و دارد کوچکی ابعاد که است شخصی کامپیوترهاي انواع از -ج

 شود می دهاستفا کم حجم با کارهاي براي و دارد کوچکی ابعاد که است شخصی هاي کامپیوتر انواع از -د. 

 ؟ کنی  می استفاده تب کدام از ارقام اعشار تعداد تعیین برای-790

 Insert -الف

 Edit -ب

 ج- Home-number 

Format -د

 ؟ کرد انتخاب باید را گزینه کدام Print ای محاوره کادر از جاری کاری صفحه چاپ برای-791

 Selection Print -الف

 Entire Work Book Print -ب

 ج- Active Sheet Print 

Print Current Sheet -د

792- Round )435,23;1- ؟ چیست (نتیجه تابع 

435،23 -د 435،2 -ج  435،231 -ب 435 -الف

 روی بر کنی  استفاده جاری Book Work در را بازBook Work از شده تعریف های استایل اینکه برای-793

 کنی ؟ کلیک ای گزینه چه

 Modify -الف

 table style -ب

 ج- Merge style 

add -د

 ؟ شود تعیین باید مورد کدام در گیرد قرار صفحه همان در نمودار اینکه برای-794

 As New Sheet -الف

 ب- object in 

 As New Work Book -ج

File - New -د



 

 

 ؟ گیرند می قرار استفاده مورد منظور چه به Paste و Copy فرامین-795

 اطلاعات حذف -الف

 اطلاعات کپی -ب 

 اطلاعات جابهجایی -ج

دوباره برگرداندن و فرمان آخرین حذف -د

 ؟.................. سطر یک پهنای افزایش برای-796

 کنیم می درگ پایین طرفه به را آن پایینی مرز -الف. 

 .کنیم می درگ بالا طرفه به را آن ییبالا مرز -ب

 .کنیم می درگ بالا طرفه به را آن پایینی مرز -ج

 کنیم می درگ پایین طرفه به را آن ییبالا مرز -د

 شود؟ می استفاده گزینه کدام جدید سبک یک ایجاد برای Home سربرگ از Style Cell کشوی از-797

 . کنیم می کلیک Add دکمه روي بر ، سبک نام تعیین از بعد -الف

 گزینه روي بر -ب style cell new کنیم می تعیین را سبک نام وسپس کرده کلیک . 

 . کنیم می کلیک new دکمه روي بر -ج

 . کنیم می کلیک Ok دکمه روي بر ، سبک نام تعیین از بعد -د

 ؟ است صحیح مطلب کدام ستونی نمودار یک در موجود های سری تعداد مورد در-798

 . هاست سطر تعداد برابر ها سري تعداد -الف

 هاست ستون تعداد برابر ها سري تعداد -ب . 

 . شدبا ها ستون برابر یا سطرها تعداد برابر تواند می بر کار انتخاب به بسته ها سري تعداد -ج

 . هاست ستون و ها سطر تعداد مجموع برابر ها سري تعداد -د

 شود؟ می استفاده گزینه کدام از لیست یک کردن مرتب برای-799

 Data تب از filter Autoگزینه -الف

 میکنیم انتخاب Data تب از را Form گزینه -ب

 .کنیم می انتخاب Data تب از را Arrange گزینه -ج

 گزینه -د Sort تب از را Data کنیم می انتخاب. 

 ؟ هاست برنامه انواع از یک کدام مجموعه زیر Excel برنامه-800

 پردازها واژه -الف

 ترسیمی هاي برنامه -ب

 یاطلاعات بانکهاي -ج

 گسترده صفحه هاي برنامه -د

 شد؟ خواهد فعال فرض پیش طور به سلول کدام Enter کلید فشار و B1 سلول در داده ورود از پس-801

A2 سلول -د B2 سلول -جC1   سلول -ب A1 سلول -الف

 ؟ شود می هاشور خطوط با سلول یک شدن پر موجب Cell Format کادر از گزینه کدام-802

 Gridlines -الف

 Customize -ب

 Texture -ج

 د- Pattern

 ؟ دهد می انجام را کاری چه Delete پنجره از Entire Row گزینه-803

 . کند می پاک را سلول محتویات فقط -ب .کند می پاک را شده انتخاب سلول -الف



 

 

 کند می پاک کامل طور به را ستون یک -د . کند می پاک کامل طور به را سطر یک -ج . 

 ؟ است درست مورد کدام فعال سلول در C3تا B2 سلولهای محتوای کردن جمع برای-804

 B2+C3 -الف

 =B2+C3 -ب

 B2+C2+B3+C3 -ج

 د- B2+C2+B3+C3= 

 ؟ باشد نمی Excel های کاربرد از گزینه کدام-805

 رومیزي نشر امور انجام -الف 

 حسابداري دفاتر تهیه -ب

 گرافیکی نمودار تهیه -ج

فروش فاکتور -د

 ؟ شود می استفاده زیر گزینه کدام از کاربرگ) کردن اضافه(درج منظور به-806

 Insert-Column -الف

 ب- Insert-Work Sheet 

 Insert-Row -ج

Insert-Delete -د

 ؟ است غلط گزینه کدام-807

 .یردگ می نظر در ریاضی عملیات در شرکت قابلیت با عدد عنوان به را تاریخی هاي داده اکسل -الف

 گویند می) توضیحات( متنی یادداشت ، سلول هر داخل متن به -ب. 

 . کند می جمع هم با راSheet2 از B5تا A5 سلولهاي= B5:A5!sheet2(sum) فرمول -ج

 .باشد می Sheet Workیک شامل فرض پیش درحالت 2013 اکسل درBook Work یک -د

 ؟ چیست Labels Data گزینه مفهوم نمودار ترسی  در-808

 ها داده اسامی نمایش -الف 

 نمودار در ها داده جدول نمایش -ب

 نمودار شرح نمایش -ج

محورها و نمودار عنوان -د

 دارد؟ ای وظیفه چه Count تابع-809

 شده انتخاب سلولهاي شمارش -الف

 شده تایپ سلولهاي شمارش -ب

 عددي سلولهاي شمارش -ج

 تاریخی و عددي سلولهاي شمارش -د 

 ؟ شود می گرفته نظر در متن عنوان به زیر های گزینه از یک کدام-810

10:30 -د 3+2 -ج    =2+3 -ب   4.3 -الف

 شود؟ می استفاده گزینه کدام جدید صفحه یک در نمودار ترسی  برای-811

 Type Chart گزینه انتخاب -الف

 گزینه انتخاب -ب Sheet New As 

 Chart Place گزینه انتخاب -ج

Object As In گزینه انتخاب -د

 ؟ است زیر های گزینه از کدامیک معادل A10:A1(Sum(/10= فرمول-812

 Round (A1,A10=) -الف

 ب- Average (A1:A10=) 

 Subtotals (A1:A10=) -ج

Count (A1:A10=) -د

 ؟ کنی  می استفاده گزینه کدام از سلولها در تکراری های داده ورود عمل تسریع جهت-813

 Auto Correct -الف

 Auto Format -ب

 Auto Stayl -ج

 د- Auto Fill

 ؟چیستsum(A2:C5;D8=  -وظیفه دستور(-814



 

 

 سلولهاي مجموع محاسبه -الف A2 تا C5 سلول و D8 

 D8 سلول و C5 باA2 سلولهاي مجموع محاسبه -ب

 D8تا C5 سلولهاي و A2 سلول مجموع محاسبه -ج

 D8تا A2 سلول مجموع محاسبه -د

 ؟ است صحیح گزینه کدام-815

 A1=A2+A3 -الف

 ب- =A2+A3 

 =A2+A3 -ج

 A2=A3 -د

 ؟ کرد استفاده میتوان کلید کدام از فعال خانه ویرایش برای-816

 F4 -د F2 -جF1   -ب F3 -الف

 ؟............ توان می مشخص محدوده یک انتخاب برای-817

 . زد را Ctrlوسپس انتخاب را اول خانه -الف

 . گیریم می را Alt خانه اولین انتخاب -ب

 سپس و کنیم می انتخاب را اول خانه -ج Shift کنیم می کلیک را انتهایی خانه و گرفته را . 

 ها خانه انتخاب و جهتی کلید -د

 ؟ داد انجام ها خانه در را ها داده ترازی ه  توان می Cells Format از تب کدام از استفاده با-818

 Number -الف 

 Font -ب

 Alignment -ج

Border -د

 دهد؟ می انجام عملی چه Fit To Shrink گزینه Alignment تب از Cell Format کادر در-819

 گیرد قرار خانه طول در تا شود داده اندازه تغییر طوري خانه در شده نوشته متن -الف . 

 خانه یک در شده ي ها خانه محتواي ترکیب -ب

 . گیرد می قرار بعد خط در متن بقیه باشد بیشتر خانه از متن طول اگر -ج

 کند می پر را خانه عرض تا متن شدن کشیده -د

 ؟........... گزینه از تکراری کارهای انجام از گیری جلو و کارها انجام سرعت بردن بالا برای-820

 Merge -الف

 Template -ب

 Style -ج

 د- Template و Style

 ؟.............. از( Sheet( کاری صفحه یک کپی برای-821

 . کنیم می انتخاب را Insert گزینه و کنیم می راست کلیک نظر مورد Sheet روي -الف

 کنیم می انتخاب راCopy Or Move گزینه و کرده کلیک راست نظر مورد Sheet روي -ب

 کنیم می انتخاب را Sheet Insertتب از -ج

 روي -د Sheet کنیم می انتخاب را کپی گزینه و کنیم می راست کلیک نظر مورد 

 میرود؟ بکار منظور چه به Review تب از Sheet Protect گزینه-822

 خودکار یابی غلط -الف

 جاري صفحه روي گذاري رمز -ب 

 Book Work روي گذاري رمز -ج

 کاربر اطلاعات گذاشتن اشتراک به -د



 

 

 صحیح مورد نمودارکدام اجزای لیست از و Chartابزار نوار در نمودار، عالئ  فهرست بندی قالب برای-823

 است؟

 Chart Area -الف

 Plot Area -ب

 ج- Legend 

 Series -د

 است؟ صحیح گزینه کدام بعدی سه نمودار مشاهده زاویه تغییر برای-824

 Type Chart گزینه Chart تب از -الف

 Option Chart گزینه Chart تب از -ب

 تب از -ج Chart 3 گزینه-View D 

 Location گزینه Chart تب از -د

 =max(A1,B1,F3) باشد حاصل تابع زیر کدام است ؟  =True  A1و  B1=khاگر -825

 Khtrue4 -الف

 صفر -ب

 Error -ج

4 -د 

 ؟ دهد انجام را تابع چند کار تواند می دستور کدام-826

 Sum -الف

 ب- Subtotals 

 Average -ج

 Form -د

 ؟ باشد می مورد کدام چاپ برای بر میان کلید-827

 Ctrl + P -الف

 ب- Ctrl + L 

 Ctrl + X -ج

 Ctrl + M -د

 کرد؟ انتخاب باید را مورد کدام Print ای محاوره کادر از سند کل چاپ برای-828

 Active Sheet(S ) -الف

 ب- Entire Work Book 

 Selection -ج

 List -د

 برمیگرداند؟ را عددی چه روبرو ابعت باشد 24-18-10-16-14-8 ترتیب به d6 تا d1مقادیر اگر-829

=max(d1:d5) 

 18 -د  16 -ج 8 -ب 24 -الف

 نیست؟ صحیح زیر مورد کدام-830

 . کرد وارد داده آن در بتوان که اي صفحه هر یعنی کاربرگ -الف

 دهد می تشکیل را کاري صفحه یک ستون و سطر هر تقاطع -ب . 

 .نامند سطر افقی بطور را هم مجاور سلولهاي -ج

 . برد نام زمان ، تاریخ ، متنی ، عددي توان می را سلول داخلی مقادیر انواع -د

 ؟ نیست صحیح مورد کدام کاری صفحه داخل در اطلاعات کردن ذخیره مورد در-831

 شود می ذخیره فایل یک در کاري صفحه هر -الف . 

 . است Xls گسترده صفحه فایلهاي پسوند -ب

 . کرد استفاده office دکمه از As Saveیا Save گزینه از توان می سازي ذخیره براي -ج

 . است استاندارد ابزار نوار از Save دکمه انتخاب سازي ذخیره روشهاي از یکی -د

 ?.دهد می انجام عملی چه Down Cells Shift گزینه سلول یک کردن اضافه هنگام-832



 

 

 راست به ها خانه سایر انتقال -الف

 چپ به ها خانه سایر انتقال -ب

 پایین به ها خانه سایر انتقال -ج 

 بالا به ها خانه سایر انتقال -د

 ؟......توان می Alignment گزینه با سلولها بندی قالب هنگام در-833

 داد تغییر را متن نمایش شکل -الف

 داد تغییر را زمینه پشت رنگ -ب

 داد تغییر را حروف بندي قالب -ج

 کرد تنظیم را متن ترازبندي -د 

 ؟ چیستText Wrap گزینه مفهوم-834

 شود داده نشان سطري چند بصورت طوالنی متن-الف . 

 . شوند تبدیل سلول یک به هم با شده انتخاب سلولهاي -ب

 . شوند تقسیم سلول چند به شده انتخاب سلولهاي -ج

 . بگیرد جا سلول در تا شده وریز کوچک متن -د

 شود؟ می استفاده گزینه کدام از سلولها زمینه رنگ تغییر برای-835

 الف- Pattern 

 Border -ب

 Protection -ج

Font -د

 شود؟ می استفاده گزینه کدام از شده مارک متن بندی قالب از برداری نسخه برای-836

 Paste Special -الف

 Paste -ب

 ج- Format Painter 

Copy -د

 میدهید؟ انجام عملی چه Sheet3 از قبل و جاری کاری صفحه به جدید برگ کار یک افزودن منظور به-837

 . کنیم می انتخاب را Insert گزینه و کرده کلیک راست Sheet2 روي بر -الف

 روي بر -ب Sheet3 گزینه و کرده کلیک راست Insert کنیم می انتخاب را 

 . کنیم می انتخاب را Insert گزینه و کرده کلیک دوبارSheet2 برروي -ج

 . کنیم می انتخاب Insertگزینه کرده کلیک دوبار Sheet3 برروي -د

 میباشد؟ صحیح گزینه کدام سلولها بین زمان ه  و زنده ارتباط در-838

 کند تغییر مقصد سلولهاي مبدا سلولهاي تغییر با -الف . 

 . نکند تغییر مقصد سلولهاي مبدا سلولهاي تغییر با -ب

 . شوند می نوشته شده تعریف مقادیر سري شده انتخاب ي سلولها روي بر ماوس کشیدن با -ج

 . شوند می دار رمز شده انتخاب سلولهاي -د

 دهی ؟ نمایش پنجره یک در کدام هر اندازه و موقعیت با را گسترده صفحه فایل چند بخواهی  اگر-839

 review تب از Protectionsگزینه انتخاب- الف

 review تب از Book Work Protect گزینه انتخاب -ب

 window قسمت در window switch گزینه از استفاده با ها آن نمایش -ج

 گزینه از استفاده با آنها کردن مرتب -د all arrange قسمت در window 

 ؟ باشد می......  عملگر یک*  و.....  عملگر یک and عملگر-840

 اي رشته و منطقی -ب محاسباتی و منطقی -الف 



 

 

منطقی و محاسباتی -د اي رشته و آدرس -ج

 میباشد؟ کدام شده باز گسترده صفحه فایلهای کردن مرتب نحوه-841

 گزینه انتخاب -الف Arrange تب از view 

 review تب از Arrange گزینه انتخاب -ب

 Icons Arrange انتخاب و کلیک راست انجام -ج

 Icons Arrange گزینه انتخاب و کلیک دوبار انجام -د

 شود؟ می استفاده گزینه کدام از فرمول و آدرس نوار کردن سفارشی برای-842

 review تب showگروه از bar formula -الف

 ب- Bar Formula گروه از show تب View 

 data - تب از Formula -ج

 dataتب وtools dataگروه از Bar Formula -د

 ؟ کنی  می استفاده فرمان کدام از سلول یک در فرمول کردن وارد برای-843

 الف- Formulas - Function 

 Insert - Function -ب

 Insert - Formulas -ج

Formulas- Insert -د

 ؟ باشد می ای دایره نوع از زیر نمودار کدام-844

 الف- Pie ب- Area ج- Bundle د- Cone

 ؟ است نادرست Round تابع درباره مورد کدام-845

 باشد می اعشاري اعداد کردن گرد براي تابع این -الف

 باشد می صحیح اعداد کردن گرد براي تابع این -ب

 باشد می دلخواه رقمهاي تا اعشاري اعداد کردن گرد براي تابع این -ج

 باشد می اعشاري اعداد شمارش براي تابع این -د 

 شود؟ می استفاده گزینه کدام از ها سلول ادغام جهت-846

 Wrap Text -الف

 Justify -ب

 ج- Merge Cells 

Shrink To Fit -د

 شرو ازکدام باشد استفاده قابل بازنیز فایلهای بقیه در فایل یک در شده تعریف های Style اینکه برای-847

 کنی ؟ می استفاده

 کنیم می کلیک Add برروي Style Cell -الف

 کنیم می کلیک Modify روي بر Style Cell از -ب

 از -ج Style Cell برروي Merge کنیم می کلیک 

 کنیم می کلیک Style روي بر Style Cell -د

 ؟ چیست سلول یک در # عالمت شدن ظاهر مفهوم-848

 است بزرگتر سلول عرض به نسبت عدد طول -الف . 

 . است بزرگتر سلول ض عر به نسبت علمی عدد طول -ب



 

 

 . دارد شده متنی بندي قالب سلول -ج

 است فرمول حاوي سلول -د

 کدامند؟ اکسل در عملگرها انواع-849

 اي مقایسه - اي رشته - محاسباتی - منطقی عملگرهاي- الف 

 آدرس - محاسباتی - منطقی عملگرهاي -ب

 اي رشته -آدرس - محاسباتی عملگرهاي -ج

 اي رشته -آدرس - اي مقایسه - محاسباتی عملگرهاي -د

 ؟ است چگونه خانه یک در تابع یک نوشتن طریقه-850

 الف- min(A1:B5) 

 min = (A1, B5) -ب

 X = A1 + b5) min -ج

C1=A1+B(min -د

 نمود؟ استفاده توان می کلید کدام از برنامه راهنمای کردن فعال برای-851

 الف- F1 ب- F3 ج- F2 د- F4

 مکدا بگیرد را آن جای جدید خانه و کند حرکت پایین به شده انتخاب خانه اینکه برای ، خانه درج هنگام در-852

 نمود؟ انتخاب بایدInsert ای محاوره کادر از را مورد

 Shift Cells Right -الف

 ب- Shift Cells Down 

 Entire Row -ج

 Entire Column -د

 ؟ نمود تنظی  را ها خانه کادر خطوط توان می Cell Format ای محاوره کادر از تب کدام از استفاده با-853

 Alignment -الف

 Font -ب

 Number -ج

 د- Border 

 دهد؟ می انجام عملی چه Fill انتخاب Alignment تب از و Cells Format ای محاوره درکادر-854

 .گیرد قرار بعد خط در متن بقیه باشد بیشتر خانه از متن طول چنانچه شود می باعث -الف

 .گیرد ارقر خانه طول در تا شود داده اندازه تغییر طوري خانه در شده نوشته متن که شود می باعث -ب

 شود می خانه یک در شده انتخاب هاي خانه محتواي شدن ترکیب باعث -ج

 کند پر را خانه عرض تا شود می متن تکرار باعث -د. 

 ؟ چیست IF تابع عملکرد-855

 .کند می جایگزین را جدید اعداد و گذارد می شرط انتخابی سلولهاي روي بر -الف

 .کند می جایگزین را جدید اعداد و گذارد می شرط سلولها کلیه روي بر -ب

 دهد می مناسب پیام شرط بودن درست صورت در ، گذارد می شرط انتخابی سلولهاي روي بر -ج. 

 .کند می پاک را سلول محتواي. نباشد برقرار شرط اگر و گذارد می شرط انتخابی سلولهاي روي بر -د

 کرد؟ باید چه داد تغییر را کاری صفحه(  Cell(  های خانه محتوای نتوان اینکه برای-856

 نماییم انتخاب راLocked گزینه و کرده فعال راProtection تب Cells Format اي کادرمحاوره از -الف

 را سلول ابتدا -ب locked سربرگ از سپس و کنیم میReview گزینه Sheet Protect رمز کلمه و کنیم می کلیک را 

 .دهیم می قرار



 

 

 .میکنیم کلیک را Workbook Protect سپس و کرده کلیک را Protection گزینه Tools سربرگ از -ج

 و کنیم می کلیک را Workbook Protect گزینه Reviewسربرگ از سپس و کنیم می locked را سلول ابتدا -د

 .دهیم می قرار رمز کلمه

 رود؟ می بکار ها خانه از محدوده یک عددی های داده میانگین محاسبه برای تابع کدام-857

 Round -د Average -جCount   -ب Sum -الف

=Sum (Ali ; A1 ; C1 (باشد حاصل تابع زیر کدام است؟ C1=6 ،B1=Ali ،A1=5 858-اگر خانه های 

 5 -الف

 11 -ب

 Ali 5 6 -ج

 خطاي -د Name 

 است؟ کدام زیر تابع حاصل.  باشد Ali=C2 و True=A1 ،False=B2 خانه مقادیر اگر-859

=Count ( A1 ; B2 ; C2( 

 3 -د 1 -ج 0 -ب  2 -الف

 است؟ کدام زیر تابع حاصل باشد Kh = B1 ،True=A1 ،4=F3 اگر-860

IF(a1=kh,"t","f=) 

 F3 -د Error -ج F -ب  4 -الف

 دهد؟ می انجام را شرطی بندی قالب گزینه کدام-861

 style formatting -الف

 ب- conditional formatting 

 formatting -ج

Auto Filter -د

 شود؟ می نامیده چه موجودیت یا موضوع یک به مربوط فیلدهای مجموعه-862

 داده بانک -الف

 رکورد -ب 

 جدول -ج

 یاطلاعات بانک -د

 ؟ بگیرد صورت تواند می زیر روش کدام به Access جداول در رکوردها مشاهده روشهای-863

 Table , Data base -الف

 Form View , Table -ب

 ج- Form View , Data sheet 

Design view , Datasheet view -د

 ؟ شود می نامیده چه موجودیت یا موضوع یک به مربوط مشخصات-864

 فیلد -الف

 رکورد -ب 

 جدول -ج

 یاطلاعات بانک -د

 شود؟ می نامیده...................  موجودیت یک به مربوط جزئی اطلاعات-865

 رکورد -الف

 جدول -ب

  فیلد -ج 

 یاطلاعات بانک -د

 شود؟ می گفته.................  هستند یکسان فیلد عناوین دارای که رکوردها از ای مجموعه به-866

رکورد -د فیلد -ج جدول -ب  داده پایگاه -الف

 چیست؟ اکسس فایلهای پسوند-867

accdb -دnccdb   -ج fcdb -ب mccdb -الف



 

 

 نمود؟ عمل توان می چگونه رکورد یک ویرایش برای-868

 Form طریق از -الف

 Sheet Data طریق از -ب

 Query طریق از -ج

 د- form و Datasheet 

 ؟.. ..................... است بهتر هستند یکسانی خانوادگی نام یا نام دارای که افرادی تمایز برای-869

 .نمائیم ذخیره جداگانه فیلدهاي در را آنها -الف

 اولیه کلید یک -ب  )Key Primary  )کنیم اضافه جدول به. 

 .دهیم قرار رمز آنها خانوادگی نام یا نام براي -ج

 کنیم ایجاد جداگانه فرم آنها براي -د

 است؟ صحیح Table یک مورد در زیر عبارات از یک کدام-870

 .باشد ایندکس دو داراي تنها تواند می Table یک -الف

 .باشد ایندکس یک داراي تنها تواند می Table یک -ب

 .باشد داشته Key Primary یک تنها تواند می Table یک -ج

 یک -د Table چند حاوي تواند می Key Primary باشد. 

 باشد؟ می کارکتر 255 حداکثر داده ع نو کدام-871

 الف- short Text 

 Text -ب

 Long Text -ج

Hyperlink -د

 .نمود؟ تعریف قانون گیرد قرار خواهد می فیلدها در که عبارت یک برای توان می فیلد خصوصیت چه توسط-872

 Required -الف

 Allow Zero -ب

 ج- Validation Rule 

Caption -د

 باشد؟ تواند می اینترنتی آدرس یک شامل زیر دادة از نوع کدام-873

 Currency -الف

 OLE object -ب

 Memo -ج

 د- Hyperlink 

 باشی ؟ نداشته فیلد در Null ارزش داشتن اجازه بخواهی  اگر-874

 خاصیت -الف Required روي را Yes کنیم تنظیم. 

 .کنیم تنظیم No روي را Required خاصیت -ب

 .کنیم تنظیم Yes روي را Format خاصیت -ج

 .کنیم تنظیم No روي را Format خاصیت -د

 ؟ شود می استفاده زیر داده نوع کدام از مجموعه زیر دارای فیلدی ایجاد برای-875

 short text -الف

 Long Text -ب

 Ole Object -ج

 د- Lookup Wizard 

 فیلدها از خصوصیت کدام نشود رد خالی یک وهیچ پرشود جدول از رکورد دریک فیلدها تمام اگربخواهی -876

 شود؟ فعال باید

 الف- Required ب- Index 



 

 

Default Value -د Caption -ج

 جوجست و مرتب ، سریعتر را ها داده بتواند اکسس اینکه برای باشد بیشتر جدول رکوردهای تعداد چه هر-877

 دارید؟..................  به احتیاج کند

 Primary Key -الف

 Query -ب

 Filter -ج

 د- Index

 شود؟ می نامیده چه اکسس در معیار یک اساس بر جو و پرس-878

 الف- query ب- Form ج- Table د- Search

 ؟ است مناسب کاال قیمت برای داده نوع کدام-879

 الف- Currency 

 text -ب

 Number -ج

Memo -د

 هشمار و فرد نام شهر، نام، فیلد مانند فیلد چندین براساس جستجوها خواهی  می که بزرگ های درجدول-880

 ؟کنی  ایجاد.....................  است بهتر شود انجام تلفن

 .کنیم ایجاد یگانه ایندکس -الف

 کنیم ایجاد ایندکس چند -ب. 

 .کنیم ایجاد Key Primary -ج

 .دهیم قرار Yes برابر را مذکور فیلدهاي Required خواص -د

 نمود؟ استفاده باید روش کدام از یاطلاعات بانک ساختار در فیلد یک درج برای-881

 الف- Design - Insert Rows 

 Insert - Rows Database -ب

 Insert - Rows Data sheet -ج

home - Insert Rows -د

 ؟ کنی  می استفاده زیر روش کدام از خاص معیار اساس بر رکوردهایی انتخاب برای-882

 الف- Query 

 home - Find -ب

 home - Search -ج

 create -د

 نمود؟ عمل باید چگونه Wizard طریق از فرم یک ایجاد برای-883

 طریق از -الف wizard Form -Create 

 Form Create برروي کلیک دوبار سپس و Database پنجرة در Objects ۀ مجموع زیر از Forms روي بر کلیک -ب

by using wizard 

 home ریبون از Form wizard انتخاب -ج

 Form ریبون از Create wizard using انتخاب -د

 ازلیست فیلدها تمام انتقال باعث دکمه کدام برروی کلیک wizard Form با فرم طراحی درهنگام-884

 Available selected Fields می شود؟

 --> -د > -ج << -ب  < -الف

 دارد؟ قرار زیر موارد از یک کدام Query پنجره یبالا قسمت در-885

 .دهد می نشان را فیلد یک کدام هر که دارد ستونهایی -الف



 

 

 قراردارد اید کرده انتخاب که جدولی فیلدهاي لیست -ب. 

 .شود می ظاهر پنجره يبالا در Datasheet جدول همانند جدولی -ج

 Datasheet جدول همانند جدولی و فیلدها لیست -د

 شود؟ می استفاده میانبری کلید چه از گزارش یا فرم صفحات چاپ جهت-886

 الف- Ctrl + P ب- Alt + P ج- Ctrl + Z د- Shift + P

 را گزینه کدام Range Print قسمت ودر Print پنجره در گزارش یا فرم از خاصی صفحات چاپ جهت-887

 نمائی ؟ می انتخاب

 All -الف

 ب- Page Form … To … 

 selected Records -ج

Print To File -د

 .شود می ذخیره........  در اطلاعات کلیه داده درپایگاه-888

 ERD -الف

 ب- Data Base 

 DBMS -ج

DBL -د

 ؟ باشد نمی Access داده پایگاه افزار نرم امکانات از یک کدام-889

 اطلاعات ذخیره -الف

 اطلاعات وتحلیل تجزیه -ب

 زیاد کاربران تعداد دسترسی -ج 

اطلاعات مدیریت -د

 ؟ است..............  یک دارای حداقل داده پایگاه هر-890

تصویر -د Table -ج  رکورد -ب Field -الف

 ؟ چیست اطلاعات بانک-891

 گویند را پیوسته هم به و مرتبط اطلاعات از شده سازماندهی مجموعه- الف . 

 . گویند نوع یک از متعدد اطلاعات به -ب

 . گویند داده پایگاه در محاسباتی اقالم به -ج

 شود می گفته فرمولها به -د

 ؟ چیست جدول-892

 گویند باشد یکسانی فیلدهاي داراي که رکوردها از اي مجموعه به -الف. 

 .باشد یکسانی نوعهاي داراي که فیلدها از اي مجموعه به -ب

 .گویند ، باشد فیلد داراي که رکوردها از اي مجموعه به -ج

 .گویند فیلدها از اي مجموعه به -د

 گویند؟ می چه است اطلاعات حاوی که بانک در عنصر کوچکترین-893

 کاراکتر -د  فیلد -ج  جدول -ب رکورد -الف

 ؟ چیست کننده مشخص فیلد یک خواص-894

 .باشد می فیلد نوع -الف

 .باشد می فیلد یک تعداد -ب

 .گرفت نظر در توان می که باشد می فیلد آن براي الزم فضاي حداکثر -ج



 

 

 است فیلد آن براي الزم فضاي و فیلد نوع -د. 

 .... ادهد نوع از دارند محاسبات به احتیاج که عددی های داده و........  از ردیف مانند هایی داده درج برای-895

 )چپ به راست از)؟.کنی  می استفاده

 Number - Currency -الف

 Text - Number -ب

 ج- Number - Auto number 

Text - Auto number -د

 شود؟ می استفاده اطلاعات بانک در تصویر دادن قرار برای داده نوع کدام-896

 الف- OLE 

 Memo -ب

 Lookup Wizard -ج

 Text -د

 شود؟ می استفاده داده نوع کدام از طوالنی های متن ذخیره جهت-897

 Text-الف

 Comment -ب

 ج- Long Text 

number -د

 کند؟ ذخیره خود در را حرو  و عالئ  ، اعداد تواند می داده نوع فیلد کدام-898

 الف- text 

 Currency -ب

 Attach َ-ج

 ole -د

 باشد؟ نمی درست اصلی کلید مورد در جمله کدام-899

 .است اصلی کلید آنها از یکی ولی باشد کلیدي فیلد چند داراي است ممکن جدول یک -الف

 .تاس بفرد منحصر مقادیر داراي که باشد فیلد چند یا دو از اي مجموعه تواند می اصلی کلید -ب

 .شود می استفاده جداول بین ارتباط ایجاد براي اصلی کلید از -ج

 نمود استفاده توان نمی جداول بین ارتباط ایجاد براي اصلی کلید از -د. 

 کنی ؟ می انتخاب را گزینه کدام Base Data پنجره در یاطلاعات بانک جداول لیست مشاهده برای-900

 Objects -الف

 ب- Tables 

 Reports -ج

Open Table -د

 نمود؟ ویرایش و مشاهده را جدول های داده......  نمای در-901

 Data base -الف

 ب- Data Sheet 

 design -ج

جدول - درختی -د

 شود؟ می منتقل کجا به نما مکان Ctrl + Home ترکیبی کلیدهای از استفاده با-902

 شود می منتقل اول رکورد فیلد اولین به نما مکان- الف. 

 .شود می منتقل جاري رکورد فیلد اولین به نما مکان -ب

 .شود می منتقل آخر رکورد اول فیلد به نما مکان -ج

 .شود می منتقل متنی فیلد اولین به نما مکان -د

 شود؟ می استفاده ترکیبی کلیدهای کدام از رکوردها کلیه انتخاب جهت-903

Alt + A -د Ctrl + R -ج Ctrl + A -بAlt + S   -الف

 باشد؟ نمی صحیح جدول در فیلد نام تغییر برای گزینه کدام-904



 

 

 . داد تغییر بتوان را فیلد نام تا sheet Data نماي به سوئیچ -الف

 Sheet Data نماي در جدید نام نمودن تایپ و فیلد عنوان روي کلیک دوبار -ب

 Sheet Data نماي در فیلد نام روي راست کلیک -ج

 گزینه انتخاب و فیلد نام روي راست کلیک -د Column Rename 

 شود؟ می بسته جاری یاطلاعات بانک ترکیبی کلید کدام توسط-905

 الف- Alt + F4 ب- Ctrl + F5 ج- Ctrl + F4 د- Alt + F5 

 شود؟ می استفاده گزینه کدام از قبلی فیلد به نما مکان انتقال جهت Sheet Data نمای در-906

 Tab -الف

 Alt -ب

 Ctrl -ج

 د- tab+shift - کلید صفحه جهتی هاي دکمه

 نیست؟ صحیح گزینه کدام file از Newگزینه انتخاب با-907

 . شود می ایجاد جدید یاطلاعات بانک یک مستقیم طور به -الف

 . کنیم وارد را جدید اطلاعات بانک نام تا شود می باز base Data New File پنجره -ب

 . شود می ظاهر ، بسازیم خواهیم می که جدیدي اطلاعات بانک نوع انتخاب جهت وظیفه قاب -ج

 گردد می ایجاد جدید جدول یک -د. 

 باشند؟ نمی یاطلاعات بانک در جدول ایجاد های روش از کدامیک-908

 wizard table استفاده با جدول ایجاد -الف

 sheet Data از استفاده با جدول ایجاد ایجاد -ب

 ابزار نوار از استفاده با جدول ایجاد -ج Border & Table 

 View Design از استفاده با جدول ایجاد -د

 است؟ مقدار چه shortText متنی فیلدهای فرض پیش طول-909

 کاراکتر 50 -الف

 کاراکتر 255 -ب 

 کاراکتر 60 -ج

 کاراکتر 128 -د

 ؟.شود می گرفته نظر در آن برای.................  فرض پیش بطور Number فیلد انتخاب با-910

 Integer -الف

 ب- Long Integer 

 Single -ج

 Double -د

 باشد؟ نمی مجاز کلیدی فیلد در مقادیری چه درج-911

 متنی مقادیر -الف

 عددي مقادیر -ب

 (Null(  تهی مقادیر -ج

 تهی مقادیر و تکراري مقادیر -د  )Null) 

 ؟ .................. باعث فیلد Indexed خاصیت از Ok Duplicate ( Yes(  خاصیت انتخاب-912

 شدبا تکراري تواند می جدول رکوردهاي در فیلد این و شود می فیلد روي بر ایندکس ایجاد -الف. 

 .باشد تکراري تواند نمی جدول رکوردهاي در فیلد این و شود می فیلد روي بر ایندکس ایجاد -ب



 

 

 .شود نمی ایجاد ایندکس خاصیت فیلد روي بر -ج

 فیلدها کل در ایندکس ایجاد -د

 . کنی  می انتخاب............  تب از را Sort گزینه جدول های داده نمودن مرتب جهت-913

 field -الف

 ب- home 

 table -ج

Database Tools -د

 است؟ درست sheet Data نمای در فیلد حذ  برای گزینه کدام-914

 . دهیم می فشار را field Delete کلید ستون انتخاب از پس و کرده کلیک فیلد روي بر -الف

 . کنیم می انتخاب homeریبون از را Column Delete گزینه سپس کرده کلیک فیلد عنوان روي بر -ب

 . کنیم می انتخاب را Delete گزینه راست کلیک از و نموده انتخاب را فیلد -ج

 دهیم می فشار را field Delete کلید سپس و کرده راست کلیک فیلد روي بر -د

 باشد؟ می فیلدها گذاری نام برای مجاز عالئ  از کاراکتر کدام-915

 نقطه -الف

 تیره خط -ب 

 تعجب عالمت -ج

کروشه عالمت -د

 شود؟ می داده تغییر زیر قسمتهای از یک کدام اطلاعات ورود جهت قانون عنوان به عبارتی تعیین جهت-916

 Field Size -الف

 ب- Validation Rule 

 Validation Text -ج

Caption -د

 . هستی ............  نیازمند یاطلاعات بانک جداول بین ارتباط ایجاد برای-917

 کلیدي فیلد یک -الف 

 ارتباطی فیلد یک -ب

 کد فیلد یک -ج

ارتباطی خطوط -د

 ؟ گویند می چه رود بکارمی اطلاعات تغییر یا ورود جهت که یاطلاعات بانک از عنصری به-918

 الف- Form 

 Design -ب

 Dialog Box -ج

Window -د

 ؟............... تعیین یا تغییر جهت فرم خصوصیات پنجره در Format سربرگ-919

 . رود می بکار کنترل بندي قالب خصوصیات -الف

 . رود می بکار کنترل هاي داده خصوصیات -ب

 . رود می بکار فرم در رویداد شدن فعال نحوه -ج

 کند می تنظیم را کنترل خصوصیات سایر -د . 

 ؟ کند می فعال غیر یا فعال را کنترل ، فرم خصوصیات پنجره در امکان کدام-920

Other -د Enable -جEvent   -ب Format -الف

 گیرد؟ می قرار استفاده مورد گزینه کدام وجو پرس یک ایجاد برای-921

 Query -دTable   -ج Report -ب Macro -الف

 ؟ باشد می چقدر متنی نوع داده اندازه-922

 بایت 64000 -ب بایت 8 -الف



 

 

 ندارد محدودیتی -د بایت 255 -ج 

 ؟ کنی  می استفاده تب کدام از فرم در تصویر یک درج برای-923

Format -دFile   -ج Image -ب Insert -الف

 ؟ شود نمی محسوب اکسس محیط در داده نوع یک گزینه کدام-924

Form -دOle   -ج Memo -ب Text -الف

 گویند؟.............. را باشد می موجودیت یک مورد در که سطر چند در اطلاعات دهی سازمان و آوری مع-925

جدول- د  داده پایگاه- ج فیلد- ب رکورد- الف

 ؟................... جهتTable گروه از View Design گزینه-926

 ویزارد بصورت جدید فرم یک ایجاد- الف

 ویزارد بصورت جدید جدول یک ایجاد- ب

 جدول از استفاده بدون جدید فرم ایجاد- ج

 ویزارد از استفاده بدون جدید جدول ایجاد- د

 ؟...................از فرم یک ایجاد برای-927

 الف- Create-Form Design 

 Home -Form View -ب

 Insert- Form Design -ج

Insert -Form View -د

 ؟ شود می استفاده گزینه کدام از گزارش ایجاد برای-928

Table -د Form -ج Report -بQuery-  الف

 ؟ باشد ارتباط در دیگر جدول با بخواهد جدول اگر-929

 . باشد داشته فیلد10 اقل حد باید -الف

 . باشد داشته رکورد10 حداقل باید -ب

 باشد داشته اولیه کلید یک باید -ج . 

 . داشت نگه پایین را CTRL کلید باید -د

 نزولی صورت به شده پیدا رکوردهای که شود می موردباعث کدام انتخاب Query یک طراحی درهنگام-930

 باشند؟ مرتب

 Ascending -الف

 Not Sorted -ب

 ج- Descending 

Sort By Name -د

 ؟ است شده گذاشته منظوری چه برای Criteria سطر Query جدول در-931

 Sort روش تعیین براي -الف

 نمایش جهت رکوردها انتخاب معیار براي -ب 

 نظر مورد جدول تعیین -ج

نظر مورد فیلدهاي عناوین ذکر -د

 شود پرسیده معیار تعیین بر مبنی سؤالی ای محاوره کادر یک توسط Queryاجرای هنگام اینکه برای-932

 ؟ داد قرار توان می را زیر مورد کدام criteriaدرسطر

 } ?{  -الف

 }. نمایید وارد را نظر مورد عبارت لطفاً{  -ب

 ج-  ]? [ 

 / ?/  -د

 یلترف نوع کدام از ، باشد اصفهان آن شهر فیلد مثال طور به. کنی  مشاهده را خاص رکوردهایی بخواهی  اگر-933

 ؟ کنی  استفاده باید

 الف- Filter By Form 

 Filter -ب



 

 

 Sort -ج

Filter- Selection وAdvanced Filter / Sort -د

 طبق نتیجه مشاهده برای کردی  اعمال را ریفیلت Sort - Filter Advancedاز استفاده با اینکه بعداز-934

 ؟ نمود عمل باید گزینه کدام

 Filter By Selection -الف

 Remove Filter - Sort -ب

 ج- Apply Filter - Sort 

Save Record -د

 داده صفحه جدول یک سطر مقدار از قسمتی با که ببینید تان ازجدول را سطرهایی همه خواهید می اگر-935

 کنید؟ استفاده.........  از دارند تطبیق

 Find-الف

 Replace -ب

 ج- Selection filter 

 view -د

 ؟ است زیر موارد از یک کدام معر  زیر تعریف-936

 ". ندا شده مشخص تطبیق براي که فیلدهایی و رکوردها به یاطلاعات بانک اطلاعات نمایش کردن محدود "

 گیري گزارش -الف

 بانک در ارتباطات -ب

 کردن مرتب -ج

 فیلتر -د 

 ؟ باشد نمی Report طراحی قسمتهای از زیر موارد از یک کدام-937

 Detail -الف

 Report Header -ب

 Page Header -ج

 د- Summary

 ؟ باشد می صحیح زیر موارد از کدامیک-938

 . شود می ساخته ها گزارش از اي مجموعه از جدول -الف

 . شود می گفته جدول موجودیت به مربوط اطلاعات از یک هر به -ب

 . شود می گفته فرم موجودیت یک به مربوط هاي فیلد از اي مجموعه به -ج

 شود می ساخته رکورد از اي مجموعه از جدول -د . 

 ؟ داد انجام View Sheet Data در توان نمی را زیر موارد از کدامیک-939

 رکورد حذف -الف

 رکورد اصالح -ب

 رکورد کردن اضافه -ج

 فرم ایجاد -د 

 ؟ شوند می دیده جزئیات با چپ سمت پانل های آیکن Base Data پنجره در نمایش حالت کدام در-940

 Small Icons -لف

 List -ب

 ج- Details 

 Large Icons -د

 ؟ چیست یاطلاعات بانک طراحی در مرحله آخرین معموالً-941

 کار رابط طراحی -الف

 کار روند رسم -ب



 

 

 سازي مستند -ج

 آن پاالیش و آزمایش و برنامه در داده کردن وارد -د

 از کمهد کدام روی بر نظر مورد فیلد انتخاب از پس یاطلاعات بانک طراحی هنگام در اولیه کلید تعیین برای-942

 ؟ نمود کلیک باید ابزار نوار

 Indexes -الف

 Build -ب

 ج- Primary Key 

Data Base Window -د

 ؟ کنی  می کلیک تب کدام از را Record New گزینه جدید رکورد یک کردن اضافه برای-943

 الف- home ب- Format ج- table د- Insert 

 ؟ کنی  می کلیکcreate تب از را مورد کدام گزارش ایجاد برای-944

Table -د Queries -ج Reports -بForms   -الف

 ؟ است صحیح زیر گزینه کدام پیشرفته فیلتر تعیین برای-945

 Filter By Form -الف

 Sort -ب

 Filter By Selection -ج

 د- Advanced Filter / Sort

 در یکبلار کله پلاورقی یلک و تیتلر عنلوان بله گلزارش اول در بلار یلک کله صلفحه سر ایجاد برای-946

 گزارش انتهای

 ؟ دهی  قرار قسمتها آن در را نظر مورد متن تا کنی  می انتخاب design تب از را مورد کدام شود چاپ

 لفا- Report Header/ Footer 

 Page Header/ Footer -ب

 Data Base -ج

Format -د

 ؟ نیست Base Data پنجره های Object جزو یک کدام اکسس در-947

 Report -الف

 Table -ب

 ج- Data Base 

Forms -د

 کداماز است بهتر. ............. و ،گزارش ایجادفرم برای نیستند ای حرفه که کاربرانی یا کار راحتی برای کاربرها-948

 ؟ نمایند استفاده روش

 Desing -الف

 ب- Wizard 

 File - New Form -ج

createt - Form -د

 را اآنه دستی بصورت خود برخواسته بنا تواند می طراح که............  و ،گزارش،جدول فرم طراحی برای-949

 ؟ شود می استفاده روش کدام از کند طراحی

 الف- Design 

 Wizard -ب

 File - New Form -ج

create - Form -د

 ؟ شود می نامیده چه جدول از ستون هر اکسس در-950

Records -د Rows -ج Fields -بCells   -الف

 ؟ دهد می نشان را نتیجه سپس پرسد می یاطلاعات بانک از سؤالی زیر های Object از کدامیک-951

 Forms -د Queries -جReports   -ب Tables -الف



 

 

 ؟ نیست Access به مربوط زیر های Object از کدامیک-952

 Tables -الف

 Queries -ب

 Forms -ج

 د- Workbooks

 می اتفاق چه کند اضافه Query فیلد لیست به فیلدها لیست از را ستاره Query طراحی هنگام در اگر-953

 ؟ افتد

 . کند می Sort کند می تعیین که دستوري براساس را جدول رکوردهاي Query -الف

 . دهد می قرار استفاده مورد آنها نمایش بدون را جدول رکوردهاي Query -ب

 ج- Query شود می شامل را جدول فیلدهاي تمام . 

 . شد نخواهد شامل را جدول فیلدهاي از هیچکدام Query -د

 « فیلد که شوند پیدا رکوردهایی که شد خواهد باعث دهی  قرار Criteria در را زیر موارد از یک کدام-954

 ؟ است" Nice " مخالف آنها»  شخصیت

 >Nice -الف

 ”> <Nice” -ب

 Nice Is -ج

 د- Not Nice 

 ؟ کنند دریافت توانند می کجا از را شاناطلاعات فرمها و ها گزارش-955

 الف- Tables ب- Forms ج- Queries د- Report

 ؟ است مرحله کدام Wizard طریق از گزارش یا فرم طراحی هنگام در مرحله اولین-956

 . شوند بندي قالب فرم یا گزارش چگونه اینکه انتخاب -الف

 . شوند ظاهر گزارش یا فرم در خواهید می که فیلدهایی انتخاب -ب

 یا جدول انتخاب -ج Query گیرد صورت آن براساس فرم یا گزارش خواهید می شما که . 

 . شوند تمام ویزارد مراحل اینکه تا Next روي بر کلیک و هم سر پشت صفحه چندین خواندن -د

 ؟ نیست داده انواع از زیر موارد از کدامیک-957

 الف- Picture/Graphic 

 Number -ب

 Text -ج

Date/ Time -د

 ؟ دارد کاربرد زیر موارد از یک کدام در Text Long نوع از فیلد-958

 . هستند 255 از کمتر کاراکترهاي داراي که فیلدهایی براي -الف

 هستند کلمه چند یا یک از بیشتر که طوالنی متنهاي براي -ب . 

 ... و Word یلفا یا گرافیک مانند اند شده ایجاد دیگر هاي برنامه در که هایی موضوع کردن ذخیره براي -ج

 تصویر درج براي -د

 ؟ است تر مناسب Key Primaryبرای زیر فیلدهای از کدامیک-959

 تاریخ فیلد -الف

 number Auto فیلد -ب

 کتابخانه در فرد عضویت شماره فیلد -ج 

فرد نام -د

 ؟ نیست درست خصوصیت مورد در زیر موارد از کدامیک-960

 .شود می وارد فیلدها جدیددر رکورد ایجاد هنگام در اتوماتیک صورت به Default مقدار -الف



 

 

 خصوصیت مقابل در -ب Required نمود وارد را) -( - - صورت به عبارتی توان می . 

 . نه یا کند وارد مقدار فیلد در باید کاربر کند می تعیین Required خصوصیت -ج

 . نمود وارد مقادیر از لیست یک از را فیلد مقدار که دهد می اجازه Up Look فیلد -د

 ؟ نیست صحیح زیر موارد از کدامیک-961

 . کند می محافظت ها ورودي بودن تکراري از Duplicates No(Yes) صورت به Indexed دادن قرار -الف

 . شود می ایندکس اتوماتیک صورت به Key Primary -ب

 فیلدهاي از کدام هر توانید می شما -ج Text ،Object Ole ،Link Hyper کنید ایندکس را . 

 No) ،Ok Duplicate(Yes ،No(Yes:  عبارتنداز شودکه تنظیم تواند می حالت سه به Index خصوصیت -د

Duplicate) 

 ؟ است نادرست یک کدام-962

 فیلد طول ماکزیمم -الف Memo است 255 برابر . 

 . است اجباري فیلد به داده کردن وارد کنید تعیین که دهد می اجازه شما به Required -ب

 . شود می دهدا فیلد به اتوماتیک صورت به مقدار این جدید رکورد ایجاد هنگام در که کند می تعیین Default مقدار -ج

 . رود می کار به فیلد به شده وارد داده مقدار ارزیابی تعیین براي Rule Validation -د

 نوشت؟ توان نمی Query طراحی هنگام در Criteria مقابل در را زیر موارد از کدامیک-963

 ”Harris” -الف

 ب- No Value 

 <500 -ج

 Between 1.1.2005 And 12.30.2006 -د

 ؟ نیست Report یک بخشهای از زیر موارد از کدامیک-964

 الف- Summary Section 

 Detail Section -ب

 Report Header Section -ج

Page Header Section -د

 ؟....................... Primary Keyبرای  -965

 جدول رکوردهاي کردن)  یکتا)  Unique براي -الف

 جدول رکوردهاي کردن Sort -ب

 براي -ج Unique جدول هاي فیلد سازي 

 جدول فیلدهاي کردن sort براي -د

 ؟ است یاطلاعات بانک یک زیر افزار نرم کدام-966

 Fox pro -الف

 ب- Access 

 Visual Basic -ج

Word -د

 بزرگ یا کوچک حرو  با اینکه مثالً.  کند می مشخص را فیلد نمایش قالب ها فیلد در زیر خواص کدام-967

 ؟ شود داده نمایش

 Indexed -ب Caption-الف



 

 

 ج- Format د- Validation Rule 

 ؟ باشد خالی تواند نمی فیلد این که دهد می نشان ها فیلد در زیر خواص از کدامیک-968

 Precision -الف

 Scale -ب

 Allow Zero Length -ج

 د- Required

 فیلد خواص درکدام شود ذخیره تواند می Decimal ازنوع عددی فیلد دریک را اعشاری ارقام تعداد-969

 ؟ شود می مشخص

 Scale -الف

 Input Mask -ب

 ج- Decimal places 

Default Value -د

 ؟ شود می استفاده یاطلاعات بانک در تصویر دادن قرار برای داده نوع کدام-970

 Memo -الف

 Number -ب

 ج- Ole 

 Look Up Wizard -د

 ازخواص کدامیک در Decimal اعداد برای شود ذخیره تواند می اعشار نقطه از بعد که ارقامی کل تعداد-971

 ؟ شود می مشخص فیلد

 Precision -الف

 Scale -ب

 ج- Decimal places 

 Default Value -د

 ؟ است مناسب عدد و متن ترکیب یا و متن برای داده نوع کدام-972

 الف- Text 

 Number -ب

 Currency -ج

Auto Number -د

 ؟ ندارد محدودیتی فیلد طول نظر از همچنین و است متنی نوع از های داده برای زیر داده نوع کدام-973

 الف- Long Text 

 Text -ب

 Currency -ج

Auto Number -د

 داده تشخیص برای اطلاعات ورود جهت قانون عنوان به عبارتی تعیین برای فیلدها خصوصیات از کدامیک-974

 ؟ است نامعتبر، های

 Validation Text -الف

 ب- Validation Rule 

 Input Mask -ج

Require -د

 ؟ کند می ایجاد منو بصورت مختلف اقال  شامل فیلدی ، داده نوع کدام-975

 -Numberالف

 ب- Look Up Wizard 

 Text -ج

 Memo -د

 ؟ شود می استفاده قسمت کدام از Property Field در فیلد برچسب تعیین جهت-976

 Validation Rule -الف

 Field Size -ب

 ج- Caption 

Pages -د

 ؟ شود می مطرح جدول در شده ذخیره های داده از که است پرسشی کدامیک-977

 الف- Queries ب- Tables ج- Forms د- Pages



 

 

 می Accessدر تکراری کارهای جهت شده تعریف قبل از نویسی برنامه های کد از استفاده برای کدامیک-978

 باشد؟

Forms -د Modules -ج Macros -بPages   -الف

 ؟ کند می منتقل جاری رکورد فیلد اولین به را نما مکان کلید کدام-979

 الف- Home 

 End -ب

 Page Up -ج

Page Down -د

 می استفاده مضاعف اعشاری دقت با اعداد سازی ذخیره جهت( Number(  عددی داده اندازه نوع کدام-980

 ؟ شود

 Single -الف

 ب- Double 

 Integer -ج

Long Integer -د

 ما اختیار در اعشاری اعداد ورود کنترل جهت را Precision و Scale خواص عددی داده انواع از کدامیک-981

 ؟ دهد می قرار

 Double -الف

 Single -ب

 Replication Id -ج

 د- Decimal

 ؟ نیست Indexed مختلف مقادیر از کدامیک-982

 Yes(Duplicate Ok) -الف

 No -ب

 Yes(No Duplicate) -ج

 د- uni code

 ؟ کرد ایجاد ایندکس توان نمی فیلدها نوع از یک کدام روی بر-983

 Number -الف

 ب- Ole 

 Text -ج

 . کرد ایجاد ایندکس توان می فیلد نوع همه روي بر -د

 می هاستفاد زیر ای داده انواع از کدامیک میلیارد+ 3 و میلیارد- 3 بین صحیح اعداد سازی ذخیره جهت-984

 ؟ شود

 Byte -الف

 ب- Double 

 Decimal -ج

 Long Integer -د

 ؟ است گسترده صفحه تمام در Excel سربرگ شبیه فرم ایجاد روشهای از کدامیک-985

 Columnar -الف

 Tabular -ب

 ج- Data Sheet 

 Auto Wizard -د

 ؟Tabular صورت به فرم ایجاد با-986

 باشیم داشته رکوردها در فیلدها از جدولی صورت به را فرم توانیم می -الف . 

 . کنیم ایجاد ستونی فرم نوعی توانیم می -ب

 . کنیم ایجاد معمولی فرمهاي توانیم می -ج



 

 

 کنیم ایجاد معمولی فرمهاي توانیم نمی -د

 ؟ نیست فرم اصلی بخشهای از کدامیک-987

 Detail -الف

 Form Header -ب

 Form Footer -ج

 د- Form View

 ؟ کند می ایجاد ستونی را فرم نوع انتخاب کدام-988

 Tabular -الف

 ب- Columnar 

 Form Wizard -ج

Data Sheet -د

 می... ..... را استفاده برای آنها ارائه و یاطلاعات بانک یک از شده خواسته های داده و اطلاعات استخراج-989

 . گویند

 Macro -د Query -جPage   -ب Table -الف

 ؟ روند می بکار Query طراحی و مشاهده برای نماها ترین معمولی از کدامیک-990

 نماي Data Sheet View -الف

 Design View -ب

 ج- Design View و Data Sheet View نماي 

 Data Type View -د

 شود؟ می استفاده زیر اشیا از یک کدام از یاطلاعات بانک در شده انجام تکراری عملیات از استفاده جهت-991

Queries -د Macro -جReports   -ب Tables -الف

 کدام ، آنها بین عملگر شرط هردو بودن دارا شود،برای نوشته Criteria در شرطی عبارت دو که هنگامی-992

 ؟ است

Or -د And -جXor   -ب Not -الف

 ؟ است صعودی سازی مرتب نوع کدام-993

 الف- Ascending 

 Descending -ب

 Grouping -ج

Sorting -د

 ؟ کنی  می تعیین را چیز چه ، گزارش ایجاد هنگام در Orientation قسمت در-994

 رکوردها بودن نزولی و صعودي -الف

 کاغذ روي بر گزارش چاپ جهت -ب 

 رکوردها بندي گروه -ج

 گزارش نوع -د

 ؟ کند می محاسبه را اعداد میانگین ، گزارش طراحی در زیر توابع از یک کدام-995

 Count -الف

 Sum -ب

 Maximum -ج

 د- Average 

 گزارش ایجاد هنگام در قسمتی چه از شود، بندی دسته استان اساس بر کارمندان لیست بخواهی  اگر-996

 ؟ کنی  می استفاده

 Orientation -الف

 ب- Group 

 Order -ج

Layout -د



 

 

 ؟ شود می چاپ گزارش ابتدای در یکبار فقط گزارش از ناحیه کدام-997

 Page Footer -الف

 Report Footer -ب

 ج- Report Header 

Page Header -د

 ؟ شود می استفاده فیلدها متن نمایش برای گزارش طراحی در زیر کنترل کدام-998

 لفا - Text Box 

 Lable -ب

 Image -ج

 Line -د

 ؟ شود می استفاده کلید کدام از ه  سر پشت و همجوار کلمات انتخاب برای-999

Shift -دTab   -ج Alt -ب Ctrl -الف

 کرد؟ استفاده توان می زیر گزینه کدام از خط چند انتخاب برای-1000

 جهتی کلیدهاي با همراه Alt کلید -الف

 انتها طرف به ماوس کشیدن و مبدا بر کردن کلیک -ب 

 Alt کلید فشردن با همراه کلمات انتخاب و ماوس درگ و کلیک -ج

 جهتی کلیدهاي با همراه Ctrl کلید -د

 . کنی  می ستفادها............  محاوره کادر از.............  زبانه از متن، یک اجزای بین فاصله تعیین برای-1001

 Font از spacing character زبانه -الف

 ب- Paragraph از Line and page breaks زبانه 

 Paragraph از spacing character زبانه -ج

 زبانه Line and Page Breaks از Font -د

 ؟ کنی  می انتخاب را زبانه کدام Symbol ای محاوره کادر از ویژه کاراکترهای درج برای-1002

 لفا- Special Characters 

 Symbol -ب

 Insert -ج

 Shortcut -د

 کنی ؟ می استفاده دکمه کدام از نمادها برای میانبر کلید کردن سفارشی کادر در میانبر کلید حذ  برای-1003

 Assign -الف

 Reset All -ب

 ج- Remove 

 Close -د

 :توان می را Word در نما تغییر های روش-1004

 زبانه از -الف View کرد فعال 

 کرد فعال Review زبانه از -ب

 کرد فعال دارد قرار افزار نرم محیط چپ سمت در که هایی دکمه طریق از -ج

 کرد فعال را آن File منوي طریق از میتوان -د

 داد؟ تغییر ورد در را نماها میتوان روش کدام از-1005

 محیط راست سمت و پایین گوشه در که هایی دکمه طریق از -الف Word دارند قرار 

 کرد فعال توان می Show گروه View زیانه از -ب

 کرد فعال میتوان Insert زبانه از -ج



 

 

 دارند قرار word محیط چپ سمت و پایین گوشه در که هایی دکمه طریق از -د

 چیست؟ سبک تعریف-1006

 گویند می سبک word در موجود هاي ابزار کلیه به -الف

 شخصم نام یک با که هستند شده مشخص کاراکتر یک براي اندازه رنگ، فونت، مانند شده تعریف پیش از قالببندي -ب 

 میشوند ذخیره

 گویند سبک یک را انتخاب هر -ج

 گویند را word در متن نمایش هاي روش -د

 گیرد؟ می صورت روش کدام از سبک یک انتخاب-1007

 انتخاب -الف Style زبانه از Home 

 Review زبانه از Style انتخاب -ب

 Design زبانه از Style انتخاب -ج

View زبانه از Style انتخاب -د

 ؟ شود می عمل چگونه کش خط روی از Tab یک حذ  برای-1008

 کنیم می درگ کش خط از بیرون به را نظر مورد تب -الف 

 دهیم می فشار را Delete کلید و کرده اشاره نظر مورد تب روي بر -ب

 کنیم می کلیک Create دکمه روري بر نظر مورد تب انتخاب از پس Tabs اي محاوره کادر از -ج

 گزینیم می بر را Remove Tab گزینه Tabs اي محاوره کادر از -د

 ؟ شود می عمل چگونه کش خط روی از Tab یک حذ  برای-1009

 کنیم می حذف کلید صفحه از Backspace کلید با را نظر مورد تب -الف

 دهیم می فشار را Delete کلید و کرده اشاره نظر مورد تب روي بر -ب

 اي محاوره کادر از -ج Tabs دکمه روري بر نظر مورد تب انتخاب از پس Clear کنیم می کلیک 

 گزینیم می بر را Tab Removeگزینه Tabs اي محاوره کادر از -د

 کوچک حرو  از شده انتخاب متن های واژه تمام کاراکتر اولین برای Case Change از گزینه کدام-1010

 کند؟ می استفاده

 Uppercase -الف

 Title Case -ب

 Lowercase -ج

 د- Toggle Case

 ؟ است مناسب گزینه کدام Word در ها متن خودکار اصالح برای-1011

 Auto Format -الف

 ب- Auto Correct 

 Auto Select -ج

 Auto Change -د

 .کنی  می انتخاب را...............................  گزینه........................  سربرگ از گرامری و امالیی خطایابی برای-1012

 Home > Spelling -الف

 View > Grammar -ب

 ج- Review > Spelling & Grammar 

 Insert > Spelling & Grammar -د

 : توان می آن تصحیح برای شود می کشیده دار موج قرمز خط یک کلمه زیر در که هنگامی-1013

 نمود حذف را دار موج خط و کرده کلیک دوبار آن روي -الف

 گزینید بر میانبر منوي از را پیشنهادي واژههاي از یکی و نموده راست کلیک آن روي -ب. 



 

 

 گزینیم می بر را Format گزینه و کرده راست کلیک کلمه روي -ج

 فشاریم می را Delete دکمه و کنیم می انتخاب را کلمه -د

 :توان می آن تصحیح برای شود می کشیده دار موج قرمز خط یک کلمه زیر در که هنگامی-1014

 نمایید حذف دار موج خط و کرده کلیک دوباره آن روي -الف

 گزینیم می بر را Change گزینه و نموده راست کلیک آن روي -ب

 هاي گزینه لغات از یکی و نموده راست کلیک آن روي -ج All Ignore و Autocorrect برگزینید را 

 . فشاریم می کلید صفحه از را lock caps دکمه بعد و انتخاب را کلمه -د

 ؟ ست معنی چه به کلمه زیر در قرمز خط-1015

 دارد گرامري مشکل کلمه -الف

 دارد نوشتاري مشکل کلمه -ب 

 دارد فرمت مشکل کلمه -ج

.است ویرایش غیرقابل کلمه -د

 دارد؟ معنایی چه کلمات زیر در آبی خط-1016

 دارد گرامري مشکل کلمه -الف

 دارد نوشتاري مشکل کلمه -ب 

 دارد فرمت مشکل کلمه -ج

 .است ویرایش غیرقابل کلمه -د

1017-Width Column Fixed ناحیه در واقع fit Auto دهد؟ می انجام عملی چه 

 .شود تنظیم معینی طول با برابر جدول سطرهاي کلیه طول که دهد می را امکان این -الف

 کند تنظیم معینی طول با برابر را جدول سطرهاي کلیه پهناي که دهد می را امکان این -ب

 کند تنظیم معینی طول با برابر را جدول هاي ستون کلیه طول که دهد می را امکان این -ج

 کند تنظیم معینی طول با برابر را جدول هاي ستون کلیه پهناي که دهد می را امکان این -د. 

 است؟ صحیح ترسی  روش به جدول ایجاد با رابطه در ها گزینه از کدامیک-1018

 Table سربرگ از Insert گزینه انتخاب -الف

 Home سربرگ از Table گزینه انتخاب -ب

 Table سربرگ از Table Draw گزینه انتخاب -ج

 انتخاب -د Table Draw سربرگ از Insert گروه Table 

 در سطر Layout ،5 سربرگ از Below Insert گزینه انتخاب و جدول یک آخر سطر 5 انتخاب با-1019

 شود می ایجاد شده انتخاب سطرهای............

چپ سمت -د راست سمت -ج پایین -ب  بالا -الف

 در سطر Layout ،5 سربرگ از Above Insert گزینه انتخاب و جدول یک آخر سطر 5 انتخاب با-1020

 . شود می ایجاد شده انتخاب سطرهای................. 

 چپ سمت -د راست سمت -ج پایین -ب بالا -الف

 ............ در سطر Layout ،5 سربرگ از Right Insert گزینه انتخاب و جدول یک آخر سطر 5 انتخاب با-1021

 .شود می ایجاد شده انتخاب سطرهای

چپ سمت -د راست سمت -ج  پایین -ب بالا -الف

 ............. در سطر Layout ،5 سربرگ از Left Insert گزینه انتخاب و جدول یک آخر سطر 5 انتخاب با-1022



 

 

 .شود می ایجاد شده انتخاب سطرهای

چپ سمت -د  راست سمت -ج پایین -ب بالا -الف

 شود؟ می استفاده دستوری چه از مداد از استفاده با جدول ترسی  برای-1023

 Insert table -الف

 Quick Table -ب

 ج- Draw Table 

 Write Table -د

 کنی ؟ می استفاده دستور کدام از کادر بدون های نوشته به جدول های نوشته تبدیل برای-1024

 Repeat Header Rows -الف

 ب- Convert to Text 

 Convert to table -ج

Convert to Formula -د

 است؟ صحیح شکل آن انتخاب از پس شکل یک اندازه تغییر جهت زیر موارد از یک کدام-1025

 سر 4 پیکان -الف

 سر 2 پیکان -ب 

 شکل يبالا دایره -ج

 Border دستور -د

 است؟ صحیح زیر مراحل از یک کدام اشکال چرخاندن جهت-1026

 Insert -> Rotate -الف

 View -> Rotate -ب

 Home -> Rotate -ج

 د- Format -> Rotate

 کنی ؟ می استفاده فرمان کدام از سند یک متن کاراکترهای تعداد شمارش برای-1027

 View منوي از Count Word فرمان -الف

 فرمان -ب Count Word منوي از Review 

 Home منوي از Count Word فرمان -ج

 References منوي از Count Word فرمان -د

 شود؟ می کلیک دکمه کدام روی پستی ادغام فرم در گیرندگان انتخاب برای-1028

 الف- Edit Recipients 

 Select Recipients -ب

 Update Labels -ج

Match Field -د

 ؟ است کدام Subscript دستور میانبر کلید-1029

 ( +Ctrl -الف

 ب- Ctrl+ = 

  Ctrl + Shift+  -ج

 ] +Ctrl -د

 .دهی  می فشار را........................  ترکیبی کلید استفاده مورد سبک از کامل اطلاعات دیدن برای-1030

 الف- Shift + F1 

 Ctrl + Alt + S -ب

 Ctrl + Shift + S -ج

Ctrl + S -د

 کرد؟ استفاده توان می زبانه کدام از پاصفحه و سرصفحه ایجاد برای-1031

Design -د View -ج Insert -بHome   -الف

 را کادر دلخواه خط سبک توان می........  قسمت از استفاده با shading and border ای محاوره کادر در-1032

 .نمود تعیین

 Style -دBox   -ج Art -ب Color -الف



 

 

 ملی اسلتفاده ترکیبلی کلیلد چله از التلین بله فارسلی تایلپ حاللت از کلیلد صفحه تبدیل برای-1033

 شود؟

 راست سمت Ctrl + Alt -الف

 چپ سمت Shift + Ctrl -ب

 ج- Shift + Alt راست یا چپ سمت 

راست سمت Shift + Ctrl -د

 شود؟ می استفاده سند کل انتخاب برای ترکیبی کلید کدام از-1034

 Ctrl + Click -الف

 Ctrl + Shift + Click -ب

 Ctrl + End -ج

 د- Ctrl + A

 شود؟ می استفاده ترکیبی کلید کدام از سند ذخیره برای-1035

 Ctrl + o -الف

 Ctrl + Shift + S -ب

 ج- Ctrl + S 

 Ctrl + P -د

 شود؟ می استفاده دکمه کدام از سند در فرمول کردن وارد برای-1036

 Symbol -الف

 ب- Equation 

 Formula -ج

Comment -د

 شود؟ می استفاده کلیدی ترکیب چه از کلید صفحه از استفاده با بعد صفحه به رفتن و متن شکستن برای-1037

 F2 -الف

 Ctrl + V -ب

 ج- Ctrl + Enter 

 Ctrl + S -د

 شود؟ می استفاده دکمه کدام از سند های حاشیه تنظی  برای-1038

 Column -الف

 ب- Margins 

 Size -ج

Orientation -د

 ؟ شود می استفاده گزینه کدام از صفحه به کادر افزودن برای-1039

 Insert -> Page Break -الف

 Page Layout -> Page Border -ب

 ج- Design -> Page Border 

 Page Setup -> Line number -د

 است؟ کدام Word الگوهای سازی ذخیره برای فرض پیش پوشه نام-1040

 الف- Templates 

 Documents -ب

 Microsoft Word -ج

Program File -د

 شود؟ می استفاده دکمه کدام از جدول های سلول ادغام برای-1041

 Split Cells -الف

 Split Table -ب

 ج- Merge Cells 

Merge Table -د

 شود؟ می انتخابText Wrap یخش از گزینه کدام گیرد قرار متن پشت تصویر اینکه برای-1042

 Tight -الف

 Square -ب

 ج- Behind Text 

Through -د



 

 

 .کنی  می اجرا را.........................  دستور...................  زبانه از صفحه شماره درج برای-1043

 Page Number-Design -الف

 Page Number-Review -ب

 Page Number-Home -ج

 د- Page Number-Insert

 گزینی ؟ می بر را گزینه کدام راست کلیک از بعد کلمه زیر قرمز خط گرفتن نادیده برای-1044

 Add to Dictionary -الف

 ب- Ignore 

 Deny -ج

 Cancel -د

 ؟ کنی  انتخاب را گزینه کدام باید آن مشابه کلمات تمام و اشتباه کلمه زیر قرمز خط گرفتن نادیده برای-1045

 Ignore -الف

 Ignore total -ب

 ج- Ignore All 

 Deny -د

1046-page Blank گروه از Pages دارد؟ کاربردی چه 

 کند می درج خالی صفحه یک -الف. 

 کند می ایجاد سند براي کاور یک -ب

 رود می سند در بعد صفحه به -ج

.کند ایجادمی الگو سند یک -د

 چیست؟ Pages گروه در Break Page دستور کاربرد-1047

 .کند می درج خالی صفحه یک -الف

 کند می ایجاد سند براي کاور یک -ب

 کند می قطع را سند مابقی و انتخابشده بخش میان ارتباط -ج 

 .کند می ایجاد الگو سند یک -د

 کنی ؟ می عمل چگونه Word افزار نرم در جلد صفحه از استفاده برای-1048

 page coverدستور editing گروه Home زبانه -الف

 زبانه -ب Insert گروه Pages دستور Cover Page 

Cover Page دستور Page Layout ج -زبانه 

Cover Page دستور Page Border گروه Design د -زبانه 

 است؟ مناسب دستور کدام ها نوشته پشت و صفجه روی کمرنگ متن ایجاد برای-1049

 Page Color -الف

 Text Color -ب

 Background Color -ج

 د- Watermark

 چه از دهید نمایش تصویر و شکل صورت به را هستند مربوط ه  به که یاطلاعات بخواهید اینکه برای-1050

 کنید؟ می استفاده Word در دستوری

 Word Art -الف

 Screenshot -ب

 Shape -ج

 د- Smart Art

 شوند؟ می نامیده چه Word نرمافزار جدول در ستونها-1051

 الف- Columns 

 Rows -ب

 Cells -ج

Table -د

 شوند؟ می نامیده چه دارند قرار جدول در افقی صورت به که سلولهایی-1052



 

 

 Cells -الف

 Columns -ب

 ج- Rows 

Table -د

 .شود می گفته...................  یک جدول خانه هر به-1053

 Rows -الف

 Columns -ب

 Table -ج

 د- Cell

 کنی ؟ می عمل روشی چه به ایجاد زمان در جدول ستون و سطر تعداد کردن وارد برای-1054

 Insert زبانه از Table Draw -الف

 روي کلیک -ب Table زبانه از Insert انتخاب و Table Insert 

 Insert زبانه از Table Input -ج

 Home زبانه از Table Insert -د

 ؟ کنی  می وارد را سطر تعداد Table Insert محاوره کادر از بخش کدام در-1055

 Number of Columns -الف

 Fixed Column width -ب

 ج- Number of Rows 

 Number of Cells -د

 شود؟ می داده نمایش هایی زبانه چه جدول یک ایجاد از بعد-1056

 Format, Layout -الف

 Table, Design -ب

 Design, Table -ج

 د- Design, Layout

 خیر؟ یا باشد داشته عنوان سطر ما جدول که کنی  می تعیین Design زیانه از بخش کدام در-1057

 Banded Rows -الف

 ب- Header Row 

 Total Row -ج

 Last Row -د

 ببینی ؟ را سند اطلاعات توانی  می File زبانه قسمت کدام در-1058

 الف- INFO 

 SHARE -ب

 EXPORT -ج

ACCOUNT -د

 کرد؟ چاپ را سند صفحات تمام توان می Print دستور های گزینه از کدامیک-1059

 Print Preview -الف

 ب- Print All Page 

 Print Selection -ج

 Print Current Page -د

 کنی ؟ می عمل چگونه شود چاپ زوج صفحات فقط بخواهی  اگر-1060

 Odd Page -الف

 Print All Page -ب

 ج- Even Page 

 Print Current Page -د

 شود؟ می استفاده دستور کدام از چاپ صفحات کردن سفارشی برای-1061

 الف- Custom Print 

 Print All Page -ب

 Print Selection -ج

Print Current Page -د

 .......متن در) توضیحات) Comment درج برای-1062

 Insert>New Comment -ب View>New Comment -الف



 

 

Review>New Comment -دHome>New Comment   -ج

 کنی ؟ می استفاده مورد کدام از Word افزار نرم محیط در صفحه بزرگنمایی کردن سفارشی برای-1063

 Custom -الف

 Review>Zoom -ب

 ج- View>Zoom 

View>Setting -د

 چیست؟ Font کاربرد-1064

 کنیم تعیین را متن اندازه توانیم می گزینه این از استفاده با -الف

 دهیم تغییر را انتخابی متن شکل توانیم می گزینه این از استفاده با -ب

 دهیم تغییر را متن نوع توانیم می گزینه این از استفاده با -ج 

 .کنیم می استفاده مورد این از متن به دادن فرمت براي -د

 است؟ تر مناسب مورد کدام متن روی شده اعمال های فرمت کردن پاک برای-1065

 Change Case -الف

 Remove Format -ب

 ج- Clear All Formatting 

Delete Formatting -د

 دهد؟ می انجام کاری چه Strikethrough دستور-1066

 کند می درج خط یک متن روي -الف. 

 .کند می درج متن زیر خط یک -ب

 .کند می کج و مایل را متن -ج

.کند می توپر را متن -د

 است؟ کدام دستور ترین سریع الفبا حرو  یا عدد اساس بر ها نوشته سازی مرتب برای-1067

 Filter -الف

 Increase Alphabet -ب

 ج- Sort 

Asset -د

 کنی ؟ می استفاده گزینه کدام از شود ایجاد متن در پاورقی بخواهی  اینکه برای-1068

 لفا- End note 

 Footnote -ب

 Footer -ج

Header -د

 دارد؟ کاربردی چه جدول DESIGN زبانه در Styles Table گروه-1069

 جدول خطوط بر سبک اعمال -الف

 جدید هاي سلول ایجاد -ب

 جدول روي سبک اعمال -ج 

تصویر روي سبک اعمال -د

 رود؟ می کار به مورد کدام جدول های سلول رنگ تغییر برای-1070

 Table Color -الف

 Border -ب

 Fill Color -ج

 د- Shading

 گزینی ؟ می بر را Select دستورات از یک کدام جدول سطر انتخاب برای-1071

 Select Cell -الف

 Select Column -ب

 ج- Select Row 

Select Table -د

 گزینی ؟ می بر را Select دستورات از یک کدام جدول ستون انتخاب برای-1072

 Select Cell -الف

 ب- Select Column 

 Select Row -ج

Select Table -د



 

 

 ؟ کنی  می استفاده Select دستورات از کدامیک از جدول در سلول انتخاب برای-1073

 الف- Select Cell 

 Select Column -ب

 Select Row -ج

Select Table -د

 کنید؟ می انتخاب را Select دستورات از یک کدام جدول کل انتخاب برای-1074

 Select Cell -الف

 Select Column -ب

 Select Row -ج

 د- Select Table

 دهد؟ می انجام کاری چه Select گروه از Row Select دستور-1075

 کند می انتخاب را سلول -الف

 .کند می انتخاب را جدول ستون -ب

 کند می انتخاب را جدول سطر -ج 

کند می انتخاب را جدول کل -د

 جا یک صورت هب را جدول دیگر تنظیمات و رنگ جهت، ها، اندازه توانی  می...............  ای محاوره کادر در-1076

 .کنی  تعیین

 Table Option -الف

 Table Setting -ب

 ج- Table Properties 

View Gridlines -د

 دارد؟ کاربردی چه Draw گروه از Eraser گزینه-1077

 جدول سطر و ستون رسم -الف

 متن به جدول تبدیل -ب

 جدول هاي نوشته جهت تعیین -ج

 جدول نظر مورد قسمت حذف -د 

 شود؟ می استفاده دستور کدام از جدول نظر مورد قسمت کردن پاک برای-1078

Eraser -دRemove   -ج Clear -ب Draw -الف

 گزینی ؟ می بر را Delete گروه از دستور کدام جدول های ستون حذ  برای-1079

 Delete Cells -الف

 ب- Delete Columns 

 Delete Rows -ج

Delete Table -د

 گزینی ؟ می بر را Delete گروه از دستور کدام جدول های سطر حذ  برای-1080

 Delete Cells -الف

 Delete Columns -ب

 ج- Delete Rows 

Delete Table -د

 گزینی ؟ می بر را Delete گروه از دستور کدام جدول های سلول حذ  برای-1081

 الف- Delete Cells 

 Delete Columns -ب

 Delete Rows -ج

Delete Table -د

 کنی ؟ می اعمال را Delete گروه از دستور کدام جدول کل حذ  برای-1082

 Delete Cells -الف

 Delete Columns -ب

 Delete Rows -ج

 د- Delete Table

 کنی ؟ می استفاده دستور کدام از ستون و سطر چند به سلول یک تجزیه برای-1083

 Merge Cells -الف

 ب- Split Cells 

 Split Table -ج

Split Column -د



 

 

 است؟ مناسب دستور کدام بخش دو به جدول تقسی  برای-1084

 Merge Cells -الف

 ب- Split Table 

 Split Cells -ج

Separate Table -د

 :کنی  تعیین را جدول ارتفاع توانی  می گزینه این توسط-1085

 الف- Height ب- Weight ج- Width د- Vertical

 :کرد تعیین را جدول عرض توان می گزینه این توسط-1086

 Vertical -د Width -جWeight   -ب Height -الف

 کنی ؟ منظ  را ها آن توانی  می گزینه کدام توسط شد، نامنظ  جدول سطرهای اندازه هرگاه-1087

 Distribute Columns -الف

 ب- Distribute Rows 

 Distribute Cell -ج

Distribute Table -د

 کنی ؟ منظ  را ها آن توانی  می گزینه کدام توسط شد، نامنظ  جدول های ستون اندازه هرگاه-1088

 الف- Distribute Columns 

 Distribute Rows -ب

 Distribute Cell -ج

Distribute Table -د

 دهی ؟ تغییر را جدول نوشته جهت توانی  می چگونه-1089

 Table گروه از Orientation Text -الف

 Sort گروه از indentation Text -ب

 ج- Direction Text گروه از Alignment 

Text Directionاز گروه Cell Size -د

 .باشد داشته فاصله چقدر سلول حاشیه از متن کنی  تعیین توانی  می.............  گزینه از استفاده با-1090

 Cell Direction -الف

 Cell Alignment -ب

 Cell Indention -ج

 د- Cell Margins

 نمود؟ استفاده میتوان ابزار کدام از صفحه هر در جدول سطر عنوان تکرار برای-1091

 Convert to text -الف

 Repeat Header Column -ب

 ج- Repeat Header Row 

Repeat Header Cell -د

 دارد؟ عملکردی چه Data گروه در Rows Header Repeat دستور-1092

 کند می تبدیل متن به را جدول -الف

 بنویسیم فرمول توانیم می -ب

 کند می ایجاد عنوان سطرها براي -ج

 کند می تکرار را جدول عنوان صفحه هر در -د

 . رود می کار به تصویر درج برای گزینه کدام-1093

 Illustrate -الف

 Shape -ب

 Image -ج

 د- Picture

 .گردد می ایجاد....................  نام به جدید زبانه یک تصویر نمودن درج با-1094

 الف- Format ب- Picture ج- Design د- Layout

 آید؟ می حساب به زیر های برنامه از یک کدام جزو Word افزار نرم-1095

 نویسی برنامه -الف

 اطلاعات بانک -ب

 پرداز واژه -ج 

گسترده صفحه -د



 

 

 دارد؟ کاربرد مورد کدام درWord افزار نرم-1096

 نویسی برنامه -الف

 مالی امور -ب

 گرافیکی امور -ج

 مقاله و کتاب ویرایش و تهیه -د

 است؟ کدام روش ترین سریع ها نوشته سایر روی انتخابی متن شده اعمال های فرمت اعمال برای-1097

 متن کردن کپی -الف

 نوشته کردن Duplicate -ب

 از استفاده -ج Painter Format 

Copy formatting -د

 شود؟ می استفاده ای گزینه چه از ویژه کاراکتر یک درج برای-1098

 Style گزینه view سربرگ -الف

 clipart گزینه Insert سربرگ -ب

 object گزینه Insert سربرگ -ج

 سربرگ -د Insert گزینه Symbol

 است؟ کدام redo فرمان میانبر کلید-1099

 Alt + D -د Ctrl + Y -جCtrl + s   -ب Ctrl +z -الف

 است؟ گزینه کدام copy میانبر کلید-1100

Ctrl + c -دAlt + c   -ج Ctrl + x -ب Ctrl + A -الف

 اسناد و مجالت کتاب، رایشوی و نوشتن برای بیشتر که بوده Office بسته افزارهای نرم جمله از-............... 1101

 .شود می استفاده آن از.... و

 Excel -الف

 ب- Word 

 Access -ج

PowerPoint -د

 شود؟ می استفاده گزینه کدام از چاپ از قبل سند نمایش پیش برای-1102

 Quick Print -الف

 Print -ب

 ج- Print Preview 

Print Page -د

 .است...............  ترکیبی کلیدهای از استفاده Word در سند یک ایجاد برای شیوه ترین آسان-1103

 Ctrl + M -الف

 Alt + N -ب

 Ctrl + O -ج

 د- Ctrl + N

 گویند؟ می چه شوند می استفاده الگو عنوان به که شده ویرایش قبل از و آماده سندهای به-1104

 Pattern -الف

 ب- Template 

 Recent -ج

Blank -د

 .است......  ترکیبی کلیدهای از استفاده Word در سند یک کردن باز برای شیوه ترین آسان-1105

Ctrl+ R -د Ctrl + O -جAlt +N   -ب Ctrl + N -الف

 شود؟ می استفاده کلیدهایی چه از سند ذخیره برای-1106

Ctrl +s -دCtrl +w   -ج Ctrl + c -ب Ctrl +x -الف

 شود؟ می استفاده گزینه کدام از ها سند مدیریت برای-1107

 INSERT -الف

 PAGE LAYOUT -ب

 ج- FILE 

DESIGN -د



 

 

 چیست؟ Word در File بخش کاربرد-1108

 نمودار و اشیا درج -الف

 متن و پاراگراف مدیریت -ب

 چاپ از قبل سند بازبینی -ج

 سند مدیریت -د

 .نیست اجرا قابل Word افزار نرم با و آورد می در تغییر قابل غیر صورت به را فایل..........  فرمت-1109

 الف- PDF ب- DOCM ج- DOC د- DOCX

 نیدک تعیین را نامی آن برای و داده سازی ذخیره آدرس خود سند به تا باشید داشته نیاز شما که زمانی-1110

 ؟کنید استفاده گزینه کدام از است بهتر

 الف- Save As ب- Save ج- Export د- Share

 کنی ؟ می استفاده Browse ای محاوره کادر از زمانی چه-1111

 سند در جدول ویرایش -الف

 جدید سند ایجاد -ب

 سند جستجوي -ج

 سند بازبینی -د

  ؟کنی می عمل چگونه سریع دسترسی با ابزار نوار به دستور یا ابزار کردن اضافه برای-1112

 Option> Customize Ribbon -الف

 گزینه انتخاب و ریبون روي راست کلیک -ب Toolbar Access Quick Customize 

 Option> Advanced> Editing Option -ج

 Window گروه View زبانه -د

 کنی ؟ می استفاده گزینه کدام از( Toolbar Access Quick( ابزار نوار ویرایش برای-1113

 Option> Add-in -الف

 Option > Customize Ribbon -ب

 ج- Option> Quick Access Toolbar 

Option>Edit>Toolbar -د

 .کنی  چاپ را خود سند توانی  می...................  از استفاده با-1114

 الف- Print ب- Save ج- Info د- Open

 کنی ؟ می استفاده شود چاپ خواهی  می که سندهایی تعداد انتخاب برای ای گزینه چه از-1115

 Print all page -الف

 Quick print -ب

 Number of pages -ج

 د- Copies

 کنی ؟ انتخاب را گزینه کدام باید سند در جاری صفحه چاپ برای-1116

 Print Selection -الف

 ب- Print Current Page 

 Print First Page -ج

Print All pages -د

 است؟ کدام گزینه بهترین سند صفحات تمام چاپ برای-1117

 Print Current Page -الف

 ب- Print Pages 

 Print Selection -ج

Print All pages -د

 کنی ؟ چاپ سفارشی صورت به را نظر مورد صفحات توانی  می گزینه کدام از استفاده با-1118

 Pages -الف

 Print Current pages -ب

 ج- Custom Print 

 ...Print from ... to -د



 

 

 کنی ؟ می استفاده مورد کدام از شده انتخاب متن چاپ برای-1119

 Print Selected Text -لفا

 Print Section -ب

 Print Current text -ج

 د- Print Selection

 

 بگذارید؟ اشتراک به اینترنت در را خود سند توانید می File منوی از دستور کدام از استفاده با-1120

Share -دPrint   -ج Publish -ب Export -الف

 چیست؟ Export گزینه کاربرد-1121

 ها فرمت دیگر در سند انتشار -الف 

 سند انتشار -ب

 سند نمایش پیش -ج

خاص فرمت با سند کردن وارد -د

 است؟ کدام سند بستن برای میانبر کلید-1122

Alt + W -د Alt+F4 -ج Ctrl +W -بCtrl + C   -الف

 شود؟ می استفاده دستوری چه از سند بستن برای-1123

 Exit -الف

 Eject -ب

 ج- Close 

Close Document -د

 کنی ؟ می عمل چگونه Office در خود کاربری حساب به شدن وارد برای-1124

 File > New> Account -الف

 File > Open> Account -ب

 ج- File> Account 

File > Option> Account -د

 کنید؟ می استفاده دکمه کدام از Office در خود کاربری حساب به واردشدن برای-1125

Sign at -د Sign Out -ج Sign In -بSign Up   -الف

 .کنی  می استفاده File منوی در............  گزینه از افزار نرم کردن سفارشی و تنظیمات تغییر برای-1126

 Account -الف

 Info -ب

 Customize Word -ج

 د- Options

 کنی ؟ می اقدام زبانه کدام از Word در آماده تمهای از استفاده و سند ظاهری شکل تغییر برای-1127

 INSERT -الف

 HOME -ب

 ج- DESIGN 

LAYOUT -د

 چیست؟( Template( الگو مزیت-1128

 نیست تغییر قابل -الف

 اجراست قابل Word 2013 در فقط -ب

 ویرایش زمان در جویی صرفه -ج 

 است اشیا و جدول داراي -د

 دهی ؟ انتقال دیگر جای به و زده برش را انتخابی متن توانی  می دستور کدام توسط-1129

 الف- Cut 

 Paste -ب

 Copy -ج

Format Painter -د

 کنی ؟ می استفاده گزینه کدام از دهی  انتقال دیگر های متن به را متن یک فرمت بخواهی  گاه هر-1130

 Copy Format -ب Cut -الف



 

 

 ج- Format Painter د- Paste Format

 شود؟ می استفاده دستوری چه از سند روی زمینه پس رنگ اعمال برای-1131

 Watermark -الف

 ب- Page Color 

 Page Border Color -ج

 Background Color -د

 رود؟ می کار به دستور کدام است شده زده برش یا کپی و انتخاب قبل از که متنی چسباندن برای-1132

 الف- Paste 

 Clipboard -ب

 Replace -ج

Find -د

 کنی ؟ می اجرا را دستوری چه ستونی چند های نوشته ایجاد برای-1133

 Multi Columns -الف

 ب- Page Layout > Columns 

 Page Layout >Line Numbers -ج

Page Layout > Margins -د

 باید را مورد کدام Columnsای محاوره کادر در دستی صورت به ها ستون تعداد کردن مشخص برای-1134

 دهی ؟ تغییر

 Preset -الف

 Width and Spacing -ب

 ج- Number of columns 

Apply to -د

 کنی ؟ می انتخاب را Columns ای محاوره کادر از گزینه کدام ها ستون بین خط دادن قرار برای-1135

 Line spacing -الف

 ب- Line between 

 Line in middle -ج

Line in right -د

 چیست؟ Case Change گزینه کاربرد-1136

 کلید صفحه زبان تغییر -الف

 سند حاشیه روي تغییرات اعمال -ب

 بالعکس و کوچک به بزرگ از التین حروف تغییر -ج 

التین هاي نوشته فرمت تغییر -د

 کنی ؟ می استفاده منظور چه به Font دستور از-1137

 متن بزرگی یا کوچک تغییر -الف

 جمله فرمت تغییر -ب

 نوشته فرمت حذف -ج

 قلم نوع تعیین براي -د

 رود؟ می کار به گزینه کدام نوشته اندازه کردن بزرگ برای-1138

 Change Font size -الف

 Font -ب

 ج- Increase Font Size 

Decrease Font size -د

 کنی ؟ می کلیک دستور کدام روی کنی  ک  را متن اندازه اینکه برای-1139

 الف- Decrease Font size 

 Small Font -ب

 Increase Font size -ج

Change Font size -د

 ار گزینه کدام باید شود، نوشته لتینلا بزرگ حرو  با جمله هر کلمه اول حر  بخواهی  اینکه برای-1140

 رگزینی ؟ب



 

 

 Uppercase-الف

 Lowercase -ب

 Capitalize Each word -ج

 د- Sentence case

 است؟ مناسب گزینه کدام باشند بزرگ انگلیسی حرو  تمام بخواهی  اگر-1141

 Lowercase -الف

 Sentence case -ب

 Toggle case -ج

 د- Uppercase

 کنی ؟ می استفاده Case Change دستور کدام از انگلیسی کوچک حرو  نوشتن برای-1142

 الف- Lowercase 

 Uppercase -ب

 Capitalize each word -ج

Sentence case -د

 کنی ؟ می انتخاب را گزینه کدام باشد، کوچک انگلیسی کلمه هر از حر  اولین بخواهی  اگر-1143

 Sentence Case -الف

 Capitalize Each Word -ب

 ج- Toggle case 

Lowercase -د

 کنی ؟ فعال را گزینه کدام باید نوشته کردن برجسته برای-1144

 Underline -الف

 Italic -ب

 Strikethrough -ج

 د- Bold

 . شود می استفاده متن...................  برای Underline گزینه از-1145

 کردن دار زیرخط -الف 

 کردن مورب -ب

 کردن توپر -ج

کردن دار جلوه -د

 کنی ؟ می استفاده گزینه کدام از متن کردن مورب برای-1146

 Bold -الف

 ب- Italic 

 Underline -ج

Effect -د

 چیست؟ Italic سبک کاربرد-1147

 نوشته کردن توپر -الف

 نوشته کردن دار خط زیر -ب

 نوشته کردن مورب -ج 

نوشته روي خط ایجاد -د

 کنی ؟ می استفاده ای گزینه چه از عدد یک توان نوشتن برای-1148

 الف- Superscript 

 Subscript -ب

 Strikethrough -ج

Bold -د

 است؟ مناسب ای گزینه چه) زیرنویس(اندیسگذاری برای-1149

 Superscript-الف

 ب- Subscript 

 Strikethrough -ج

Bold -د

 برگزینی ؟ را دستور کدام است بهتر متن به دادن جلوه برای-1150

 Text Style -الف

 Text option -ب

 ج- Text Effects 

Font -د

 :دهی  تغییر را متن رنگ توانی  می دستور این با-1151



 

 

 Highlighter -الف

 Color -ب

 Typography -ج

 د- Font Color

 شود؟ می استفاده گزینه کدام از نوشته زمینه کردن رنگ برای-1152

 Font color -الف

 Fore color -ب

 ج- Highlight 

Line color -د

 است؟ تر مناسب دستور کدام چندسطحی فهرست ایجاد برای-1153

 Bullets -الف

 Numbering -ب

 ج- Multilevel List 

Table of content -د

 Bullets ایجاد برای گزینه کدام از نکردی  پیدا کشویی لیست در را خود نظر مورد Bullets که زمانی-1154

 ؟کنی  می استفاده جدید

 Define new number format -الف

 Define new multilevel list -ب

 Change list level -ج

 د- Define new bullet

 است؟ کدام Word در فهرست ایجاد ابزار-1155

 Multilevel list -الف

 ب- Table of Contents 

 Number list -ج

List of content -د

 کند؟ می چین وسط را متن Alignment دستورات از کدامیک-1156

 الف- Center ب- Right ج- Left د- Justify

 کنی ؟ استفاده Alignment گزینه کدام از باید فارسی متون نوشتن برای-1157

Justify -د Left -ج Right -بCenter   -الف

 است؟ مناسب دستور کدام راست سمت از متن ترازبندی برای-1158

 الف- Align right 

 Alignment -ب

 Right -ج

Indent to right -د

 .دارد کاربرد متن ترازبندی برای..........................  گزینه-1159

 Indentation -الف

 ب- Justify 

 Line spacing -ج

Direction -د

 دارد؟ کاربرد متن کردن منظ  برای Alignment دستورات از یک کدام-1160

Justify -دMargins   -ج Right -ب Center -الف

 کنی ؟ اجرا را دستوری چه باید حاشیه از پاراگرا  فاصله کردن ک  برای-1161

 Left indention -الف

 Increase indent -ب

 ج- Decrease indent 

High indention -د

 رود؟ می کار به منظوری چه به indent Increase گزینه-1162

 حاشیه از پاراگراف فاصله کردن کم -الف

 حاشیه از پاراگراف فاصله کردن زیاد -ب 

 حاشیه افزایش براي -ج

 حاشیه کاهش براي -د



 

 

 کند؟ می تغییر دستور کدام با نوشته جهت-1163

 الف- Direction 

 Indentation -ب

 Alignment -ج

 sort -د

 رود؟ می کار به فارسی متون نوشتن برای گزینه کدام-1164

 Left to right text direction -الف

 ب- Right to left text direction 

 Right indention -ج

 Left indention -د

 کند؟ می تعیین را خطوط بین فاصله دستور کدام-1165

 Text spacing -الف

 Paragraph spacing -ب

 Character spacing -ج

 د- Line and paragraph spacing

  دارد؟چه کاربردی  Line and Paragraph Spacing ابزار-1166

 پاراگراف و خطوط ترازبندي -الف

 پاراگراف و خطوط تورفتگی -ب

 پاراگراف و خطوط فاصله تنظیم -ج 

پاراگراف و جدید خطوط ایجاد -د

 کنید؟ می استفاده Border ابزار از زمانی چه-1167

 شود می استفاده برگه حاشیه تنظیم براي -الف

 شود می استفاده جدول حاشیه تغییر براي -ب

 شود می استفاده جدول و متن دور کادر ایجاد براي -ج 

 .شود می استفاده نوشته سبک انتخاب براي -د

1168-Shading رود می کار به................  برای. 

 پاراگراف و خط فاصله تنظیم -الف

 کادر و حاشیه ایجاد -ب

 متون سازي مرتب -ج

 کادر داخل زمینه طرح و رنگ تعیین -د

 شود؟ می استفاده دستور کدام از متن قالببندی و تغییرات حذ  برای-1169

 Remove formatting -الف

 ب- Clear formatting 

 Delete formatting -ج

Change formatting -د

 نمود؟ ایجاد سفارشی و جدید سبک میتوان گزینه کدام از استفاده با-1170

 الف- Create a new style 

 Define New Style -ب

 Apply Style -ج

Save As New Style Set.. -د

1171-Styles Apply دهد؟ می انجام کاری چه 

 کند می ایجاد جدید سبک -الف

 کند می حذف را قبل سبک -ب

 کنیم اعمال را موجود هاي سبک توانیم می و کند می ایجاد جدید سبک -ج 

 کند می ویرایش را موجود هاي سبک -د

 دهی ؟ تغییر را tab نوع توانی  می روشی چه به-1172

 کش خط روي کردن کلیک با -الف



 

 

 tab change گزینه انتخاب view سربرگ از -ب

 tab of types گزینه انتخاب view سربرگ از -ج

 به مربوط مربع روي کلیک با -د tab کش خط چپ سمت در ها 

 دهی ؟ انجام را عملی چه باید ها tab از کدام هر اجرای برای-1173

 کنیم می کلیک افقی کش خط در دلخواه مکان در -الف 

 کش خط کردن درگ با -ب

 فشاریم می را lock caps دکمه کردن تایپ حین در صفحه روي -ج

 bar scroll دکمه فشردن با -د

 شود؟ می استفاده انگلیسی حرو  نوشتن برای tab کدام-1174

 Right Tab -الف

 ب- Left Tab 

 Center Tab -ج

Decimal Tab -د

 رود؟ می کار به کردن چین وسط برای تب کدام-1175

 Right Tab -الف 

 Bar Tab -ب

 ج- Center Tab 

 Decimal Tab -د

1176-Tab Center ؟ شود می گفته تبی نوع چه به 

 اعشاري تب -الف

 راست تب -ب

 وسط تب -ج 

بار تب -د

 گزینی ؟ می بر را گزینه کدام تب ایجاد محل در پاراگرا  اول خط تورفتگی ایجاد برای-1177

 Hanging Indent -الف

 ب- First Line Indent 

 First Line Tab -ج

Decimal Tab -د

 کنی ؟ می انتخاب را تب کدام راستا یک در عدد اعشار دادن قرار و اعشاری اعداد کردن چین وسط برای-1178

 Center Tab -الف

 ب- Decimal Tab 

 Bar Tab -ج

 Right Tab -د

1179-Tab Bar دهد؟ می انجام کاری چه 

 تب ایجاد محل در پاراگراف اول خط تورفتگی ایجاد -الف

 تب ایجاد محل در خط یک دادن قرار -ب 

 راست سمت از افقی کش خط در تب ایجاد -ج

 راستا یک در اعداد اعشار دادن قرار -د

  چیست؟ Decimal Tabکاربرد -1180

 راست تب ایجاد -الف

 وسط تب ایجاد -ب

 چپ تب ایجاد -ج

 اعشاري تب ایجاد -د

1181- First Line Indent  دارد؟چه کاربردی  

 .رود می کار به اعشاري اعداد کردن چین وسط براي -الف



 

 

 .رود می کار به پاراگراف کل تورفتگی ایجاد براي -ب

 رود می کار به پاراگراف اول خط تورفتگی ایجاد براي -ج 

 . رود می کار به خطوط بین فاصله ایجاد براي -د

 کنی ؟ می استفاده پاراگرا  و خطوط بین فاصله تغییر برای گزینه کدام از-1182

 Special character -الف

 ب- Line and paragraph spacing 

 Line and paragraph indent -ج

 Each character Spacing -د

 است؟ کدام Find میانبر کلید-1183

Ctrl + F -دCtrl + R   -ج Ctrl +j -ب F3 -الف

 کنی ؟ پیدا فایل متن در را نظر مورد اصطالح و لغت توان می گزینه کدام توسط-1184

 الف- Find ب- Replace ج- Search د- Google

 رود؟ می کار به فعلی متن با جدید متن یک کردن جایگزین برای دستور کدام-1185

 الف- Replace 

 Find -ب

 Object -ج

Search -د

 ینیجایگز برای را آن ورد خواهی  می که را عبارتیReplace and Find پنجره از..............  قسمت در-1186

 .مینویسی  ،)کند پیدا(کند انتخاب

 Replace With -الف

 Find With -ب

 ج- Find What 

Search word -د

 مینویسی ؟ چه What Find کشویی منوی در-1187

 شدن جایگزین براي جدید متن -الف

 کنیم جستجو خواهیم می که متنی -ب 

 کنیم توپر خواهیم می که را متنی -ج

کنیم پاک را آن فرمت خواهیم می که متنی -د

 کنی ؟ درج شود، جایگزین قبلی کلمه با خواهی  می که را جدیدی عبارت یا کلمه باید کادر کدام در-1188

 Search Box -الف

 Find What -ب

 ج- Replace With 

 Replace All -د

 جایگزین را شده انتخاب کلمات تمام توانید می Replace and Find کادر در دکمه کدام از استفاده با-1189

 کنید؟

 More -الف

 ب- Replace All 

 Replace -ج

Find what -د

 شود؟ می استفاده گزینه کدام از Replace And Find کادر در بعدی کلمه یافتن برای-1190



 

 

 Find Previous -الف

 Replace -ب

 Find what -ج

 د- Find next

 می کلیک دکمه کدام روی کنی  جایگزین یک به یک صورت به را یافتهشده کلمات بخواهی  اینکه برای-1191

 کنی ؟

 Replace All -الف

 Single Replace -ب

 Find Next -ج

 د- Replace

 کنید؟ می انتخاب را سربرگ کدام کش خط نمایش برای-1192

 Reference -الف

 ب- View 

 Layout -ج

Insert -د

 کنید؟ می فعال را View سربرگ از ابزار کدام کش خط برای-1193

 Gridline -الف

 Eraser -ب

 ج- Ruler 

Wrap -د

 دهی ؟ می تغییر را صفحه اندازه دستور کدام توسط-1194

 Width -الف

 Paper -ب

 Page Layout -ج

 د- Size

 دهی ؟ می تغییر را گزینه کدام صفحه ارتفاع تغییر برای-1195

Paper -د Height -جWeight   -ب Width -الف

 دارد؟ کاربردی چه Paper سربرگ در Width گزینه-1196

 دهد می تغییر را صفحه ارتفاع -الف

 کند می تعیین را صفحه عرض -ب 

 کند می تعیین را صفحه کل اندازه -ج

.کند می تعیین را حاشیه اندازه -د

 کند؟ می تعیین را صفحه جهت Layout Page سربرگ در دستور کدام-1197

 الف- Orientation 

 Margins -ب

 Size -ج

Columns -د

 شود؟ می استفاده قل  سایز کاهش برای ترکیبی کلید کدام-1198

] +Ctrl -د [ +Ctrl -جCrtl+ (   -ب ( +Ctrl -الف

  شود می موجب Font از گزینه کدام( x+5( انتخاب از پس نمایی ، تایپ را( x+5 ^)2 عبارت میخواهی -1199

 شود؟ تایپ درستی به عبارت تا

 Strikethrough -الف

 ب- Superscript 

 Subscript -ج

Engrave -د

 است؟ پذیر امکان گزینه کدام توسط دیگر پاراگرا  چند یا یک به پاراگرا  یک بندی قالب کردن کپی- 1200

 الف- Format Painter 

 Position -ب

 Effect -ج

Paragraph -د

 است؟ کدام to Go ترکیبی کلید-1201



 

 

 Alt + G -د Alt +C -ج Ctrl + G -بCtrl +C   -الف

 کنی ؟ می استفاده سربرگ کدام از پاراگرا ، ترازبندی برای-1202

 Insert -الف

 Font -ب

 ج- Page Layout 

Review -د

 کرد؟ استفاده توان می زیر گزینه کدام از ه  سر پشت بهصورت خط چند انتخاب برای-1203

 کلید- الفShift جهتی کلیدهاي با همراه 

 جهتی کلیدهاي با همراه Alt کلید -ب

 جهتی کلیدهاي با همراه Ctrl کلید -ج

خطوط انتخاب و Bar Scroll کلید -د

 شود؟ می استفاده کلید صفحه کلید کدام از پراکنده کلمات انتخاب برای-1204

Tab -د Shift -ج Ctrl -بAlt   -الف

 ببرید؟ نام کامپیوتررا اصلی های حافظه-1205

 CD-ROM - DVDROM -الف

 ب- ROM - RAM 

 EPROM - HARD DISK -ج

HARD DISK-RAM -د

 است؟ خروجی دستگاه یک مورد کدام-1206

 کلید صفحه- الف

 ماوس- ب

 اسکنر- ج

 چاپگر- د

 عهده بر را کار این وظیفه برنامه کدام,  کامپیوتر درک قابل زبان به فه  قابل غیر دستورات تبدیل برای-1207

 ؟ دارد

 عامل سیستم- الف

 ها مترجم- ب 

 کاربردي افزارهاي نرم- ج

کمکی افزارهاي نرم- د

 شود؟ می استفاده مورد کدام از پردازش حال در های داده موقت نگهداری برای-1208

CACHE-د REGISTER-جALU  -ب CU-الف

 است؟ کامپیوتری سیست  یک فیزیکی اجزای بیانگر زیر های گزینه از یک کدام-1209

 افزار سخت- الف )HARDWARE) 

 (FREEWARE( رایگان افزار م نر- ب

 (SOFTWARE(افزار نرم- ج

(WARECOURSE( ابزاراموزشی- د

 است؟ صحیح زیر های عبارت از یک کدام-1210

 است مگابایت یک کمتراز گیگابایت یک- الف

 است مگابایت کمترازیک بایت کیلو یک- ب. 

 است بیت کمترازیک بایت یک- ج

است گیگابایت ازیک کمتر ترابایت یک- د

 است؟ صحیح RAMمورد در عبارت کدام-1211

 کند می هاراحفظ شودداده می کامپیوترخاموش که هنگامی RAM-الف

 ب-RAM است نوشتنی خواندي حافظه یک. 

 است نوشتنی فقط حافظه RAM-ج

 داد افزایش توان نمی کامپیوتري هیچ در را RAM-د

 است؟ کدام زیر های گزینه بین در نظرابعاد از کامپیوتر ترین بزرگ-1212



 

 

 PC-الف

 MAINFRAME-ب

 LAPTOP-ج

 د- SUPER COMPUTER

 گیرد؟ می قرار کجا در اجرا منظور به برنامه یک-1213

 الف-RAM 

 ROM-ب

 HARD DISK -ج

CACHE MEMORY -د

 باشد؟ نمی شبکه انواع جزء زیر موارد از یک کدام-1214

 الف- GATE WAYS 

 WAN-ب

 MAN-ج

 LAN-د

 ؟ است شده تشکیل هایی قسمت چه از کامپیوتر سیست  یک-1215

 جانبی حافظه و افزار سخت- الف

 افزار میان و افزار نرم- ب

 افزار میان و افزار سخت- ج

 افزار میان و افزار نرم و افزار سخت- د 

 شود؟ می استقاده بزرگ تصاویر و ها نقشه چاپ برای مورد کدام از-1216

 پالترها- الف 

 پرینترها- ب

 فتوکپی دستگاههاي- ج

 تکثیر ماشینهاي- د

 شود؟ می نامیده سریع حافظه عنوان به CPU از واحد کدام-1217

 الف-CACHE 

 REGISTER-ب

 CU-ج

ALU-د

 باشد؟ نمی ورودی دستگاه گزینه کدام-1218

 الف-SPEAKER 

 MOUSE-ب

 LIGHT PEN -ج

SCANNER-د

 نیست؟ ضروری زیر گزینههای از یک کدام کامپیوتر در موزیک و صوت از استفاده برای-1219

 صدا کارت- الف

 مودم- ب 

 ویدئویی یا صوتی فایل- ج

 (SPEAKER( بلندگو- د

 دارد؟ نام چه کامپیوتری شبکه در مرکزی کامپیوتر-1220

 MICRO COMPUTER -الف

 SUPER COMPUTER -ب

 MINI COMPUTER -ج

 د- SERVER COMPUTER

 گویند؟ می چه ها سایت وب در اینترنت شبکه ازطریق فروش به-1221

 E-TEJARAT -الف

 ب- E-COMMERCE 

 E-TRAINING -ج

 E-BANKING -د

 :از است عبارت کامپیوتری ویروس-1222

 زا بیماري ویروس یک- الف

 کامپیوتر در موجود افزار سخت یک- ب

 مخرب کامپیوتري برنامه یک- ج 

کامپیوتر در موجود افزار نرم یک- د

 کرد؟ تایپ باید چگونه جستجو درکادر شود می خت  P به که حرفی 5 های فایل جستجوی برای-1223



 

 

???? p-دp  ????-ج p*-ب *p-الف

 .شود می مشخص درایو یک آزاد فضای عبارت، این مقابل در-1224

 CAPACITY-الف

 BACKUP NOW -ب

 ج- FREE SPACE 

 TYPE-د

 نمائی ؟ می انتخاب را گزینه کدام ها پوشه و ها فایل روی بر شده انجام عمل آخرین لغو برای-1225

 RESTORE-الف

 CLOSE-ب

 ج-UNDO 

REDO-د

 است؟ کدام متنی های فایل پسوند-1226

 الف-TXT ب-BMP ج-JPG د-RTF

 .شود می استفاده.........  های کلید ترکیب از پاسخ بدون برنامه یک بستن برای-1227

 الف- CTRL+ALT+DELET 

 SHIFT+CTRL+ALT -ب

 SHIFT+CTRL+A -ج

ALT+DELET+Y -د

 کنی ؟ می استفاده گزینه کدام از پنجره ی اندازه رساندن حداقل به برای-1228

 الف*MINIMIZE 

 MAXIMIZE*ب

 CLOSE-ج

 RESTORE DOWN -د

 شود؟ می کجا به آنها انتقال موجب ها پوشه و ها فایل حذ -1229

 COMPUTER-الف

 ب- RECYCLE BIN 

 روند می بین از- ج

 گیرند می قرار CLIPBORD موقت حافظه در- د

 کرد؟ استفاده نمیتوان گزینه کدام از ها پنجره بستن برای-1230

 . کنیم کلیک را CLOSE گزینه FILE منوي از- الف

 کنیم کلیک پنجره يبالا گوشه راست سمت ضربدر عالمت روي- ب

 . میکنیم استفاده F4+ ALT ترکیبی کلید از- ج

 ترکیبی کلید از- د TAB+ ALT میکنیم استفاده . 

 گویند؟ می چه است شده فشرده آن چپ سمت دکمه حالیکه در ماوس دادن حرکت عمل به-1231

 الف-DRAG 

 CLICK-ب

 DOUBLE CLICK -ج

 DROP-د

 گویند؟ می چه ها پنجره یبالا رنگی نوار به-1232

وضعیت نوار- د عنوان نوار- ج  منو نوار- ب آدرس نوار- الف

 .اینترنت در هرسایت فرد به منحصر نشانی از است عبارت-................... 1233

 DOMAIN-الف

 ADDRESS SITE -ب

 ج-URL 

HTTPS-د



 

 

 باشد؟ موتورجستجوگرمی یک زیر گزینه کدام-1234

 TVTO-دASK  -ج GOOGLE-ب YAHOO-الف

 باشد؟ می شده دریافت های پیام برگیرنده در پوشه کدام-1235

 الف-INBOX 

 DRAFT-ب

 OUTBOX-ج

 SENTITEM-د

 اند؟ شده بندی طبقه موضوعی نظر از سایتها آن در که هستند هایی سایت-1236

 طبیعی زبان جستجوي موتور- الف

 جستجو موتورهاي- ب

 جستجو فرا موتورهاي- ج

 فهرست سایتهاي وب- د

 ؟ است کدام اینترنت تاریخچه-1237

 BACK-الف

 ب-HISTORY 

 FAVORITES-ج

FORWARD-د

 کرد؟ استفاده توان می را علمگرد کدام ها عبارت جستجوی در+  عالمت جای به-1238

XOR-د NOT-ج AND-بOR  -الف

 است؟ کدام دولتی موسسات به مربوط های سایت پسوند-1239

MIL-د GOV-جEDU  -ب COM-الف

 باشد؟ می شده حذ  های پیام برگیرنده در پوشه کدام-1240

TRASH-دOUTBOX  -ج DRAFT-ب INBOX-الف

 ؟ دهی  انجام باید عملی چه وب صفحات متن اندازه تغییر برای-1241

  الف- IE/VIEW / TEXT SIZE 

 IE/ VIEW / STATUS BAR -ب

 IE/VIEW /EXPLORER BAR -ج

IE/ VIEW / TOOL BAR -د

 است؟ وب صفحات مرورگر زیر افزارهای نرم از یک کدام-1242

 INTERNET EXPLORER -الف

 MOZILA FIREFOX -ب

 WINDOWS EXPLORER -ج

 د- INTERNET EXPLORER - MOZILA FIREFOX 

 کنی ؟ می استفاده گزینه کدام از جدول های خانه ادغام برای-1243

 SPILT CELLS -الف

 ب- MERGE CELLS 

 TABLE SPILT -ج

MERGE TABLE -د

 است؟ مناسب ترکیبی کلید کدام واحد یک میزان به قل  اندازه کاهش برای-1244

CTRL[+دSHIFT-  ]+ج -SHIFT[+ب -CTRL]+الف

 است؟ افزاری نرم نوع چه WORD افزار نرم-1245

 است گرافیکی افزار نرم یک- الف

 است آماري افزار نرم یک- ب

 است پرداز واژه افزار نرم یک- ج 

 است گستر صفحه افزار نرم یک- د



 

 

 است؟ صحیح WORD افزار نرم در جدید سند ایجاد برای زیر های گزینه از یک کدام-1246

 SAVE AS -د SAVE`- ج NEW-بOPEN  -الف

 شود؟ می استفاده گزینه کدام از خطوط بین فاصله تنظی  برای-1247

 LINE COLOR -الف

 LINE STYLE -ب

 ج- LINE SPACING 

 BORDER-د

 کنی ؟ می استفاده گزینه کدام از شوند تراز پاراگرا  خطوط انتهای بخواهی  اگر-1248

 الف-JUSTIFY 

 CENTER-ب

 ALIGN LEFT -ج

ALIGN RIGHT -د

 شود؟ می استفاده ای گزینه چه از هندسی اشکال درج برای-1249

 الف-SHAPES 

 PICTURE-ب

 SMART ART -ج

 CHART-د

 شود؟ می استفاده گزینه کدام از افقی به عمودی حالت از سند تغییر برای-1250

 PORTRAIT-الف

 PORTRAIT FLEEPED -ب

 ج-LANDSCAPE 

LANDSVCAPE FLEEPED -د

 شود؟ می استفاده خانه چند به جدول خانه یک تقسی  برای فرمان کدام از-1251

 INSERT سربرگ از SPLIT گزینه- الف

 گزینه- ب CELLS SPLIT سربرگ از LAYOUT 

 INSERT سربرگ از MERGE گزینه- ج

 LAYOUT وابسته سربرگ از MERGE گزینه- د

 است؟ کدام الگو صورت به شده ایجاد سند ی ذخیره پسوند-1252

XPS-د DOCX-ج DOTX-بPDF  الف

 است؟ مناسب ابزار کدام گذاری عالمت ایجادلیست جهت-1253

 الف-BULLETS 

 NUMBERING-ب

 TABLE-ج

SYMBOL-د

 است؟ کدام REDO ترکیبی کلید معادل-1254

 CTRL+B -الف

 ب- CTRL+Y 

 CTRL+Z -ج

 CTRL+SHIFT+Z -د

 کند؟ می شمارش را ها سلول از ناحیه یک در موجود اعداد تابع کدام-1255

 LEN-د COUNTA-ج COUNT-بROUND  -الف

 کدام است؟  A4در   SUM(A1;A3 ) =حاصل فرمولA1=10 , A2=20, A3=30 بافرض  -1156

30- د 40- ج  60- ب 50- الف

 گیرد؟ قرار سطر چند در شدن طوالنی صورت در سلول در شده نوشته متن که شود می باعث چیز چه-1257

 MERGE CELLS -ب STRIKE-الف



 

 

 WRAP TEXT -د SHRINK TO FIT  -ج

 ندارد؟ را آن محتویات نمایش قابلیت سلول پهنای دهدکه می نشان خطای کدام-1258

#NAME - د #####- جDIV#   - ب #VALUE-الف

 پول رایج قالب با فرمت اعمال باعث CELLS FORMAT پنجره در زیرواقع های گزینه از یک کدام-1259

 شود؟ می

 SPECIAL-الف

 ب-CURRENCY 

 TEXT-ج

FRACTION-د

 رود؟ می بکار عدد چند مجموع محاسبه برای تابع کدام-1260

 الف-SUM ب-COUNT ج-AVERAGE د-COUNTIF

 شود؟ می استفاده عالمتی چه از مطلق دهی آدرس جهت-1261

&- د #- ج $- ب  ؟- الف

 دهد؟ می انجام عملی چه cells format پنجره از fill گزینه-1262

 نظر مورد باواژه خانه یک پرکردن- الف 

 سلول زمینه رنگ تغییر- ب

 سلول داخل سازي فشرده- ج

 سلول داخل اطلاعات ترازبندي- د

 دارد؟ کاربرد متنی قالب نمایش زیربرای ی داده نوع کدام-1263

 CURRENCY-الف

 NUMBER-ب

 TEXT-ج

 د-GENERAL 

 است؟ کدام نمودار ساخت میانبر-1264

 F11-دF10  -ج F2-ب F1-الف

1265- CHART چیست؟  

 است تابع یک- الف

 شود می استفاده موجود اطلاعات و ها داده ، ارقام مقایسه براي که است نموداري- ب. 

 .است سازمانی نمودار یک- ج

 .شود می استفاده گرافیکی تصاویر درج براي- د

 D=2^3*2+2/4 است؟ عددی چه اکسل در روبرو فرمول از حاصل نتیجه-1266

 18- د  10- ج 66- ب 144- الف

 باشد؟ EXCEL کاربرگ های خانه از خانه یک نام تواند می زیر موارد از یک کدام-1267

 A1-دAZ2  -جZA  -ب AZ 2 -الف

 است؟ کدام K6 سلول مطلق آدرس-1268

 الف- $ K$ 6 ب- K$6$ ج-K6$ د -$K6 



 

 

 .نامند می........................ یک را اکسل در اطلاعات نگهداری واحد هر-1269

 ب سلول-الف-ROW ج-COLUMN د-LINE 

 HOME سربرگ از را مورد کدام صعودی صورت به و الفبا حرو  اساس بر رکوردها کردن مرتب برای-1270

 نمود؟ انتخاب باید SORTگزینه

 لفا- SORT A TO Z 

 SORT Z TO A -ب

 COUSTOM SORT -ج

DESCENDING-د

 شود؟ می نامیده چه موجودیت یا موضوع یک به مربوط اطلاعات ترین جزیی-1271

 فیلد- الف 

 رکورد- ب

 جدول- ج

 یاطلاعات بانک- د

 شود؟ می معرفی نوعی ازچه تولد تاریخ فیلد-1272

 TEXT-الف

 MEMO-ب

 ج- DATE & TIME 

 YES/NO -د

 کرد؟ تهیه گزارش یک توان می گزینه کدام از استفاده با--1273

 form-الف

 Data base -ب

 ج-REPORT 

MACRO-د

 است؟ چقدر NO/YES داده نوع اندازه-1274

 بایت یک- الف

 بایت مگا یک- ب

 بایت 8- ج

 بیت یک- د

 شود؟ می استفاده اعداد برای زیر داده نوع کدام-1275

 TEXT-الف

 MEMO-ب

 ج-NUMBER 

CAPTION-د

 است؟ چندجدول دارای حداقل داده هرپایگاه-1276

2- د 0- ج 1- ب  3- الف

 کنی ؟ می استفاده سربرگ ازکدام مختلف های روش از جداول ساخت جهت-1277

 HOME-الف

 ب-CREATE 

 DESIGN-ج

 DATABASE TOOLS -د

 است؟ دستی بصورت فرم ایجاد روش ، گزینه کدام-1278

 FORM WIZARD -الف

 ب- FORM DESIGN 

 SPLIT FORM -ج

MULTIPLE FORM -د

 

 بانک در شده ذخیره های داده از ای مجموعه استخراج برای یاطلاعات بانک اجزای از یک کدام از-1279

 شود؟ می استفاده یاطلاعات

 الف-Query ب-TABLE ج-FORM د-MACRO



 

 

 کرد؟ بررسی توان می خصوصیت کدام با را جدول به ورودی اطلاعات صحت-1280

 CAPTION-الف

 ب- VALIDATION RULE 

 INDEX-ج

 DEFAULT VALUE -د

 استفاده گزینه کدام از QUERY نتیجه در فیلد یک نمایش عدم یا نمایش برایQUERY طراحی در-1281

 کنی ؟ می

SHOW-دCRITERIA  -ج FILED-ب TABLE-الف

 کنی ؟ می استفاده خاصیتی کدام از فیلد نام تعیین برای-1282

 NAME-الف

 ب-CAPTION 

 FORMAT-ج

 FIELD SIZE -د

 ؟ است مناسب سن ستون برای عددی فیلد کدام-1283

 الف-BYTE ب-SINGLE ج-DECIMAL د-INTEGER

 شود؟ می استفاده ای گزینه چه از ها داده نوع تعیین برای-1284

 DATA NAME -الف

 ب- DATA TYPE 

 DATA SHEET -ج

FORMAT DATA -د

 

 شود؟ می هااستفادهاسلاید وطراحی ایجاد برای نما کدام-1285

 الف-NORMAL 

 SLIDE SORTER -ب

 NOTE PAGE -ج

SLIDE SHOW -د

 است؟ پوینت پاور افزار نرم معر  گزینه کدام-1286

 . است گرافیکی افزار نرم یک- الف

 است مطلب ارائه افزار نرم یک- ب 

 است اماري افزار نرم یک- ج

 .است گسترده صفحه افزار نرم یک- د

 شود؟ می استفاده نما کدام از نمایش نهایی ارائه برای-1287

 NOTE PAGE -الف

 ب- SLID SHOW 

 SLIDE SORTER -ج

 NORMAL-د

 می انجاماسلاید ازکدام نمایشی برنامه اجرای SLIDE CURRENT FROM گزینه از استفاده با-1288

 شود؟

 اول اسلاید- الف

 میانی اسلاید- ب

 آخراسلاید- ج

 جاري اسلاید- د 

 کند؟ می تبدیل دایره به را شکل دکمه کدام فشردن بیضی رس  هنگام در-1289



 

 

SHIFT-دDELETE  -ج ALT-ب CTRL-الف

 .شود می استفاده.................  گزینه از اسلاید یک کردن مخفی برای-1290

 الف- HIDE SLIDE 

 HIDE SHOW -ب

 GO TO SLIDE -ج

POINTER OPTION -د

 .یی گو می......................  دیگر سرور به شخصی کامپیوتر از اطلاعات انتقال به-1291

 linkHyper -الف

 ب- Upload 

 Worm -ج

 Download -د

 است؟ سایت چند ویژه همواره URL آدرس-1292

 2 -د 3 -ج 5 -ب 1 -الف 

 .گویند می......................  ویندوز، در تصویری نمادهای به-1293

 Desktop -الف

 ب- Icon 

 Start Menu -ج

Pointer -د

 دارد؟ نام چه فایل انتقال پروتکل-1426

 الف- Ftp ب- Https ج- Http د- Isp 

 .شود می نامیده...................  دارد قرار نمایش صفحه پایین در که سراسری نوار-1427

 Pointer -الف

 ب- Taskbar 

 Status bar -ج

 Desktop -د

 شود؟ می استفاده لیزر اشعه از اطلاعات نوشتن و خواندن برای یک کدام در-1294

 Tape -الف

 Hard Disk -ب

 Floppy Disk -ج

 د- CD - ROM

 نمایی ؟ می استفاده جدید سند یک ایجاد برای میانبر کلید کدام از-1295

 CTRL+ V -الف

 CTRL+X -ب

 CTRL+O -ج

 د- CTRL+N

 . کنی  می استفاده..............................  از ها سایت شده روز اخباربه آخرین مشاهده برای-1296

 الف- RSS ب- HTTPS ج- Podcast د- XML 

 گیرد؟ می قرار استفاده مورد افزار سخت بکارگیری جهت که هستند دستورالعملهایی گزینه کدام-1297

 افزار سخت -الف

 افزار میان -ب 

 افزار نرم -ج

سیستم -د

 شود؟ می استفاده گزینه کدام از جدید نام با سند ذخیره برای-1298

 Save -الف

 ب- Save as 

 Save, ctrl+s -ج

 Ctrl+s -د



 

 

 .................... های کلید باید ابتدا شود، مشکل دچار سیست  کاربردی برنامه بایک کار هنگام که صورتی در-1299

 .شوی ) Manager Task) وظایف مدیرت بخش وارد تا بفشاری  را

 الف- Ctrl+Alt+Del 

 elete + CtrlD -ب

 Delete + Alt + Shift -ج

Ctrl + Delete + Shift -د

 است؟ کدام ریبون نوار سازی مخفی برای میانبر کلید-1300

 Alt+F4 -الف

 ب- Ctrl+F1 

 F1 -ج

 Alt+F -د

 است؟ غلط Disk Hard مورد در زیر موارد از یک کدام-1301

 .نمود بندي قالب مجددا توان می را شده) Format) بندي قالب یکبار که دیسکی -الف

 .شود می پاک موجود اطلاعات کلیه ، سخت دیسک بندي قالب دستور اجراي با -ب

 .نمود بندي قالب را آن باید حتما دیسک از استفاده از قبل -ج

 باشد می داخلی سخت دیسک مخصوص فقط بندي قالب عمل -د. 

 گویند؟ می چه اینترنت خدمات دهنده سرویس شرکت به-1302

 Hperlink -الف

 User Account -ب

 URL -ج

 د- ISP

 است؟ کدام)، Help)  از استفاده جهت میانبر کلید-1303

 F 3 -د F 7 -ج F 1 -بF2   -الف

 نمائی ؟ می استفاده Undo فرمان اجرای برای کلید صفحه های کلید کدام از-1304

 الف- CTRL+ Z ب- CTRL+ V ج- CTRL+ P د- CTRL+X 

 شود؟ می استفاده گزینه کدام از کامپیوتر کردن قفل برای-1305

 الف- Lock 

 Shut Down -ب

 Restore -ج

 Log Off -د

 کنی ؟ می استفاده کلید کدام از بعدی پاراگرا  به رفتن برای-1306

 Ctrl -د Alt -ج Enter -بShift   -الف

 ؟ دهد می نشان را آموزشی سایت وب یک پسوند کدام-1307

 Edu -دGov   -ج Com -ب Net -الف

 می نامیده چه دهند می نشان را ارز قیمت و هوا و آب مانند یاطلاعات ،که 7 ویندوز در کوچک ابزارهای-1308

 شوند؟

 Flip 3D -لفا

 Navigation -ب

 Touch -ج

 د- Gadgets 

 هستند؟ خروجی وسایل جزء زیر های ابزار از کدامیک-1309

 الف- Speaker 

 Microphone -ب

 Light Pen -ج

Scanner -د



 

 

 است؟ مناسب گزینه کدام مطالب، رئوس حالت در نما تغییر برای-1310

 Print layout -الف

 ب- Outline 

 Web layout -ج

 Read mod -د

 ....................................... ://httpتایپ  -1311

 .است الزامی تجاري غیر هاي سایت براي -الف

 .است الزامی تجاري هاي سایت براي -ب

 نیست الزامی -ج. 

 . است الزامی -د

 شود؟ می استفاده افزار سخت کدام از کامپیوتر به تصاویر کردن وارد برای-1312

 چاپگر -الف

 اسکنر -ب 

 پالتر -ج

گرافیک کارت -د

 نمائی ؟ می انتخاب را گزینه کدام ویندوز از کامل خروج برای-1313

 Log Off -الف

 Restore -ب

 ج- Shut Down 

Hibernate -د

 است؟ کدام ها واژه جستجوی فرمان اجرای مناسب گزینه-1314

Home -د Find -جReplace   -ب Edit -الف

 ؟ کنی  می استفاده گزینه کدام از وب صفحه یک مجدد بارگذاری برای-1315

 Stope -الف

 ب- Refresh 

 Back -ج

 Forward -د

 کنی ؟ می انتخاب را سند یک در موجود موضوعات تمام کلیدها کدام از استفاده با-1316

 CTRL+ V -الف

 ب- CTRL+ A 

 CTRL+ S -ج

 CTRL+ C -د

 ؟ شود نمی محسوب عامل سیست  زیر موارد از یک کدام-1317

 Windows -د Word -جUnix   -ب Linux -الف

 نمائی ؟ می استفاده گزینه کدام از جزئیات با ها پوشه و درایوها نمایش جهت-1318

Details -دList   -ج Tiles -ب Icons -الف

 شود؟ می استفاده کلید کدام از) Screen Full) صفحه تمام نمایش جهت IE مرورگر در-1319

 F9 -د F10 -ج F11 -بF12   -الف

 گردد؟ می سند ابتدای به نما مکان پرش سبب کلید کدام-1320

 Home -الف

 ب- End 

 CTRL+ Home -ج

 CTRL+ End -د

 نامند؟ می چه دارند عهده به را افزار سخت مدیریت که افزارهایی نرم-1321

 سودمند -د یاب ویروس -ج کاربردي -ب سیستمی -الف 

 نمائی ؟ می استفاده کلید کدام از مجاور غیر فایلهای انتخاب برای-1322



 

 

 Ctrl -دAlt   -ج Enter -ب Shift -الف

 ؟ دهد می نمایش خالی صفحه با را IE گزینه کدام-1323

 Use Empty -الف

 Use Default -ب

 Use Clear -ج

 د- Use Blank

 گردد؟ می استفاده آرایی صفحه برای نما کدام از-1324

 Outline -الف

 Web layout -ب

 Draft -ج

 د- Print layout 

 است؟ سیستمی افزار نرم گزینه کدام-1325

 عامل سیستم -الف 

 اینترنت -ب

 اکسل -ج

 ورد -د

 نیست؟ حافظه گیری اندازه واحدهای جزء کدامیک-1326

 کلمه -د بایت -ج سلول -ب  بیت -الف

 ؟ باشد می اینترنت و کاربر بین رابط گزینه کدام-1327

 شبکه -د ISP -جTTP   -ب IT -الف

 شود؟ می استفاده گزینه کدام از کلمه یک انتخاب برای-1328

 پاراگراف بر کلیک -الف

 crtl کلید از استفاده -ب

 کلمه بر کلیک -ج

 کلمه بر کلیک دابل -د 

 نماید؟ می ایجاد افزارها نرم برای را گرافیکی محیط یک گزینه کدام-1329

 Utility -الف

 المللی بین واسط -ب

 کاربره تک عامل سیستم -ج

 کاربر گرافیکی واسط -د GUI 

 .گردد می شناسائی.......................  از فایل یک هویت-1330

 ذخیره محل -الف

 فایل نام -ب 

 فایل پسوند -ج

فایل حجم -د

 است؟ کدام Refresh میانبر کلید-1331

 F11 -د F7 -ج F5 -ب F1  -الف

 است؟ کدامیک کپی عمل در موقت حافظه-1332

 Cells -الف

 Ram -ب

 Shortcut -ج

 د- Clipboard

 

 .گویند می...........................  سایت وب یک صفحه اولین به-1333

 First Page -الف

 ب- Home Page 

 Web Page -ج

Current Page -د

 شود؟ می استفاده ترکیبی کلید کدام از جمله یک انتخاب برای-1334



 

 

 Ctrl+ Home -الف

 Alt+End -ب

 ج- Ctrl+click 

Ctrl+ Tab -د

 .باشد می................................  کاری صفحه دیگر نام-1335

 Cell -الف

 workbook -ب

 ج- Worksheet 

 sheet -د

 کنی ؟ می استفاده گزینه کدام از طرفین، از ترازبندی ایجاد جهت-1336

 الف- Justify ب- Center ج- Right د- Left 

 ؟ کنی  می استفاده گزینه کدام از خود مندی عالقه لیست به سایت نام کردن اضافه برای-1337

 Home -الف

 Refresh -ب

 ج- Add To Favorites 

History -د

 شود؟ می استفاده شده ذخیره های فایل مشاهده جهت فرمان کدام از-1338

 الف- Open ب- save as ج- Save د- New 

 شود؟ تایید ای گزینه چه توسط باید ، اطلاعات فرم تکمیل از پس-1339

 Agree -الف

 Agree Form -ب

 test -ج

 د- Submit 

 شود؟ می استفاده وب در تصویر انتقال زیربرای های دستگاه از کدامیک-1340

 Scanner -الف

 Printer -ب

 Modem -ج

 د- Webcam

 باشد؟ می اکسل محیط ویژه نوار کدام-1341

 Ribbon -الف

 ب- Formul Bar 

 AddressBar -ج

 QuikAccess -د

 کدامند؟ روند می کار به جستجو برای که منطقی های عملگر-1342

 IF , NO -الف

 ب- NOT , AND , OR 

 OR , IF -ج

IF , AND -د

 واژه که باشد صورت چه به جستجو ، کنی  جستجو را University و Shiraz عبارت خواهی  می-1343

University نباشد؟ جستجو در 

 University + Shiraz -الف

 ب- Shiraz - University 

 Shiraz University+  -ج

 And Shiraz University -د

 شود؟ می استفاده متن شدن توپر برای گزینه کدام از-1344

 Italic -الف

 Underline -ب

 ج- Bold 

 Font size -د

 است؟ دستگاهی چگونه مودم-1345

 خروجی/  ورودي -ب  خروجی -الف



 

 

پردازشی -د ورودي -ج

 شود؟ می استفاده کاراکتر کدام از عبارت دقیق جستجوی برای-1346

 " " -د  ( ) -ج [ ] -ب } { -الف

 نمایی ؟ می استفاده گزینه کدام از رنگ طیف زمینه پس ایجاد برای-1347

 Texture -الف

 Shading -ب

 Pattern -ج

 د- Gradient

 .گویند می......  کرد ذخیره آن در را اطلاعات بتوان که ای گونه به دیسک سازی آماده عملیات به-1348

 الف- FORMAT 

 Http -ب

 MAN -ج

 WWW -د

 ؟ گردد نمی مشاهده یاطلاعات چه ، فایل دانلود پنجره در-1349

 فایل دریافت سرعت -الف

 فایل شده دریافت درصد -ب

 فایل شده دریافت حجم -ج

 فایل گیرنده نام -د

 بری ؟ می بکار را دکمه کدام نویسیبالا برای-1350

 Subscript -الف

 Shadow -ب

 Outline -ج

 د- Superscript

 .است...................  پسوندهای ،جزء Mp3 پسوند-1351

 موقت -د ویدئویی -ج صوتی -ب تصویري -الف 

 .شود می گفته.................................  ، کامپیوتر برروی شبکه از فایل یک بارگذاری به-1352

 Upload -الف

 Hyper link -ب

 Save As -ج

 د- Download

 رود؟ می بکار کوچک حرو  به التین حرو  تغییر برای گزینه کدام-1353

 الف- Lowercase 

 Uppercase -ب

 Sentence case -ج

 Toggle case -د

 شود؟ می مشخص زیر موارد از کدامیک با ها ستون و سطرها عناوین-1354

 الفبا حروف با ها ستون و سطرها -الف

 ارقام با ها ستون و سطرها -ب

 اعداد با ستون و الفبا حروف با سطرها -ج

 اعداد با سطرها و التین الفباي حروف با ستونها -د 

 کنی ؟ می استفاده فرمان کدام از افقی صورت به کاغذ قرارگیری وضعیت تنظی  برای-1355

 الف- Landscape 

 Page Range -ب

 Portrait -ج

 Current Page -د

 کنی ؟ می استفاده جدید گسترده صفحه فایل یک ایجاد برای فرمان کدام از-1356

 Cut -د New -ج Copy  -ب Format -الف



 

 

 شود؟ می استفاده گزینه کدام از شده نوشته متن رنگ تغییر برای-1357

 Fill color -الف

 Font -ب

 ج- Font color 

Text highlight -د

 .کنی  می استفاده...........................  فرمان از بازیافت سطل از پوشه یا فایل بازیابی برای-1358

 Format -الف

 ب- Restore 

 Delete -ج

 Empty Recycle -د

 دهد؟ می نمایش دار سایه را متن جلوه کدام-1359

 الف- Shadow 

 Outline -ب

 Emboss -ج

 Engrave -د

 چیست؟ ارگونومیک هد -1360

 کاري لوازم ماندن سالم -الف

 روحی سالمت -ب

 کار محیط در انسان سالمت -ج 

 کاري روش سازي بهینه -د

 ؟ گردد می استفاده تصاویر ذخیره برای گزینه کدام-1361

 الف- Save Picture As 

 Save As Picture -ب

 Show Picture -ج

 Go to my Picture -د

 شود؟ می استفاده گزینه کدام از ها داده کردن مرتب برای- 1362

 Auto Fill -الف

 ب- Sort 

 auto -ج

Comments -د

 باشد؟ می الکترونیک تجارت معایب از مورد کدام-1363

 .شوند مقایسه توانند می کاالها -الف

 .شود می انجام سرعت به پول انتقال و نقل -ب

 ندارد وجود خریدار و فروشنده بین فیزیکی ارتباط -ج. 

 .باشند می روز یک در ارائه قابل هاي سرویس -د

 شود؟ می انجام موردگذاری عمل زیر، گزینه کدام از استفاده با-1364

 الف- Bullets 

 Line spacing -ب

 Numbering -ج

 Indent -د

 کرد؟ مشاهده را چاپ نمایش پیش توان می چگونه-1365

 Print -الف

 ب- Print Preview 

 Print setup -ج

Page Setup -د

 شود؟ می استفاده گزینه کدام از سلول یک محتویات لغو و تایید جهت-1366

 دکمه -الف Enter دکمه و تائید جهت Esc سلول محتویات لغو جهت. 

 سلول محتویات لغو جهت Esc دکمه و تائید جهت backspace دکمه -ب

 سلول محتویات لغو جهت Spacebar دکمه و تائید جهت Tab دکمه -ج



 

 

 سلول محتویات لغو جهت Spacebar دکمه و تائید جهت Enter دکمه -د

 است؟ نادرست جمله کدام-1367

 .یابد می انتقال خود اصلی محل همان به بازیافت سطل از شده بازیابی فایل -الف

 .گیرد می قرار بازیافت سطل در شده حذف فایل -ب

 .تغییراست قابل بازیافت سطل ظرفیت -ج

 شود نمی بازیابی هیچگاه شده حذف فایل -د. 

 دهد؟ می انجام عملی چه painter format ابزار- 1368

 .کند می حذف را متن قالب -الف

 کند می کپی را متن قالب -ب. 

 .کند می کپی را متن -ج

 .کند می بندي قالب را متن -د

 . داری .......................  به نیاز وب صفحه مطالب چاپ جهت-1369

 بلندگو -د رسام -ج اسکنر -ب چاپگر -الف

 ؟ است گزینه کدام افزار نرم انواع-1370

 مترجم-سیستمی -الف

 سیستمی-کاربردي -ب 

 نویسی برنامه -کاربردي -ج

پایین سطح-بالا سطح -د

 گردد؟ می مشاهده کادر کدام در نمایش صفحه محاف  در انتظار زمان تنظی -1371

 الف- Wait 

 Copy -ب

 Properties -ج

 View -د

 شود؟ می استفاده گزینه کدام از فایل یک دانلود برای-1372

 الف- Save Target As 

 Save As -ب

 Save File As -ج

 Save -د

 چیست؟ E -Learningو  E-Mai مفهوم -1373

 الکترونیک آموزش ، الکترونیک کتابخانه -الف

 الکترونیک پست ، الکترونیک تجارت -ب

 الکترونیکی آموزش ، الکترونیکی پست -ج 

 الکترونیک کتابخانه ، الکترونیکی بانکداري -د

 .گردد می تعیین.................................  ای محاوره کادر در سیست  تاریخ و زمان-1374

 الف- Change Date and time setting 

 Setting -ب

 Properties -ج

 Date -د

 .کنی  می استفاده..................  کلید از ، Excel در غیرمجاور های خانه انتخاب برای-1375

 Shift -د Ctrl -ج Alt  -ب Insert -الف

 یم نامیده چه کنند می مختل را آن اجرای و کرده حمله اجرایی برنامه یک به که کوچکی های برنامه- 1376

 ؟ شود



 

 

 الف- Scam 

 irusev -ب

 Hacker -ج 

 ISDN -د    

 

1377-Domainآدرس در Mail-E چیست؟ نشانه 

 کاربر شناسه -الف 

 الکترونیک پست دهنده سرویس نام -ب

 وب گستر جهان وب -ج

فایل نام -د

 است؟ پاورقی درج برای سربرگ کدام-1378

 Review -الف

 Layout -ب

 ج- References 

 view -د

 .گویند می باشدچه می اینترنت شبکه همانند که خصوصی شبکه به-1379

 Interanet -د WAN  -ج MAN -ب LAN -الف

 گیرد؟ می قرار کشیده بصورت کار میز زمینه در تصویر گزینه کدام با-1380

 Tile -د Fill -ج Stretch  -ب Center -الف

 دهی ؟ می انجام کاری چه Copy or Move پنجرهی در copy a Create گزینه با-1381

 جدید کاربرگ درج -الف

 کاربرگ حذف -ب

 کاربرگ از کپی یک ایجاد -ج 

 کاربرگ جابجایی -د

 باشد؟ خطرناک تواند می هایی ایمیل چه کردن باز امنیتی نظر از-1382

 . بشناسیم را فرستنده که هایی ایمیل -الف

 است ناشناس ما براي فرستنده ولی دارند جالب موضوعات که هایی ایمیل -ب . 

 .شود می Forward دوستان طرف از که هایی ایمیل -ج

 .شود می Reply که هایی ایمیل -د

 نمائی ؟ می استفاده سند در تصویری فایل کردن وارد برای گزینه کدام از-1383

 View/ picture -لفا

 Insert/ chart -ب

 ج- Insert/ picture 

 Home/ picture -د

 نمائی ؟ می استفاده فرمان کدام از ها آیکن سایز تغییر برای-1384

 الف- View ب- Sort ج- File د- New 

 میکنی ؟ انتخاب را سربرگ کدام تصویر، اندازه تغییر جهت-1385

 الف- Format 

 Page layout -ب

 Layout -ج

 View -د

 کنی ؟ می استفاده اعشار افزودن جهت گزینه کدام از-1386

 Style -الف

 Decrease Decimal -ب

 Decimal -ج

 د- Increase Decimal 

 ؟ دهند نمی رایگان صورت به را الکترونیکی پست ساخت خدمات زیر های شرکت از یک کدام-1387

 Hotmail -د Yahoo -ج Bing -ب Google  -الف



 

 

 شود؟ می استفاده گزینه کدام از جدول در متن چرخش برای-1388

 Insert a cell -الف

 Insert a column -ب

 ج- Text Direction 

Insert a table -د

 ؟ است گزینه کدام سیست  به ویروس ورود از جلوگیری برای روش بهترین-1389

 باشد می الصاقی هاي فایل داراي که الکترونیکی هاي نامه حذف -الف

 سیستم در ویروس آنتی برنامه کارگیري به -ب

 باشد داشته را شدن روز به توانایی که آنتی داشتن -ج 

 جانبی هاي حافظه از استفاده -د

 باشد؟ می گزینه کدام الکترونیکی پست در عبور کلمه کاراکترهای تعداد حداقل-1390

 16 -د 8 -ج  32 -ب 6 -الف

 کنی ؟ می استفاده فرمان کدام از ها خانه ادغام برای-1391

 Condition Format -الف

 ب- Merge & Center 

 Format Painter -ج

 Comment -د

 .است...................  همان ویروس- 1392

 افزار سخت -الف

 کاربردي برنامه -ب

 مخرب برنامه -ج 

 منطقی بمب -د

 .نمایی  می استفاده........................گزینه از کوتاه و خاص سبک به متن ایجاد برای-1393

 Text Box -الف

 Format -ب

 Page Layout -ج

 د- Word Art

 ؟ دارد نام چه کند می تامین را رایانه برق ، برق قطع هنگام که دستگاهی- 1394

 Modem -الف

 ب- Ups 

 Cpu -ج

Memory Card -د

 ؟ چیست وب آدرس از ایمیل آدرس تشخیص روش-1395

 عالمت وجود -الف @ 

 دهنده سرویس نوع وجود عدم -ب

 سرور وب نام -ج

 Http وجود -د

 چیست؟ نشانه ویروس آنتی برنامه قرمز عالمت-1396

 ویروس آنتی شدن خراب -الف

 ویروس آنتی نبودن روز به -ب 

 ویروس آنتی از استفاده زمان مدت بیانگر -ج

ویروس وجود -د

 ؟ باشد می صحیح گزینه کدام-1397

 ادافــر مقابــل در عبــور کلمــه نمــودن وارد از -الــف 

 . کنیم خودداري مشکوک

 حسـاب چنـد بـراي یکسـان عبـور کلمه از باید -ب

 .کرد استفاده

ــد عبــور کلمــه -ج ــه نبای  عــوض اي دوره صــورت ب

 .شود

 نمـی تضـمین را کـاربر بـودن معتبـر عبور کلمه -د

 .کند



 

 

 شود؟ می استفاده گزینه کدام از عددی های داده گرافیکی نمایش برای-1398

 Chart -د Shape  -ج Format -ب Clip Art -الف

 ؟ گیرند می قرار پوشه کدام در معموال ناتمام های نامه-1399

Other -د Draft -ج Outbox  -ب Inbox -الف

 شود؟ می استفاده گزینه کدام از سلول یک در اضافی متن شکستن جهت-1400

 Split Cell -الف

 Shrink to Fit -ب

 ج- Wrap Text 

Merge & Center -د

 شود؟ می گفته چه ، است رایگان آنها از استفاده ماه یک مدت به که هایی افزار نرم به-1401

 الف- Shareware 

 Freeware -ب

 باز کد -ج

 Open Source -د

 است؟ مناسب گزینه کدام ستون عرض تغییر برای-1402

 الف- Column width 

 Row height -ب

 Table properties -ج

Preferred width -د

 ؟ نویسی  می را چیزی چه نامه Subject قسمت در-1403

 گیرنده آدرس -الف

 مخفی گیرنده آدرس -ب

 نامه موضوع -ج 

 نامه متن -د

 ؟ نمائی  می استفاده گزینه کدام از افراد سایر به الکترونیکی نامه یک مجدد ارسال برای-1404

Forward -د Send  -ج Reply All -ب Reply -الف

 گویند؟ می چه ه  به متصل رایانه چند ارتباط به-1405

 PC -الف

 ب- NETWORK 

 ISP -ج

 IP -د

 شود؟ می استفاده گزینه کدام از الکترونیکی نامه به فایل یک ضمیمه برای- 1406

 Reply -الف

 ب- Attach File 

 Forward -ج

Priority -د

 نماید؟ می فراه  را انتخابی بخش چاپ گزینه کدام چاپ پنجره در-1407

 الف- Selection 

 Current -ب

 All -ج

 Pages -د

 ؟ است افزار نرم انتشار حق های ویژگی از زیر های گزینه از یک کدام-1408

 .شناسد می رسمیت به را افزار نرم خریدار حقوق -الف

 شناسد می رسمیت به را افزار نرم کننده تولید حقوق -ب. 

 .کند می پذیر امکان را افزار نرم سرقت -ج

 . دارد را آن تکثیر حق و است افزار نرم مالک خریدار -د

 .است......................  محدودیت دارای ضمیمه فایل ارسال-1409



 

 

 موقعیت -الف

 زمان -ب

 حجم -ج 

ارسال سرعت -د

 است؟ مناسب گزینه کدام از استفاده جدول اطرا  خطوط نمودن دوخطی برای-1410

 Pen color -الف

 Text -ب

 ج- Borders 

 Line -د

 کند؟ می گذاری نشانه شده نخوانده پیام اساس بر را ها پیام گزینه کدام-1411

 الف- Unread 

 Read -ب

 Starred -ج

Bookmark -د

 شود؟ می استفاده تصویر چرخش برای دستور کدام از-1412

Layout -د Format -ج Rotate -ب Page  -الف

 کند؟ می نگهداری را شده حذ  های نامه پوشه کدام Email پنجره در-1413

 Draft -الف

 Sent -ب

 ج- Delete Item 

Inbox -د

 گیرد؟ می قرار استفاده مورد جدول های خانه کردن ادغام جهت زیر گزینه کدام-1414

 Split cells -الف

 Split table -ب

 Draw table -ج

 د- Merge cells

 است؟ دسترسی قابل سازمان از خارج افراد توسط شبکه کدام-1415

LAN -د اینترانت -ج اکسترانت -ب  اینترنت -الف

 شود؟ درج قسمت کدام در باید گیرنده آدرس ، نامه ارسال هنگام در-1416

 الف- To ب- From ج- CC د- Bcc 

 شود؟ می استفاده گزینه کدام از پستی ادغام ایجاد برای-1417

 Envelops -الف

 Lablels -ب

 Merge cells -ج

 د- Mailings 

 گیرند؟ می قرار پوشه کدام در شوند می ارسال که هایی نامه ، نباشید وصل اینترنت به اگر-1418

 الف- Outbox 

 Inbox -ب

 Send Item -ج

 Draft -د

 ؟ گویند می چه گیری پشتیبان عمل به-1419

 Number -الف

 Design -ب

 ج- backup 

Table -د

 .نمود تعیین را ها گیرنده توان می..............  قسمت از پستی ادغام هنگام در-1420

 Start mail merge -الف

 Envelopes -ب

 Address block -ج

 د- Select recipients

 کنی ؟ می استفاده ابزار کدام از نامه برچسب درج برای-1421



 

 

 Email -الف

 Envelope -ب

 Mail merge -ج

 د- labels 

 کلیک Outlook ابزار نوار از دکمه کدام روی بر باید اصلی نامه گیرندگان همه به نامه پاسخ ارسال برای-1422

 .نمایید

 Send -الف

 Reply -ب

 ج- Reply To All 

Forward -د

 کنی ؟ می استفاده کلیدها کدام از جدید صفحه یک ایجاد جهت-1423

 الف- Ctrl + Enter 

 Alt + Enter -ب

 Shift + Enter -ج

 Enter -د

 کنی ؟ می استفاده کلیدی چه از امالیی، گیر غلط کادر شدن ظاهر جهت-1424

 F1 -د F8 -ج F7 -ب F6  -الف

 .کند می ذخیره.................  درباره را اطلاعات از ای مجموعه رکورد یک-1425

 موضوع چند -الف

 فایل چند -ب

 موضوع یک -ج 

 فایل یک -د

 دامک از انتخابی سلول از قبل های ستون و سطرها شدن ثابت برای ، Freeze فرمان از استفاده زمان در-1426

 نمائی ؟ می استفاده گزینه

 Freeze First Column -الف

 Freeze Top Row -ب

 ج- Freeze Panes 

 Freeze All Column -د

 می استفاده.. ..................... گزینه از سطر اولین شدن ثابت برای ، Freeze فرمان از استفاده زمان در- 1427

 .نمائی 

 Freeze First Column -الف

 ب- Freeze Top Row 

 Freeze Panes -ج

 Freeze All Column -د

 باشد؟ می زیر های گزینه از یک کدام زیاد طول با متنی داده نوع-1428

 Number -الف

 Yes/ No -ب

 ج- Long text 

Short text -د

 کنی ؟ می استفاده سربرگ کدام از چاپ های حاشیه تنظی  برای-1429

 الف- Page setup 

 Setup -ب

 Home -ج

 Create -د

 .شود می استفاده................ گزینه از صفحات حاشیه تنظی  برای-1430



 

 

 الف- Margins 

 Size -ب

 Columns -ج

 Orientation -د

 گردد؟ می مشاهده زمانی چه# DIV/0 خطای- 1431

 .دباش نمی مناسب ستون پهناي زیرا دهد نمایش صحیح فرم به را سلول محتویات تواند نمی اکسل که زمانی -الف

 .باشد نمی مناسب ستون پهناي -ب

 است شده تقسیم صفر بر ها داده از یکی که زمانی -ج. 

 .نماید شناسایی فرمول در را ها داده از یکی تواند نمی اکسل که زمانی -د

 باشد؟ نمی پذیر امکان خروجی نوع کدام به گزارش تبدیل-1432

 Xlsx -د Bmp -ج Docx  -ب Pdf -الف

 .کنی  می انتخاب را.............. راست سمت و بالا از ریبون نوار شدن ثابت برای-1433

 Show the ribbon -الف

 TOP the ribbon -ب

 Open ribbon -ج

 Pin the ribbon -د

 چه از باشد اجرا قابل برنامه( 2003( قبلی های نسخه در مطالب ارائه فایل یک بخواهی  که صورتی در-1434

 کنی ؟ می استفاده پسوندی

 PPS -د PPT -ج POT  -ب PPTX -الف

 است؟ کدام 2013اکسس داده پایگاه افزار نرم در ها فایل پسوند-1435

 XLSX -د Accdb -ج PPTX  -ب DOCX -الف

 .شود می......  ایجاد سبب گزارش، صفحات حاشیه درتنظی  wide گزینه-1436

 کوتاه حاشیه -الف

 نرمال حاشیه -ب

 باریک حاشیه -ج

 پهن حاشیه -د 

 )راست به چپ( شود؟ می استفاده گزینه و سربرگ کدام از صفحات حاشیه تنظی  برای-1437

 Page layout------ print -الف

 Home------ margins -ب

  Page layout------- paraghraph -ج

 د- Page layout-------- margins

 است؟ نسبی آدرس دهنده نشان کدامیک-1438

 C1 -د C$1  -ج C1$ -ب C$1$ -الف

 است؟ شی کدام داده پایگاه در اصلی آیت -1439

Reports -د Tables -ج Queries  -ب Form -الف

 است؟ وضعیتی چه دارای فرض پیش بطور( layout(بندی طرح نظر از گزارش-1440

 Design -الف

 Report layout -ب

 ج- Columnar 

Form -د

 نمائی ؟ می استفاده( Templates(فرض پیش الگوهای از استفاده برای فرمان کدام از-1441

 New -د Open  -ج Save -ب Save as -الف

 است؟ کدام مناسب گزینه خاص صفحات چاپ برای-1442



 

 

 All -الف

 Selection -ب

 ج- Page 

Current page -د

 نمایی ؟ می استفاده ها فرم و جدول در اطلاعات ورود برای نما کدام از-1443

 Design view -الف

 Layout view -ب

 Design -ج

 د- Datasheet view 

 .نمایی  می استفاده................  از یاطلاعات بانک در اطلاعات از بخشی یا تمام نمایش برای-1444

 گزارش -د فرم -ج جو و پرس -ب  جدول -الف

 نمایی ؟ می استفاده ها فرم و جدول در اطلاعات ورود برای نما کدام از-1445

 Design view -الف

 Layout view -ب

 Design -ج

 د- Datasheet view 

 باشد؟ نمی انتخاب قابل PowerPoint2013 برنامه در زیر پسوندهای از کدامیک-1446

 PPSX -د TXT -ج PPTX  -ب POTX -الف

 کنی ؟ می استفاده گزینه کدام از یاطلاعات بانک در اطلاعات چاپ برای-1447

 الف- Report ب- Filter ج- Form د- Query 

 نمود؟ مشاهده توان می نما کدام در را صفحات کننده جدا- 1448

 الف- Page Layout 

 Page Break Preview -ب

 Normal -ج

 Custom View -د

 .کنی  می استفاده.................  گزینه از اصلی کلید فیلد ایجاد برای-1449

 ID -الف

 ب- Primary key 

 First key -ج

 key -د

 دهد؟ می نمایش کامل و یکپارچه صورت به را گزارش گزارش، نماهای از کدامیک-1450

 الف- Report view 

 Print preview -ب

 Layout view -ج

 Design view -د

 می ابانتخ را گزینه کدام نمائی  ایجاد آن انتهای در و داخل را نمودار های داده برچسب بخواهی  اگر- 1451

 کنی ؟

 Inside End -الف

 Center -ب

 ج- Inside Base 

 Outside End -د

 .......................کنی  تعریف اولیه کلید فیلدی برای اگر-1452

 .شود نمی شناسایی فیلد این توسط جدول در رکورد -الف

 .شود نمی مرتب فیلد آن براساس جدول محتویات -ب

 باشیم داشته خالی یا و مشابه داده دو توانیم نمی -ج 

 .باشیم داشته خالی یا و مشابه داده دو توانیم می -د

 نماید؟ می چاپ رو و پشت خودکار بطور را صفحات گزینه کدام-1453



 

 

 الف- Manually print on both sides 

 Landscape -ب

 Print one sided -ج

 Collated -د

 شود؟ می وارد زیر کادرهای از کدامیک در ها داده اعتباری قانون-1454

 Input mask -الف

 Valiation text -ب

 Caption -ج

 د- Validation Rule

 باشد؟ نمی ها فرم نمایش برای نما کدام-1455

 Design view -الف

 ب- Data sheet 

 Form view -ج

 Layout view -د

 باشند؟ می رویت قابل شده باز اخیراً های فایل مسیر کدام در-1456

 Computer ← Open ← File -الف

 One Drive ← Open ← File -ب

 Add a Place ← Open ← File -ج

 د- Recent Presentation ← Open ← File 

 کنی ؟ می استفاده فیلد خصوصیات کدام از ها داده ورود برای الگویی ایجاد برای-1457

 General -الف

 Field size -ب

 ج- Input mask 

 format -د 

 شود؟ می گفته چه ستونی نمودار به- 1458

 Column -د Area  -ج Pie -ب Line -الف

 شود؟ می استفاده بعدی رکورد به حرکت جهت زیر های دکمه از کدامیک-1459

 First record -الف

 Last record -ب

 Previous record -ج

 د- Next record

 .نمایی  می استفاده کلید صفحه در.......... میانبر کلید از چاپ عمل از پیش مشاهده برای-1460

 Ctrl + F1 -الف

 ب- Ctrl+ F2 

 F2 -ج

 F1 -د

 کنی ؟ می انتخاب را گزینه کدام ها داده از لیست یک ایجاد برای-1461

 Auto number -الف

 OLE object -ب

 ج- Lookup wizard 

calculated -د

 است؟ مناسب مسیر کدام مرحله به مرحله شکل به فرم یک ایجاد برای-1462

 الف- Create ----- form ------- form wizard 

 Home ----- form ------- form -ب



 

 

 Home ----- form ------- form wizard -ج

 Home ----- form ------- form design -د

 شود؟ می اسلاید بزرگنمایی سبب گزینه کدام-1463

  الف- Zoom In 

 Font -ب

 Zoom Out -ج

 Font Size -د

 .دهی  نشان...............  یا.............  نمای دو در را جدول توان می فیلد یک خصوصیات تعیین برای-1464

 layout -الف

 ب- Design 

 Format -ج

Data sheet -د

 گردد؟ می استفاه ابزار کدام از امالیی خطاهای تصحیح برای-1465

 Auto correct -الف

 View -ب

 Chack -ج

 د- Spelling & Grammer 

 شود؟ می استفاده گزینه کدام از خالی فرم ایجاد جهت-1466

 Form design -الف

 Form wizard -ب

 ج- Form blank 

 Form view -د

 نمائی ؟ می استفاده گزینه کدام از نمودار به عنوان نمودن اضافه برای- 1467

 Data Labels -الف

 More Title Options -ب

 Add Data Labels -ج

 د- Chart Title

 شود؟ می استفاده فرم نمای کدام از اطلاعات ورود جهت-1468

 الف- Form view 

 Layout view -ب

 Print view -ج

 Design view -د

 شود؟ می استفاده گزینه کدام از اسلاید های طرح از استفاده با جدید اسلاید یک نمودن اضافه برای-1469

 New ← File -الف

 Layout ← Home -ب

 Slide master ← View -ج

 د- New slide ← Home

 کنی ؟ می استفاده....................  گزینه از سرصفحه ویرایش برای-1470

 Edit footer -الف

 ب- Header 

 Footer -ج

Edit header -د

 گردد؟ می استفاده نمودار نوع کدام از درصد به ها داده مقادیر نمایش برای- 1471

 الف- Pie ب- Line ج- Bar د- Column 

 مقابل را ابلمق عبارت نمایی ، وارد عددی فیلد در ها داده ورود برای را 500 تا 100 بین شرطی بخواهی  اگر-1472

 =<)and 100=> 500) کنی ؟ می درج خصوصیات از یک کدام

 Validation rule -ب Index  -الف



 

 

Formay -د Validation text -ج

 کنی ؟ می کلیک گزینه کدام روی فیلتر یک حذ  جهت-1473

 الف- clear filter 

 Filter by form -ب

 Delete filter -ج

 Toggle filter -د

1474 -Legend است............  همان نمودار یک در. 

برچسب -د ها داده -ج راهنما -ب  محور -الف

 کند؟ می قبول را هایی داده نوع چه text short فیلد-1475

 کاراکتر 63999 از کمتر اعداد و متن -الف

 خودکار صورت به متوالی اعداد تولید -ب

 متن فقط -ج

 کاراکتر 255 از کمتر اعداد و متن -د 

 نمود؟ ایجاد شده تعیین شرط با را جو و پرس توان می روش کدام در-1476

 Split query -الف

 Query wizard -ب

 Query -ج

 د- Query design 

 کنی ؟ می استفاه نامه پاکت روی چاپ برای Size بخش در گزینه کدام از-1477

Table -د Mailing -ج Envelop -ب Labels  -الف

 کنی ؟ می استفاده گزینه کدام از نمودار نوع تغییر برای-1478

 الف- Change Chart Type 

 Templates -ب

 Seris name -ج

 Chart Title -د

 گردد؟ می استفاده گزینه م کدا از فیلدها فرض پیش مقدار ایجاد جهت-1479

 Size -الف

 Required -ب

 Caption -ج

 د- Default value 

 کنی ؟ می کلیک سربرگ کدام بر query ایجاد برای-1480

Create -د Home  -ج File -ب View -الف

 کنی ؟ می استفاده گزینه کدام از اسلاید تمامی روی بر زمینه پس اعمال برای-1481

 الف- Apply to All 

 Apply to Select -ب

 Ok -ج

 Cancel -د

 شود؟ می استفاده دستورات مکرر اجرای برای فرمان کدام- 1482

 Auto fill -الف

 Auto Filter -ب

 ج- Macro 

 Comments -د

 است؟ کدام نوشته کردن دار زیرخط برای مناسب گزینه-1483

 Bold -ب Italic -الف



 

 

 ج- Underline د- Shadow

 باشد؟ نمی( type data(داده نوع انواع از کدامیک-1484

 الف- Primary 

 Long text -ب

 Attachment -ج

Short Text -د

 شود می انجام مرحله به مرحله شکل به جو و پرس ایجاد ،.........  روش در-1485

 Query -الف

 Query design -ب

 Split query -ج

 د- Query wizard

 نمائی ؟ می انتخاب را فرمان کدام سپس کلیک راست ابتدا کاربرگ محافظت جهت-1486

 Move -الف

 ب- Protect Sheet 

 Cut -ج

Copy -د

 کنی ؟ می استفاده گزینه کدام از query در خروجی سازی مرتب برای-1487

 الف- Sort ب- Or ج- Criteria د- Show 

 نمایی ؟ می وارد چگونه را شرط دهد، نشان را 50 تا 20 بین افراد جو و پرس یک بخواهی  اگر-1488

 الف- Between 20 and 50 

 =>50and >= 20 -ب

 =>50 -ج

 =<20 -د

 شود؟ می استفاده ای گزینه چه از خاص شرط اساس بر جدول های داده استخراج برای-1489

 الف- Query ب- Form ج- Report د- Macro 

 دهد؟ می رخ اتفاقی چه slide Hide انتخاب با-1490

 .شد نخواهد دیده سازي مرتب نماي در اسلاید -الف

 .شد نخواهد دیده نرمال نماي در اسلاید -ب

 شد نخواهد دیده اجرا نماي در اسلاید -ج. 

.شد نخواهد دیده مختلف نماهاي در اسلاید -د

 کنی  می استفاده...............  تابع از ها خانه های داده روی بر شرط تعریف جهت- 1491

 Average -الف

 Round -ب

 ج- If 

 Sum -د

 .شود می استفاده..............  محاسبه جهت number count گزینه از-1492

 اعداد نمودن گرد -الف

 اعداد تعداد شمارش -ب 

 اعداد میانگین -ج

 اعداد جمع -د

 رود؟ می کار به ها سلول جمع عمل برای تابع کدام- 1493

Sum -د Min  -ج Average -ب Max -الف

 (IF(A1=14),”Ok”;”Noباشد نتیجه فرمول چیست؟    A1=14اگر -1494



 

 

 الف- Ok 

 No -ب

 True -ج

 False -د

 کنی ؟ می استفاده گزینه کدام از انیمیشن جلوه اجرای تکرار برای-1495

 الف- Repeat ب- Delay ج- Start د- Duration

 کند؟ نمی محاسبه را A6 تا A1 میانگین فرمول کدام- 1496

 average(A1:A6=)  -الف

 Sum(A1:A6)/Count(A1:A6)= -ب

 ج- =Average(A1;A6) 

 Average(A1,A2,A3,A4,A5,A6)= -د

 گردد؟ می استفاده عالمت کدام از تابع در درج و همجوار های سلول انتخاب برای- 1497

 د . -ج ; -ب : -الف- $ 

 شود؟ می استفاده میانبر کلید کدام از اسلاید آخرین به انتقال برای-1498

 Ctrl+Page Down -الف

 Ctrl+home -ب

 Ctrl+Page Up -ج

 د- Ctrl+End 

 باشد؟ نمی اسلاید نمایش های روش از زیر های گزینه از کدامیک-1499

 Notes page -الف

 Normal -ب

 Reading view -ج

 د- Template 

 باشد؟ می نما کدام از استفاده ، وضعیت بهترین متن ویرایش برای-1500

 Slide -الف

 Outline -ب

 Slideshow -ج

 د- Normal 

 شود؟ می استفاده گزینه کدام از چاپ محدوده تعیین برای- 1501

 Print Title -الف

 All -ب

 Print -ج

 د- Set Print Area 

 دهی ؟ می تغییر را ها انیمیشن اجرای ترتیب ، فرمان کدام از استفاده با-1502

 Frame -الف

 Duration -ب

 Delay -ج

 د- Reorder Animation 

 ؟باشد می کدام Function Insert ای محاوره کادر کردن باز برای میانبر کلید- 1503

 F4 -الف

 Shift+F4 -ب

 ج- Shift+F3 

 F3 -د

 نمائی ؟ می استفاده عملیاتی های دکمه درج برای گزینه کدام از-1504

 Shapes -الف

 Run -ب

 Begin Type -ج

 د- Action Buttons 



 

 

 شود؟ می استفاده گزینه کدام از کاغذ یک در کوچک صورت به یداسلا چند چاپ جهت-1505

 Frame slide -الف

 ب- Handouts 

 Outline -ج

 pages -د

 .فشاری  می همزمان را...........  های کلید ، جاری اسلاید از ها یدلااس نمایش برای-1506

Shift + F5 -د Shift+F3  -ج Alt+F5 -ب Alt+F3 -الف

 


